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Sugar Enterprise 8.1 Application Guide

The Sugar Application Guide introduces you to some basic CRM concepts and
helps you get familiar with the Sugar system. It describes how to access Sugar
through a personal computer and a web browser. It also describes how to perform
a broad range of customer relationship management tasks and related
administration tasks.

Last Modified: 2018-06-11 17:34:36

Introduction

Overview

Welcome to Sugar - a commercial Customer Relationship Management (CRM)
application. Strong relationships are at the core of every organization's success.
Sugar brings ease and order to the creation, development, and maintenance of
your organization's important relationships.

Sugar consists of interrelated records in modules such as Accounts, Contacts,
Opportunities, Cases, Meetings, Emails, etc. and wraps your data in an intuitive
user interface which helps make sense of these different elements of your
business. Whatever your organization's focus - sales, marketing, support, or other
ventures - Sugar's flexible modules bend to align with your business' models and
practices. Manage your relationships from inception to fruition and beyond with
Sugar's built-in modules and relationships as well as your custom modules and
configurations available to Sugar administrators.

Core Features

Sales Force Automation

e Target, Lead, and Contact management to direct and organize efforts
throughout the sales life cycle

e Account management to aggregate interactions with organizations and
individuals

e Opportunity management to pursue new business, share sales information,
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and track deal progress

e Sales Forecasting to enable sales representatives and managers to
understand upcoming business

* Quote management to prepare potential sale figures including multiple line
items, currencies, and tax codes

e Quoted Line Item management to capture the details of your organization's
goods and services

Marketing Automation

e Target, Lead, and Contact management to support the creation of new
relationships

e Email marketing campaigns to present relevant email messages to groups
of recipients

e Campaign management and reporting for tracking campaigns across
multiple channels and analyzing the effectiveness of marketing activities

e Target List management to organize groups of recipients for ensuring
campaign message relevance

e Web-to-Lead Forms to capture lead information directly from external web
input

Customer Support

e Case management to track service and resolution of customer issues

e Bug tracking to identify, prioritize, and resolve product issues

e Contact and Account management to track support history and enable
continuity of service

e Sugar Portal to provide clients with self-service capabilities support
activities

e Knowledge Base to manage information and share it externally

Record Keeping

e Email, Task, Call, and Meeting management to facilitate day-to-day work

e Note management to affix information and file attachments to other Sugar
modules

e Document management to track living documents and their changes

e Contract management to capture and maintain sales and service contracts
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e Search capabilities to quickly and easily locate your data

Collaboration

e Shared Email and Calendar to provide visibility across individuals and
teams

e Connectors and tools to leverage third-party information regarding your
prospects and clients

Reporting

e Report creation and management to gain insight into your organization's
Sugar data
e Home page dashlets to display important tables and reports

Last Modified: 2018-06-11 17:34:36

Getting Started

Overview

Sugar offers users a wide range of configuration options when getting started with
the application. Your first time logging into Sugar the New User Wizard will step
through configuring some basic settings (i.e. Your Information, Your Locale). You
may skip these steps and configure these settings in your user preferences at a
later time. Please note that system administrators can also set up each user's basic
settings when creating the user in Sugar. This documentation will cover the
various options (e.g. New User Wizard, User Preferences) available when first
getting started with Sugar and accessing your account.

Accessing Sugar

Prerequisites
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The following will need to be installed and configured on your local machine prior
to accessing Sugar:

e A supported web browser application (e.g. Chrome, Firefox) is required on
your local machine. For more information on the various supported web
browsers, please refer to the Supported Platforms page.

e The web browser must have JavaScript and cookie support enabled in order
to access Sugar.

e Network access to a server running your Sugar instance is required.

Logging In

The Sugar login screen allows you to enter login credentials (user name and
password) to access your instance. Navigate your web browser to your instance's
URL (e.g. https://example.sugarondemand.com) to access Sugar's login screen. If
you do not know your instance URL or login credentials, please reach out to your
system administrator for assistance. The New User Wizard will launch upon your
first successful log in to Sugar allowing you to configure some of your basic
personal settings.

§ SUGAR

Forgot Password? Login

Resetting Your Password

There may be occasions when users forget their Sugar password and will need to
reset it. If the system administrator has enabled the Forgot Password feature via
Admin > Password Management, users will have the option to request a password
reset directly from Sugar's login screen. If you do not see the Forgot Password link
on your login screen, please reach out to your system administrator for further
assistance. System administrators can either enable the Forgot Password feature,
send a system-generated password to the user, or manually change the user's
password via Admin > User Management. For more information on how to set up
and manage passwords in Sugar, please refer to the Password Management
documentation. Please note that the outbound mail server for the system must be
configured via Admin > Email Settings and users will also need to have their
personal email settings configured in their user preferences in order for the
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temporary password information to be emailed.For more information on setting up
the system email settings, please refer to the Email documentation in the
Administration guide.

Use the following steps to request a new password:

1. Click the Forgot Password? link on the bottom left of Sugar's login dialog
box.

¥ SUGAR

|' Forgot Password? | LogIn

2. Enter your Sugar username and primary email address on file, then click
"Request Password". If submitted successfully, a message will appear that
your request has been submitted.

¥ SUGAR

3. A temporary password will be emailed to your primary email address.

4. Enter the temporary password into Sugar's log in screen.
Note: Be sure to change your password once logged in by navigating to the
Password tab in your user preferences.

Setting Your Language

Users have the option to choose the primary language they want displayed in
Sugar by clicking the Language link on the bottom right of the Login screen. The
Language dropdown list will appear allowing you to select the appropriate
language you want displayed in your Sugar account. The out-of-the-box default
language is English (US), but administrators can change the default language
globally via Admin > Locale. For more information on configuring the default
language in Sugar, please refer to the User Interface section of the System
documentation. Once the default language is changed by the administrator, it will
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display as the default selection on the login screen for all users.

Administrators can also control what languages are available to select in the
Language dropdown list via Admin > Languages. If you do not see one of the listed
languages below displayed in the Language dropdown list, please reach out to your
system administrator for assistance. For more information on managing languages
in Sugar, please refer to the Languages section of the System documentation.

SRR

BRI

Portugués Brasileiro

@Language / Sprache / Idioma

The following languages are available for use in Sugar:

Albanian Hungarian
Arabic Italian
Brazilian Portuguese Japanese
Bulgarian Korean
Catalan Latvian
Chinese (Simplified) Lithuanian
Chinese (Traditional) Norwegian
Croatian Polish
Czech Portuguese
Danish Romanian
Dutch Russian
English (UK) Serbian
English (US) Slovak
Estonian Spanish
Finnish Spanish (Latin)
French Swedish
German Thai

Greek Turkish
Hebrew Ukrainian
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Logging Out

When you are done working in Sugar and wish to log out of the system, simply
click your user name on the upper right of Sugar and select "Log Out". This will log
you out completely from Sugar and you must log in again in order to access your
account.

Q 2| +
& M Profile
i& ctmployees
O About
(= LogOut

Automatic Log Outs

While working in Sugar, a user may be automatically logged out of the system.
Currently, Sugar allows a username to be logged in under only one session, and
any additional user sessions started using the same username will log out the
previous session. This behavior is for your security as Sugar does not allow
multiple sessions for the same username from different machines or browsers. To
prevent situations like this, please do not share your login credentials (username
and password) with users in your organization.

Another situation where users are automatically logged out is when the user does
not perform any actions in Sugar for a certain period of time. The security timeout
period in Sugar is controlled by configuration settings in PHP and the web server
running your Sugar instance. Please note that the PHP session's lifetime persists
until you close your web browser and the default session timeout value is 1440
seconds (24 minutes).

In order to prevent security timeouts, users can navigate or click the page(s) in
Sugar every so often to keep the session active. If the session times out, click any
button, tab, etc. on the current page once you are ready to continue working in
Sugar, and you will be taken back to the Login screen. Another option is to
completely close your current browser and open a new browser to navigate back to
Sugar's Login page.

Please note that users can have multiple tabs of Sugar pages open within the same
web browser (e.g. Chrome) without getting logged out of the system. For example,
this is useful when working with multiple Sugar pages or records without
navigating away from previous pages.
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New User Wizard

When users first log in to Sugar, they will step through the New User Wizard to
configure some basic settings (i.e. Your Information, Your Locale). If the system
administrator already configured your basic settings when adding you as a user to
Sugar, the fields in the wizard will be populated with the provided information. You
can update your information as you go through the New User Wizard to make any
necessary changes. Please note that you can skip the steps in the wizard if you
wish to configure the settings via your user preferences at a later time.

Configuring Your Information

The Your Information step of the New User Wizard allows you to enter basic
information (e.g. name, email address, phone) about yourself to be stored in your
user profile. Please note that the information provided in this step can be updated
in your user preferences at a later time if desired. For more information on
configuring your personal information, please refer to the User Preferences
section.

The following options are available to configure your user profile:

e First Name : Enter your first name.

e Last Name : Enter your last name.

e Email : Enter your primary email address.
e Phone : Enter your office number.

Please note that all required fields will indicate "Required" in the field and must be
completed prior to moving to the next step of the wizard. Once your personal
information is entered, click "Next".

1 User Profile Setup progress

Setup your user information

First name Last name

Jim | Brennan

Email Phone
jim@example.com ‘ (415) 226-BBEB
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Configuring Your Locale

The User Locale Settings step allows you to configure the date, time, and name
format you want displayed in Sugar based on your current geographical location.
Please note that the information provided on this page can be updated in your user
preferences at a later time if desired.

The following options are available to configure your locale settings:

Time Zone : Select the time zone based on your current geographical
location.

Date Format : Select the format you want the date stamps displayed in
Sugar.

Time Format : Select the format you want the time stamps displayed in
Sugar.

Name Format : Select the format you want the concatenated name fields
displayed in Sugar's list view and record view.

Once your locale information is entered, click "Next".

» User Locale Settings Setup progress
Set your time zone, date, and name formats
Time Zone Time Format
| America/Los Angeles (GMT-8:00)  ~ | | 11:00 pm -
Date Format Mame Format
| 12/23/2010 ~ | | Dr. David Livingstone -

The following page will confirm that your set up is complete and that you are ready
to use Sugar. You can access the various support resources (e.g. Documentation,
Knowledge Base) available by clicking one of the boxes in the dialog box. Please
note that you can click "Start Sugar" to go directly into your Sugar account.
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Start using sugar!
1
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Sugar Training Documentation Knowledge Base Forums
Back Start Sugar
Tour

You can launch the Welcome to Sugar tour on the Home page if you wish to see
key features of the user interface. Simply click the Help link in Sugar's footer then
click "Tour" in the help pane. The Welcome to Sugar window will appear and
include links which provide access to additional resources (e.g. training,
documentation). Click the appropriate link in the window to be directed to the
specific page (e.g. Support page) in a separate tab. To begin the tour, simply click
the Right arrow and a bubble will appear to point out the various parts of the
application such as where to access the dashboard and activity stream, perform a
global search, etc. You can click the Left arrow at anytime during the tour to go
back through the key features again. Once you have completed viewing the tour,
click the Done button to exit the tour. Please note that you can launch the tour
again by clicking the Tour link in Sugar's help pane at any time. For more
information regarding the Tour link, please refer to the User Interface
documentation. As you navigate around Sugar, you can launch the tour for any of
the Sidecar modules (e.g. Accounts, Leads, Contacts) by clicking the Tour link in
the help pane to view key features of the list view and record view.
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User Preferences

There is a wide range of configuration options available to users when setting up
their profile in Sugar. The User Preferences section gives users the ability to view
and update their basic information, personal email settings, etc. To access user
preferences, click your user name on the upper right of Sugar and select "Profile".

Q -+

& A Pprofile

i& Employees

6 About

User Profile Tab

The User Profile tab displays basic information such as your name, email address,
phone number, etc. If the New User Wizard was completed, the information you
entered will appear under the User Profile tab. The system administrator can also
enter the user's basic information when creating the user via Admin > User
Management. For more information on creating new users, please refer to the
User Management documentation. Your personal information on this tab are
grouped by default into the User Profile, Employee Information, and Email Settings
sections. To enter or update your information, simply enter the appropriate values
for the fields then click "Save" to preserve the changes.
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User Profile

The User Profile section displays your Sugar user name, full name, status, user
type (e.g. Regular User, System Administrator User), and profile picture (if
uploaded). Your user name, full name, status, and user type will be populated as
the system administrator must enter this information when creating a new user.
Users have the option to update their user name, full name, as well as upload a
profile picture to be displayed in the upper right of Sugar. Please note that only
system administrators have the ability to change your status and user type. For
more information on changing a user's status and user type, please refer to the
User Management documentation.

User Profile Password Advanced External Accounts Downloads

# User Profile

User Name: max First Name: Max
Status: Active Last Mame: Jensen
User Type: Regular User
User can access modules and records based on team security and roles.
Avatar: ﬂ
™
T -

Employee Information

The Employee Information section displays your employee status, title, phone
number, address, etc. If you completed the Your Information step of the New User
Wizard, the information you entered will appear in this section. You can update
your address, phone number (e.g. Work Phone, Mobile), description, IM Type (e.g.
MSN, Yahoo!), and IM Name in this section accordingly. Please note that only
system administrators can change your employee status, title, department, and
supervisor information. For more information on administrator updates to the
Employee Information section, please refer to the User Management
documentation.
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# Employee Information

Employee Status: Active

Title: Account Rep Work Phone:
Department: Mobile:
Reports to: Sarah Smith Other Phone:

Fax:

Home Phone:

IM Type: - IM Name:
Address Street: Address City:
%
Address State: Address Postal Code:

Address Country:

Description:

Email Settings

The Email Settings section contains your primary email address and preferred
method for sending mail from Sugar.
Email Settings

Email Address: Primary Reply-to

o

max@example.com

Email Client: "4 External Email Client 5

Cancel Reset User Preferences

The Email Settings section contains two fields:

e Email Address : Enter your primary email address.

o Sugar refers to the primary email address in the user's profile to
send messages such as password-reset emails, record-assignment
notifications, and workflow alerts to users.

o Users can add multiple email addresses in email settings, but only
one can be marked "Primary".

o If the administrator has enabled the system email account for users,
the primary email address will be displayed when the user sends
outbound emails via the system email account.
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e Email Client : Select how you would like to send email from Sugar.

o Sugar Email Client (most common) : To send messages through
the Sugar application and automatically archive them in Sugar, you
must select "Sugar Email Client" from the Email Settings section of
your user profile. This is the default setting.

= Note: To send email from Sugar, you must configure your
outbound email server via Emails > Email Settings or, if
using the system email account to send email, the system's
outbound email server must be configured by an
administrator via Admin > System Email Settings.

o External Email Client : Users can choose this option if they would
like to send email from an application outside of Sugar (e.g.
Microsoft Outlook, Gmail). If you choose the External Email Client
option, emails sent to contacts, leads, etc. will not be saved in Sugar
as archived emails unless you use the Sugar Email Archiving service
(a.k.a. "SNIP") or a Sugar connector such as the Outlook Plug-in or
a third-party connector like Collabspot.

Note: The administrator may have configured the user's email settings when
adding the user to the system, but the user can always edit the options in their
profile.

Password Tab

Users have the option to change their password in Sugar by navigating to the
Password tab in their user preferences. You can use this option to change
temporary Sugar passwords, system-generated passwords for password resets,
etc. Administrators also have the ability to change or reset a user's password via
Admin > User Management. For more information on how administrators can
reset a user's password, please refer to the Resetting User Passwords section of
the User Management documentation. Please note that passwords can be changed
as often as you wish in Sugar. Updating passwords in Sugar on a regular basis is
recommended for the security of your account.

To reset your password, enter your current password, new password, and
confirmed password making sure to meet the password requirements listed on the
right. Each password requirement will be checked off in the list as the new
password meets the required conditions. Please note that the new password you
enter must meet all the restrictions in order for the password to save. System
administrators can configure the password requirements via Admin > Password
Management. They can choose the minimum and maximum lengths required for
the password, as well as indicate if any special characters are needed. Additional
requirements such as upper case, lower case letters, and numbers can also be part
of the set restriction. The password requirement set by the system administrator
determines what users will need to include when creating new passwords.
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Although not recommended, administrators can choose to not set password
requirements if they wish, which will allow users to change their passwords
without any restrictions. For more information on configuring password
requirements, please refer to the Password Requirements section of the Password
Management documentation. Once you have entered the new password, click
"Save" to preserve the change.

User Profile Advanced External Accounts Downloads

Password
Current ¥ Must contain one upper case letter (A-Z)
Password

X Must contain one lower case latter (a-z)
New ¥ Must contain one number (0-9)
Password

X Minimum Length =6
Confirm
Password

Advanced Tab

The Advanced tab shows information specific to the user's preferences in Sugar.
This information includes user settings, locale settings, PDF settings, calendar
options, and layout options. Users can set up, view, or change the information
under this tab based on their geographical location and personal preference.

User Settings

The User Settings section allows you to configure various settings for your account
such as default team(s), reminders, notify on assignment, etc. The system
administrator can configure these settings for you when adding you as a user in
Sugar, but you can change these settings accordingly based on your personal
needs and preference.

User Profile Password External Accounts Downloads

User Settings

Export Delimiter: 1 Notify on i

Assignment: f
Import/Export . UTF-8 = Reminders: & Popup 30 minutes prior ¥
Character Set: ! Email all invitees

Show Full Names: '/

Default Teams: '/ Primary

Global L]
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The options available to configure in the User Settings section are as follows:

e Export Delimiter : Specify the character used to delimit exported data
from Sugar. By default, the comma is used to separate exported data in
Sugar.

e Import/Export Character Set : Select the default character set used for
data import, data export, and vCard generation. By default, UTF-8 (US or
Western Europe region) is selected as the import/export character set.

o Please be sure to select the proper character set based on your
locale setting in Sugar. This will make sure that the character set
between Sugar and your local machine matches when you export
data, import data, or generate PDFs.

e Show Full Names : Check this box if you would like your full name (e.g.
John Smith) instead of your assigned user name (e.g. jsmith) displayed in
Sugar. If enabled, your full name will appear in the My Activity Stream
dashlet, Assigned to fields, and on the upper right of your Sugar account.

e Default Teams : Select the default team(s) that will be automatically
assigned to new records you create in Sugar. Whenever you create a
record, the team is set as your default team, similar to how the "Assigned
To" field is set to you. You can have any number of default teams. When
selecting a default team set, you must select one team as the primary team
and, if the Administrator has enabled team-based permissions, you may
optionally indicate whether the teams on each set should be automatically
set to "selected" (Additional Permissions Enabled).

e Notify on Assignment : Check this box to receive an email notification
when a record is assigned to you by another user. Both the outbound mail
server and personal email settings must be configured in order to receive
the notification. For more information on configuring the outbound mail
server, please refer to the Email documentation.

e Reminders : Mark the popup or email reminder checkbox to set default
reminders for calls and meetings. Once marked, you can select the default
reminder time (e.g. 10 minutes prior) to send reminders to invitees.

Layout Options

The Layout Options section allows users to select what modules they want Sugar to
display or hide in the navigation bar.
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Layout Options

Select Modules for Navigation Bar i

Display Modules Hide Modules

ccounts
hd Contacts

Opportunities
Leads
Calendar
Reports
Quotes
Documents
Emails
Campaigns

The options available to configure in the Layout Options section are as follows:

e Select Modules for Navigation Bar : Select which modules will be
displayed or hidden in the navigation bar by using the left and right arrows
to move modules between the Display and Hide Modules column. You can
also designate the order of the modules displayed in the navigation bar by
selecting the module in the Display Modules column and clicking the up
and down arrows.

Locale Settings

The Locale Settings section is where you can specify how you would like the data
in Sugar displayed based on your geographical location. Please note that system
administrators can set the system locale settings via Admin > Locale, which will be
the default setting for all users in Sugar. But each user has the option to change
the default locale settings for their Sugar account in their user preferences.

Locale Settings

Date Format: '/ 2010-12-23 ¢ Preferred Currency: US Dollar: $ +
Show Preferred Currency:
i
Time Eormat: 23:00 + System Significant Digits: 2%
Time Zone: i UTC (GMT+0:00) = Example: $123,456,789.00
1000s separator: i
Name Display Format: Dr. David Livingstone + Decimal Symbol: '

The options available to configure in the Locale Settings section are as follows:

e Date Format : Select the format you want the date stamps displayed in
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Sugar.

e Time Format : Select the format you want the time stamps displayed in
Sugar.

e Time Zone : Select the time zone based on your current geographical
location.

o Please note that if the selected time zone is different from your
browser's set time zone, a warning message ("Your browser's
timezone does not match your saved timezone Adjust Your
Timezone.") will appear upon your next log into Sugar. You can
click the link in the warning dialog box to change the time zone in
your user preference accordingly.

o Note: This Time Zone setting only applies to modules using the
Legacy user interface. Modules using the Sidecar user interface will
utilize the browser's time zone.

e Name Display Format : Select the format you want the concatenated
name fields displayed in Sugar's list view and record view.

e Preferred Currency : Select the default currency you want Sugar to
display.

e Show Preferred Currency : Mark the checkbox to convert the base
currency to user-preferred currency in list views and record views.

e Currency Significant Digits : Select how many digits will appear after
the decimal symbol for currencies.

e 1000s Separator : Enter the default character used to separate numeric
values in the thousands.

e Decimal Symbol : Enter the default character used as the decimal symbol.

PDF Settings

The PDF Settings section allows users to set and change the default font settings
for PDF documents generated in Sugar.

The options available to configure in the PDF Settings section are as follows:

e Font for Header and Body : Select the font for the header and body of
PDF documents when generated in Sugar.

e Main Font Size : Enter the default font size for the PDF header when
generated in Sugar.

e Font for Footer : Select the font for the footer of the PDF document when
generated in Sugar.

e Data Font Size : Enter the default font size for the PDF body when
generated in Sugar.
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PDF Settings

Font for Header and Body: '/ DejaVuSans

Main Font Size: 8

Font for Footer: '/

DejaVuSans

Data Font Size: 8

Calendar Options

Sugar calendars can be shared and viewed with various iCal compatible calendar
applications such as Apple Calendar, Google Calendar, Yahoo! Calendar, Mozilla
Thunderbird, etc. The calendars are viewable as read-only in the external calendar
applications and any edits to existing calendar events (e.g. meetings, calls) can
only be done in Sugar. The Calendar Options section allows users to generate a
unique publish key to sync their Sugar calendar to external calendar
application(s). The publish key is a security feature as it prevents other users from
viewing your calendar unless they have this information. The user must have your
publish key information to view your Sugar calendar via the external calendar
application.

Publish Key : The publish key is used to uniquely identify a user's calendar
and sync Sugar's calendar to external calendar applications (e.g. Google
Calendar, Apple Calendar). A system-generated alphanumeric value (e.g.
948fc65a-9¢c89-al1f-b40c-5) is displayed by default, but users can change
this key (e.g. mysecretkey) to whatever they wish. The Publish at my
location site, Search location, and iCal Subscription URL all reflect the
publish key within the URL.

Publish at my location : Use this URL to sync free/busy information for
meetings from Microsoft Outlook to Sugar. This is helpful when scheduling
meetings in Sugar as you can view the user's free/busy information to avoid
scheduling conflicts.

Search location : Use this URL to sync free/busy information for meetings
from Microsoft Outlook to Sugar. This is helpful when scheduling meetings
in Sugar as you can view the user's free/busy information to avoid
scheduling conflicts.

iCal Subscription URL : Use this URL to integrate the external calendar
application with your Sugar calendar.

First Day of Week : Select the first day of the week that will display in
Week, Month, and Year views when viewing your Sugar calendar. This
setting also applies to calendar pickers which display when users are
setting a value for a date field (e.g. Expected Close Date).

Use the following steps to integrate the external calendar application with your
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Sugar calendar:

1. Navigate to the Advanced tab in your user profile and scroll down to the
Calendar Options section.

Calendar Options
Publish Key: i I

Publish at my location:

Search location: u | N | - | -

iCal Subscription URL: i

First Day of Week: i Sunday H

2. Copy the iCal Subscription URL then paste the value into your iCal
compatible calendar application.
o For Apple Calendar:

= Click "File" then select "New Calendar Subscription".
@ calendar m Edit View Window Help

P ® Calenc New Event #EN ‘
4 New Calendar »
iCloud INew Calendar Subscription... X3S I
piark ‘ Import...
Home Export > Mon
Close All N #BW |

Other
Found in Mail  print... %ep
US Holidays N
Birthdays

= Enter the iCal Subscription URL and click "Subscribe".

l.._ Enter the URL of the calendar you want to subscribe to.
1-1 Calendar URL:

o For Google Calendar (https://www.google.com/calendar):
= Click "Other Calendars" then select "Add by URL".
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https://www.google.com/calendar

Calendar < > A

GMT-08

+ April 2013 < Sam
SMTWTF S
123 4 5 8 Gam
7 8 9[10]11 12 13
14 15 16 17 18 18 20 7am
21 22 23 24 25 26 27
28 29 30 gam
8am
» My calendars -

10am
» Other calendars

Add a coworker's calendar

Browse Interesting Calendars

= Enter the iCal Subscription URL and click "Add Calendar".

Add by URL

URL:

If you know the address to a calendar (in iCal format), you can
type in the address here.

[ Make the calendar publicly accessible?

|_Add Calendar | Cancel )]

Use the following steps to sync the free/busy information from the Sugar calendar
to Microsoft Outlook:

1. Navigate to the Advanced tab in your user preferences and scroll to the
Calendar Options section.

2. Copy the Search location URL.

3. In Outlook, go to File > Options > Calendar > Free/Busy Options.

4. In the Internet Free/Busy section, paste the Search location URL into the
corresponding box.

Please note that the settings must be configured on each user's computer. Once
configured, the invitee shows as busy for any times currently scheduled in Sugar if
the user's email address in Sugar matches the invitee email address in Outlook.

For help troubleshooting or displaying your Sugar calendar in an external

application, refer to the Troubleshooting Viewing Sugar Calendar in Google
Calendar and Troubleshooting Feed Refresh in External Calendars articles.

External Accounts Tab
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The External Accounts tab allows users to connect to external applications (e.q.
Google, GoToMeeting, WebEx) from Sugar. Please note that you must have an
existing account with the external application prior to connecting in Sugar.

Connecting to your Google account enables you to upload and access documents
stored in the Google Drive™ from the Documents module. In addition, you can
upload and view Sugar documents via the Google Drive. For more information on
how to upload and view external source documents, please refer to the Documents
documentation.

If you connect to your GoToMeeting and WebEx accounts, you will be able to
schedule meetings in Sugar to be hosted by one of these applications. Please note
that you must indicate the specific meeting type (e.g. Sugar, GoToMeeting,
WebEx) when creating the meeting in Sugar. For more information on scheduling
meetings, please refer to the Creating Records section of the User Interface
documentation.

The following steps cover connecting to the Google application as an example:

1. Click the External Accounts tab in your user preferences then click
"Create".

User Profile Password Advanced External Accounts Downloads

Create

2. Select "Google" in the Application field then click the Connect button.

o Note: If the Google option is not available to select in the
Application field, the Google connector may not have been
configured properly via Admin > Connectors. Please reach out to
your Sugar administrator to have the Google connector configured.
For more information on configuring connectors, please refer to the
System documentation in the Administration Guide.

Application: * Coogle

3. After clicking "Connect", a pop-up window will appear. Click "Allow" to
grant permission for the connection to occur.

o Google's login screen may appear inside the pop-up if you are not
already logged in to your Google account in the active browser
window. Simply enter your credentials then click "Allow" in the next
window.

o Note: Your browser's pop-up blocker must be disabled to ensure
that the Google account connects successfully to Sugar.
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= Google Connector would like to:

@ Have offline access

Dcny ﬂ

The Google application is now connected to your Sugar account and will appear
under the External Accounts tab. Please note that for Google, GoToMeeting, and
WebEx, you can only be connected to one account per application in Sugar.

Access Tab

Users can view their access information (e.g. Access table, Roles, My Teams) via
the Access tab in the detail view of their profile. System administrators can assign
users to various teams and roles depending on what each user is allowed access to
in Sugar. You will be able to view the team(s) and role(s) assigned to you via the
Roles and My Teams section in the Access tab.

Access Table

The Access table summarizes the set of permissions assigned to the user and
allows them to view the type of access they have along with the actions (e.g. View,
Edit, Delete) they can perform in Sugar. Only system administrators have the
ability to create roles and assign them to users. Users who are assigned to the role
will only be able to perform actions defined by it. Please note that users with more
than one role assigned will have the more restrictive role setting prevail on the
access table. For example, if one role allows the user to delete records in the
Contacts module, but the other role does not allow record deletion, the user will
not be able to delete records in the Contacts module. The table will list the
modules in rows on the far left with column headers representing the type of
action (e.g. Delete, Edit, Export) users can perform in each module. For more
information on the Access table column headers, please refer to the Setting
Module-Level Permissions section in the Role Management documentation.

The following setting options are available for the Access column on the table:
e Enabled : The user is allowed access to this module.

e Not Set : Does not restrict or grant access to this module, defaults to
having "Enabled" access when selected.
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e Disabled : The user will not be able to access this module, view any of its

records, or see any trace of its existence in Sugar.

The following setting options are available for the Access Type column on the

table:

e Normal : The user will be able to perform standard functions in this
module barring restrictions from other roles or team settings. The user will
not have any type of access to the Admin menu for this module.

e Not Set : Does not restrict or grant additional access to this module,
defaults to having "Normal" access when selected.

e Admin : The user will supersede any team restrictions for this module and
be able to view all records.

o Note: User does not get access to developer tools such as Studio
and Workflow Management.

e Developer : The user will be given access to the module-specific sections
of Studio, Workflow Management, Dropdown Editor and any other
necessary menus in Admin that are specific to the module.

For more information on developer tools, please refer to the Developer
Tools documentation.

e Admin & Developer : The user will be given the rights defined with the

Admin and Developer role settings.

The following setting options are available for the actions (e.g. Edit, Delete,
Export) on the table:

Advanced Access

e All : The user will be able to perform this action on any and all records that
can be accessed.

e Owner : The user will only be able to perform this action where the
Assigned To field is set to be this user.

* Not Set : Does not restrict or grant access to this function and actions
default to having "All" access when selected.

e None : The user is not able to perform this action while using this module.

Access | Access Type Delete Edit Export Import List Mass Update View
Accounts = Enabled Admin & Owner Owner Owner All All All All
Developer
Bugs Enabled Normal Mone All Owner All All All All
Calls Enabled Normal All All All All All All All
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Sugar Roles define permissions for users such as what kinds of records they can
access and what level of access they are allowed. Roles work in conjunction with
teams to form a robust security model for non-admin users in Sugar. Roles control
three different layers of access for users within Sugar: module, field, and action-
level access. Please note that only users who are assigned to the specific role will
be able to perform actions (e.g. view, edit, delete) defined by it. For more
information on the various actions and setting options for roles, please refer to the
Access Table section. Users who are not assigned to a role can access and perform
actions in any module as long as they are assigned to the record or a member of
the team assigned to manage it. System administrators have the ability to create
various roles and assign additional roles to users via Admin > Role Management.
For more information on creating and assigning roles, please refer to the Role
Management documentation.

The Roles section displays the list of roles (if any) assigned to the user. Please note
that if you are assigned to more than one role, the more restrictive role setting
prevails. For example, if you have two roles where one role allows exporting of
records in the Leads module and the other does not, then you will not be able to
export lead records due to the more restrictive role setting.

# Roles
Select
Name = Description

Customer Support Administrator  Customer Support Administrator Role

My Teams

Teams consist of one or more users who are assigned to manage records in Sugar.
The defined permissions determine what records a user is and is not able to
access. Teams are used in conjunction with roles to form a robust security model
for non-admin users in Sugar. The My Teams section displays the list of teams a
user is associated with, which determines what records the user has access to in
Sugar. Please note that every record is assigned to at least one team, but can be
assigned to multiple teams as well if different users need access to it. The default
team(s) set in the User Settings section under the Advanced tab will automatically
be assigned to new records created by the user. Users assigned to the record, as
well as system administrators can access the record regardless of team
membership. When a user is created in Sugar, they are automatically associated
with the Global team (universal team) and a Private team (users own personal
team) is created by default. System administrators can assign users to additional
teams via Admin > User Management or Admin > Team Management as
necessary. For more information on teams as well as creating and assigning teams,
please refer to the Team Management documentation.
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My Teams

Name Description

Global Globally Visible

Max Jensen Private team for max

West This is the team for the West

Downloads Tab

The Downloads tab contains the Sugar Plug-ins for Microsoft Office (i.e. Sugar
Plug-in for Microsoft Excel, Outlook, and Word) and Sugar Plug-in for Lotus Notes.
Excel plug-in enables you to create, delete, update, or view data that is in your
Sugar application. Outlook plug-in allows you to archive emails to Sugar,
synchronize contacts, meetings, and tasks, as well as create new Sugar records.
Word plug-in enables you to merge data, such as names and address in Sugar to
perform mail merges. These plug-ins are available with all commercial editions of
Sugar and must be installed on each Windows computer running the Microsoft
Office application where the plug-in is desired. Lotus Notes plug-in allows you to
integrate with Sugar by synchronizing meetings, tasks, and contacts, as well as
archiving emails to records in your instance. The plug-in comes with the Enterprise
or Ultimate editions of Sugar and is available for purchase a la carte for
Professional and Corporate customers.

To download the plug-in(s), click the appropriate file that corresponds with your
version and bitrate of Microsoft Office Excel, Outlook, or Word. Please be sure to
check for the correct version and bitrate of your Microsoft Office application in
order to download the correct file for installation. For the Lotus Notes plug-in, the
latest version will be available for installation in the Downloads tab. For more
information on downloading and installing the Sugar plug-ins, please refer to the
appropriate Plug-ins documentation.
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User Profile Password Advanced External Accounts

Sugar Plug-ins for Microsoft Office™
Read about the plug-in features within the Plug-ins Documentation.

Sugar Plug-in for Outlook
Integrate Sugar e-mail and calendar information with Microsoft Outlook.
Sugar Plug-in for Outlook 2.5.0

Sugar Plug-in for Word

Automatically populate information from SugarCRM into form letters, direct mail and other Microsoft documents.
Sugar Plug-in for Word 2010 32bit April2014

Sugar Plug-in for Word 2010 64bit April2014

Sugar Plug-in for Word 2013 32bit April2014

Sugar Plug-in for Word 2013 64bit April2014

Sugar Plug-in for Word 365 32bit April2014

Sugar Plug-in for Word 365 64bit April2014

Sugar Plug-in for Excel

Integrate Sugar with spreadsheets for better analysis of key metrics.
Sugar Plug-in for Excel 2010 32bit April2014
Sugar Plug-in for Excel 2010 64bit April2014

Sugar Plug-in for Excel 2013 32bit April2014
Sugar Plug-in for Excel 2013 64bit April2014
Sugar Plug-in for Excel 365 32bit April2014
Sugar Plug-in for Excel 365 64bit April2014

Sugar Plug-ins for Lotus Notes™

Read about the plug-in features within the Plug-ins Documentation.

’ Sugar Plug-in For Lotus Notes

Integrate Sugar with Lotus Notes.
)
N~

User Holidays

The User Holidays subpanel appears in the detail view (e.g. User Profile tab,
Advanced tab) of the user's profile. Administrators can record the days that users
will not be working so that the time off is considered when calculating project
timelines in the Projects module. To add a holiday, click the Create button and
enter the date of the holiday along with a description and then click "Save". Users
will be able to select the scheduled holiday(s) via the Project Holidays subpanel in
Projects-related modules. For more information on creating and managing
projects, please refer to the Projects documentation.

# User Holidays

; Create I
Holiday Date: = Description:
2017-12-27 PTO
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Resetting a User's Preferences

Users can reset their user preferences back to the default out-of-the-box settings,
which will revert all changes made to the user preferences section (e.g. User
Profile, User Settings, Locale Settings). To reset your user preference, click the
Reset User Preferences button at the top of your profile in edit view or click the
Actions menu then select "Reset User Preferences" in detail view.

From edit view:
Max Jensen » Edit

m Cancel Reset User Preferences

User Profile Password Advanced External Accounts Downloads

From detail view:
Max Jensen

Edit E

Reset User Preferences e

Accessing Support

The SugarCRM Support page provides access to various Sugar Support resources
such as the case portal, documentation, knowledge base, etc. Users can easily
access the support page by clicking the Documentation & Support link in Sugar's
help pane. To access Sugar's Support page outside of your instance, go directly to
the SugarCRM Support site on your web browser.
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List View Help L

For more information, refer to the Accounts
documentation.

The Accounts module consists of companies with

wihApn wanir arganizatinn hae a ralatinnchin and ic
@ Sugar University - Become an expert

Community Forums - Join the discussion

@ Documentation & Support - Learn the details

e’i Tour - View the tour for feature highlights

0 Mobile EaShortcuts @b Feedback

The Get Started section of the Support page provides users, administrators, and
developers with the appropriate resources to get them started in configuring,
customizing, and utilizing the application. The Documentation and Knowledge
Base sections provide access to Sugar's self-help area where you can learn how to
use various parts of the application via online documentation and knowledge base
articles. The Knowledge Base provides articles based on specific topics and areas
of Sugar while the Documentation goes over the entire Sugar application in detail.

The Resources section provides key information such as: supported versions and
platforms to ensure you are running Sugar in the best performing environment,
customer resources to help you manage your Sugar subscription, view/download
purchased orders, access the bug and case portal, etc. In addition, it provides
guidelines for deploying Sugar on-site and requirements for setting up
development environments.

The Training section directs you to the Sugar University page where you can find a
variety of training options to help end users, administrators, and developers. You
can find self-paced videos or e-courses, live training and webinars, personalized
training, and pursue Sugar certification. The Community section navigates you to
the SugarCRM community page where you can collaborate with other users, Sugar
partners, and Sugar employees to answer questions, participate in discussions,
solve problems, etc.

Viewing Instance Information

Users can find information regarding their version and build of Sugar by clicking
their user name on the upper right of Sugar and selecting "About". For example,
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this will be useful if you need to confirm the current version and edition of your
instance.

Q - +

Fy
4

™ Profile

W
% Employees

& About

Last Modified: 2018-06-22 22:35:21

User Interface

Overview

The user interface includes all of the visible elements users see and interact with
while using Sugar including the headers, fields, subpanels, dashboards, etc.
Knowing how to properly navigate around the application along with what the
various layouts, options, and action items do in Sugar will be critical in managing
your data in the system. This documentation covers the basics of Sugar's user
interface as well as how to perform common tasks or operations in the application.

Sidecar Modules

This documentation will cover the user interface that was introduced in Sugar 7
called "Sidecar". Below is a list of modules which use the Sidecar user interface.
Other modules continue to use the Legacy user interface which is described in
detail in the User Interface (Legacy) documentation.

e Accounts
e Bugs

e Calls

e Cases

¢ Contacts

¢ Contracts
e Emails

e Forecasts
e Home
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e Knowledge Base

e Leads

e Meetings

e Notes

e Opportunities

e Processes

¢ Quoted Line Items
¢ Quotes

e Reports

e Revenue Line Items

e Tags

e Targets

e Target Lists
e Tasks

Note: Custom modules created in Module Builder will utilize the Sidecar user
interface. Custom modules installed to an instance prior to Sugar 7 that were not
created in Module Builder will use the Legacy user interface upon upgrade to 7.x.

Navigation Bar

All pages within Sugar display a navigation bar spanning across the top of the
screen. The navigation bar allows you to access the various modules (e.g.
Accounts, Contacts, etc.), access your Home page, perform a global search, etc.
You can configure the navigation bar via your user preferences to select which
modules you want to display as well as their order. For more information, please
refer to the Layout Options section of the Getting Started documentation.

The default navigation bar consists of the following options from left to right:

<=
' - Accounts w»  Contacts v

Opportunities

Leads =

Q & -|| +

Navigation Bar Item

Description

Home

Click the Sugar Cube icon on the upper
left to access your Home page
dashboards as well as your Activity
Stream.

Module Tabs

Both stock and custom modules can be
displayed in the navigation bar. Click
the module name to open its list view or
click the triangle to the right of each
module name to display the Actions,
Recently Viewed, and Favorites menus.
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Global Search Enter keywords into the global search
bar to search for records across all
Sugar modules.

Notifications View system notifications (if any) by
clicking the notification box. The
number shown indicates the count of
unread notifications.

User Menu Click the user profile image to open the
user menu which allows access to your
profile, the Employees module, etc.

Quick Create Click the Plus icon to open the Quick
Create menu which allows you to create
records from anywhere in Sugar.

Home

You can access your Home page from anywhere in Sugar by clicking the Cube icon
at the top left of every page. Sugar's home page houses full-page dashboards and
your instance-wide activity stream. Additionally, you can manage your dashboards
and visit recent records from the Home page actions menu. For more information,
please refer to the Home documentation.

951 Accounts v contacts v Opportunities v Leads v § Q @v +

Create Dashboard
.

+
©® Activity Stream

[t Pipeline ~ B

Manage Dashboards

22 My Default Dashboard AT M u @

. Negotiation/Review . Perception Analysis . Value Proposition . Needs Analysis

2 Advanced Workflow Dashboard
Qualification . Prospecting

Prospecting
Qualification
Fatal error during installation $8,881 (3)

Additional Information Needs Analysis
$5,654 (2)

Syntax error appears when running Value Proposition
L ing $1,378 (2)

2 Account Management

%2 Home Dashboard e

© 6 O

More recents...

LP

Module Tabs

Module tabs are located to the right of the Sugar cube icon on the navigation bar
at the top of any Sugar screen. To access a specific module's list view, simply click
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the module's name. You may also click the triangle to the right of the name to
display the Actions, Recently Viewed, and Favorites menus. The Actions menu
allows you to perform important actions within the module. The Recently Viewed
menu displays the list of records you last viewed in the module. The Favorites
menu displays the list of records you most recently marked as favorites in the

module.

-

McountsB Contacts

=+ Create Account
Account

Filter = m

i

Wiew Accounts

E

Wiew Account Reports
Impaort Accounts
Cloud Cover Trust

X &Z Funding Inc

XY&Z Funding Inc

I I » I
* * 0 0O @

2447 Couriers

The number of displayed module tabs depends on your screen resolution as well as
the size of your browser window. When your available modules do not fit within the
navigation bar's width, clicking the overflow icon (three stacked dots) to the right
of the displayed modules allows you to select and navigate to the list view of the

additional modules.

-

Accounts (20 of 21+)

Filter m

Name
¥¢  Acme Holdings
¥7 ) Resources Inc

¥r  Rhyme &Reason Inc

<+

[ g Accounts v  Contacts v  Opportunities E

Q - +

Cigy

Cu

® Leads

@ Ccalendar
Reports

@ Contracts

@ Quotes

Documents

@ Emails

< pid Create v
Accounts N
e % Billing Country

Investing Internati...  USA

hmer Group Inc USA

bn Bank USA

If you do not see a particular module tab in Sugar, please check the following:

e The module may be marked as hidden in your user preferences which will
prevent the module tab from being displayed. Navigate to your user menu
(upper right of Sugar), click "Profile", click the Advanced tab, and check
the Layout Options section. If you see the module in the Hide Modules list,
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simply move it to the Display Modules list and save. For more information
on hiding and displaying modules, please refer to the Layout Options
section of the Getting Started documentation.

¢ The administrator may have disabled the module for your entire Sugar
instance. Reach out to your Sugar administrator to have the module
displayed. For more information on displaying and hiding modules
throughout Sugar, please refer to the Developer Tools documentation.

Global Search

Global search allows users to search for information across their entire Sugar
database as opposed to restricting search within a specific module. The Global
Search bar displays on the upper right of any Sugar page and utilizes full-text
search to search throughout most fields and modules for an enhanced search
experience.

" - Accounts v i m v x E v o+

Clicking on the search bar will expand it across Sugar's navigation bar. To perform
a search, type the search phrase into the search box, and the pop-up results will
begin appearing once you enter at least one character. Click "View all results" at
the bottom of the pop-up results to see and filter additional matches. To minimize
the search bar, simply click anywhere outside of the search bar. For more
information on using Global Search, please refer to the Global Search section of
the Search documentation.

Once expanded, you will be able to access the Modules dropdown by clicking the
down arrow on the far left of the search box. This allows you to restrict results to
particular modules (e.g. Accounts, Contacts, etc.). For more information on
configuring your global search, please refer to the Search documentation.
Administrators can also enable or disable modules as well as control additional
elements of global search via Admin > Search and Admin > Studio. For more
information on these configurations, please refer to the Field Options section of
the Studio documentation as well as the Search section of the System
documentation.

Notifications

Sugar notifications relay key messages, warnings, and alerts which are relevant to

the current user. The Notifications indicator is available to all users and is located

on the upper right of the screen next to global search. The number displayed in the
notifications box indicates the number of messages with a status of "Unread". A "0"
will appear if there are no unread notifications. Clicking the number will reveal a
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dropdown displaying your most recent notifications. From the open Notifications
dropdown, click "View Notifications" in order to see all notifications in a list view.
You can also navigate directly to a single notification's record view by clicking the
subJect (e.g. Missing SMTP Server settmgs) in the dropdown.

< [@] 2

Missing SMTP Server settings 25 days ago

= View Notifications

The favicon (SugarCRM cube icon) in your browser tab will also display the count
of unread notifications. Please note that the favicon notification count only appears
in the tab while logged into Sugar. When the notification count changes, the
favicon's count will update within 5 minutes of the change or upon reloading the
browser.

Note: The favicon count can only be viewed when accessing Sugar using the
Chrome, Firefox, or Opera browser.

o ® W0 Home Dashboard » Home » & x

€ - C q

‘i v Accounts v Contacts v Q o n v on

Notifications Severity Levels
Each notification will have one of four severity levels:

e Alert (Red) : Indicates something is critically wrong with your Sugar
instance and needs the attention of your Administrator immediately
e Warning (Yellow) : Indicates something in your Sugar instance needs
your attention or the attention of your Sugar Administrator to remedy
e Information (Blue) : Standard notification including reminders of an
upcoming meeting, call, or task
o Note: In order for a notification to appear, a newly created activity
must be scheduled to begin at least one hour later than the time it
was created.
e Success (Green) : Indicates the successful completion of an action or
configuration change

Notifications List View
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The Notifications list view displays all notification records meeting the current
search criteria. For more information about searching for the desired records,
please refer to the List View Search section. The following information and options
are available from the list view:

-

’v

Preview : You can preview a notification's details by clicking the Preview
button to the right of the notification. Close the preview by clicking the "x"
at top right.

Refresh : Update the current view to retrieve the latest list view results.
Severity : The color-coded severity of each notification is displayed in the
Severity column.

Status : The Status field indicates whether or not a notification has been
viewed. A notification will be automatically marked as "Read" if the record
view is opened or the notification is previewed. You can also manually
toggle the Status field by clicking its current value.

Record view : To open a notification in record view, simply click the
notification's subject.

Accounts »  Contacts ¥  Opportunities v  Notifications ~ § Q a Q v

+
Notifications (1) Preview E

Severity % Subject % Related to Status 4 &

Subject

Missing SMTP Server settings
Vissing SMTP 5., ] ..) e ¢

Status

Description
To send record assignment
notifications, an SMTP server must be
configured in Email Settings.

Notifications Record View

The Notifications record view displays the details of a specific notification. The
following information and options are available from record view:

e Links : If a notification requires actions within the Sugar application, a link

may appear in the Description field. Clicking the link will take you to the
related record or the area where action is needed.

e Severity : The color-coded severity of each notification is displayed.
e Status : The Status field indicates whether or not a notification has been

viewed. A notification will be automatically marked as "Read" if the record
view is opened or the notification is previewed. Users may also manually
toggle the Status field by clicking its current value.
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Description

Missing SMTP Server set...

View Change Log

To send record assignment notifications, an SMTP server must be

configured infEmail Settings

Related to

Show more...

User Menu

Assigned to
Administrator

Your profile icon appears in the upper right of Sugar; clicking it displays the user
menu where you can access your profile, the Employees page, and view important
version information about your instance. To upload a photo for your profile image,
please refer to the Getting Started documentation.

+
m Profile

& Employees

& About

(=% LogOut

The user menu allows you to perform the following operations:

Menu Item

Description

Profile

View your user profile, change your
password, and personalize various
aspects of Sugar.

Employees

Navigate to the Employees module to
search and view employee records.
Users with administrative privileges can
also create and edit employees in the
system.

Note: Every user is listed as an
employee; however, every employee
may not be a user in Sugar.

Admin

Navigate to the Admin page to configure

67/1.061



http://http//support.sugarcrm.com/Documentation/Sugar_Versions/8.1/Ent/Application_Guide/Getting_Started#User_Profile
http://http//support.sugarcrm.com/Documentation/Sugar_Versions/8.1/Ent/Application_Guide/Getting_Started#User_Preferences
http://http//support.sugarcrm.com/Documentation/Sugar_Versions/8.1/Ent/Application_Guide/Employees
http://http//support.sugarcrm.com/Documentation/Sugar_Versions/8.1/Ent/Administration_Guide

and customize various aspects of your
Sugar instance.

Note: This option is only available if you
are an administrator user or have or
developer-type role access.

About Navigate to the About page to view your
instance's current Sugar edition,
version, and build, as well as credits and
source code references.

Log Out Log out of your current user session.
You will be directed back to the Sugar
login page for your instance.

Quick Create

The Quick Create menu allows you to easily create new records from anywhere in
Sugar. Simply click the Plus button on the upper right of any Sugar page to access
the menu. Please note that a maximum of ten modules may be enabled to display in
the Quick Create menu. Administrators can configure which modules are enabled
and the order in which they appear via Admin > Configure Navigation Bar Quick
Create. For more information, please refer to the Developer Tools documentation.

Q &- |+

Create Account

Create Contact
Create Opportunity
Create Lead

Create Document
Compose Email
Log Call

Schedule Meeting

Create Task

Create Note or Attachment

+ + + B Cc + + + + + +

Create Revenue Line Item
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Clicking on an item in the Quick Create menu will open the record view form for
the specific module. When using quick create while viewing an existing record
where a relationship exists between the two modules, Sugar automatically relates
the new record to the one being viewed. For example, if you are viewing an
account, ABC Company, and create a new contact via quick create, the Account
Name field in the new contact will automatically populate with "ABC Company",
thus creating the link between the two records.

All required fields will indicate "Required" in the field and must be completed prior
to saving. Once the necessary information is entered, click "Save". If you do not
wish to create the record, simply click the Cancel button. Please note that
administrators have the ability to configure the record view layout via Admin >
Studio. For more information on configuring record view layouts, please refer to
the Studio documentation.

Note: Because the Quick Create drawer overlays the page from where it is
launched, using the browser's back button will appear to send you back two pages
instead of to the previous view. To return to the previous view, use the Cancel
button instead.

Footer

Sugar's footer displays the SugarCRM logo, Mobile link, Shortcuts link, Feedback
link, Help link, as well as links to enabled third-party integrations. Users can click
these links to go back to their Home page, access the help pane, etc.

§ SUGAR 0 Mobile  EAShortcuts ¢ Feedback @ Help

The following links are available in Sugar's footer:

e Logo : Click the logo on the bottom left of Sugar to return to your home
page. Administrators can replace the SugarCRM logo with a custom logo
via Admin > System Settings. For more information, please refer to the
System Settings documentation.

e Widgets : Links for any installed third-party integrations will appear to the
right of the SugarCRM logo.

e Mobile : When viewing Sugar via a touch-screen device, the Mobile link
will appear allowing you to view Sugar's mobile site.

e Shortcuts : Access the Keyboard Shortcuts help page to view the various
shortcut keys available to use along with a description of the actions they
perform. For more information regarding the Keyboard Shortcuts help
page, please refer to the Accessibility documentation

e Feedback : The Feedback window will pop up allowing you to
communicate your overall satisfaction with Sugar. Once you have entered
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the necessary information, simply click "Send" to submit your feedback

e Help : Access the help pane via the Home page or a Sidecar module's list
view/record view (e.g. Accounts) by clicking the Help link. The top of the
help pane provides a brief introduction to the current module and includes
a link to the module's corresponding documentation. In addition, the
following learning resource and Sugar 7 tour links are available in the help

pane:

o Sugar University : Opens the Sugar University page where you
can access information regarding online and live training, the Sugar
certification program, etc.

Community Forums : Opens the Community Forums page where
you can collaborate with other users, Sugar partners, and Sugar
employees to ask questions as well as participate in active
discussions, help solve problems, etc.
Documentation & Support : Opens the SugarCRM Support page
where you can access the case portal, documentation, knowledge
base articles, etc.
Tour : Launches a quick tour to show key features of the user
interface for the home page and Sidecar module page (e.g.
Accounts) you are currently viewing. For more information
regarding the Sugar 7 tour, please refer to the Tour section of the
Getting Started documentation.
Yr  Southern Realty List View Help x
Yr | XY&Z Funding Inc For more information, refer to the Accounts
documentation.
W 24/7 Couriers The Accounts module consists of companies with whom
\uniir arcanizatinn hace a ralatinnchin and ic sanaralhs
Yr | Hammer Group Inc
@ Sugar University - Become an expert
¥y DD Furniture Inc
Yr | Dirt Mining Ltd Community Forums - Join the discussion
Yr  Union Bank @ Documentation & Support - Learn the details
Tr | JABFunds Ltd. @ Tour - View the tour for feature highlights

¥  Nimble Technologies Inc

¥ SUGAR

0 Mobile  E=Shortcuts ¢ Feedback |l2R3E[

Creating Records

There are various methods for creating records in Sugar including basic creation,
quick create, duplication, and import. The same record view layout opens when
creating records by any of these methods and includes all of the relevant fields.
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Please note that administrators can configure the Record View layouts to tailor
them to your organization's needs via Admin > Studio. For more information on
configuring layouts, please refer to the Studio documentation.

Basic Record Creation

The most common method of record creation is via the individual module itself
using the Create button in the list view or the Create {Module} option in the
module tab. This opens the record view layout in edit mode which allows you to
enter all of the desired information.

The following steps cover creating an account via the Accounts module as an
example:

1. Click the triangle in the Accounts module tab to open the actions menu and
select "Create Account". You can also click the Create button on the upper
right of the Accounts list view.

o From Accounts list view:

‘i v Accounts v  Contacts v 1§ Q @ v o
Accounts (20 of 21+)
Fitter - (e z Elo

o From Accounts module tab:

-

' v AccountsE Contacts «

4+ Create Account
Accountl

Filter ~ m

= View Accounts
il View Account Reports

P
® Import Accounts

2. Enter appropriate values for the fields in the record view layout. All
required fields will indicate "Required" in the field and must be completed
prior to saving.

3. Once the necessary information is entered, click "Save".

Creating via Quick Create
The Quick Create menu allows you to easily create new records from anywhere in

Sugar. Simply click the quick-create button on the upper right of any Sugar page
to access the menu.
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Note: Administrators have the ability to enable or disable a module in the Quick
Create menu. Also, some modules are not available to be enabled. For more
information, please refer to the Developer Tools documentation.

The following steps cover creating an account via Quick Create as an example:

1. Open the Quick Create menu on the upper right of any Sugar page and
select "Create Account".

1 v Accounts v  Contacts »  } Q @ > |+

4+ Create Account

Accounts (20 of 21+)

Filter ~ m

4+ Create Contact

4+ Create Opportunity

2. Enter appropriate values in the fields in the record view form. All required
fields will indicate "Required" in the field and must be completed prior to
saving.

3. Once the necessary information is entered, click "Save".

Creating via Subpanels
On record views, beneath a record's fields, subpanels appear which contain related

records from various modules. You can create a related record as well as link an
existing record directly from the subpanel.

Note: Administrators have the ability to disable a module's subpanels for the
entire instance via Admin > Display Modules and Subpanels. For more
information, please refer to the Developer Tools documentation.

The following steps cover creating a contact via a Contacts subpanel as an
example:

1. Click the Plus button on any Contacts subpanel on a related module's
record view.

@ emais (3) +
) coNTACTS (5 of 6+) +|-
Name s City &  State 4 Email @
w Ramonita Edberg San Francisco NY phone52@exai @

2. Enter appropriate values in the fields in the record view form. All required
fields will indicate "Required" in the field and must be completed prior to
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saving.
3. Once the necessary information is entered, click "Save".

Creating via Duplication

You can also create a new record by duplicating an existing record. The Copy
option is useful if the record you are creating has similar information to an existing
record. Please note that existing subpanel relationships for the original record will
not carry over to the duplicate.

The following steps cover creating an account by duplicating an existing account
as an example:

1. Navigate to an account's record view.
2. Click the Actions menu and select "Copy".

Nimble Technologies... ¥ m

Website Industry Share

http://www.infoga.tv Find Duplicates

Member of Type Copy

Custo
Historical Summary

3. The displayed record view is pre-populated with the original account's
values. Update the necessary fields, then click "Save".

Importing Records

The import function allows you to push multiple records of a single module into
Sugar using a .cvs file instead of creating them one-by-one. For more information,
please refer to the Import documentation.

The following steps cover importing accounts as an example:

1. Click the the triangle to access the Actions menu in the Accounts module
tab and select "Import Accounts".
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" v AccountsE Contacts

4+ Create Account
Home D

View Accounts

RecentT

E

View Account Reports

Import Accounts ot

0 |®

Costrata Trust LLC

2. In Step 1, select the import file and choose "Create new records only".
Click "Next".
. In Step 2, confirm the import file properties. Click "Next".
. In Step 3, confirm the field mappings for the import. Click "Next".
. In Step 5, view the import results.
o The Created Records tab will show all of the new account records.
o The Duplicates tab will show any records in the file that were
identified as duplicates of existing records and thus not imported.
o The Errors tab will show records that were not imported due to
errors detected during import.

O~ W

Viewing Records

Sugar records can be viewed from a variety of location including via the module's
list view, record view, Recently Viewed menu, dashlets, and reports. Please note
that you will only be able to see records as allowed by your team membership, user
access type, and assigned roles. For more information on teams and roles, please
refer to the Team Management and Role Management documentation.

Viewing via List View

Each module's list view displays all of the module's records that meet the current
search criteria. To access the list view, simply click the desired module tab. While
list views only show key fields, you can click the record's name to open the record
view and access additional details. For in-depth information about list views,
please refer to the List View section of this page.

Viewing via Record View

Each record's record view displays thorough record information including all
relevant fields followed by subpanels of related records belonging to various
modules. The record view can be reached by clicking a record's name link from
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anywhere in the application. For in-depth information about record views, please
refer to the Record View section of this page.

Viewing via Recently Viewed

As you work, Sugar will keep track of which records you have recently viewed.
Click the triangle on the right of any module's tab to see a list of the 3 records you
most recently viewed in that module. You can also click the triangle to the right of
the Sugar cube icon to see records recently viewed from across all Sugar modules.
Clicking a record name within these lists will open it in record view.

AccountsE Contacts = (

4+ Create Account
= View Accounts
il View Account Reports

@® Import Accounts

1 ® Hammer Group Inc

| ® Nimble Technologies Inc

Viewing via Dashlets

Sugar Dashlets allow you to get a quick view of various records, activities, reports,
etc. Dashlets may be added to your Home page or to the intelligence pane of any
module's list view or record view. List View dashlets display lists of records and
their desired fields. Clicking a record's name from any dashlet will open it in
record view. For more information on using dashlets, please refer to the
Intelligence Pane documentation.
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My Contacts ~ B

Name % Account Name & Office Phone *
Daron Langone (559) 848-6289
Johanne Bramwell Insight Marketing Inc (327) 402-3565
Tierra Palin Tracker Com LP (508) 131-9394
Sanford Bristol Hammer Group Inc (563) 201-0083
Trish Basta Hammer Group Inc (888) 171-3184

More contacts...

Viewing via Activity Streams

The activity stream allows you to see record changes and user posts relevant to
records you are following in Sugar. Activity stream posts will display records when
that record was modified or when a user mentions the record in their post.
Clicking the record's name link will open its record view. You can also preview the
record directly from the activity stream by clicking the Preview button to the right
of the post. For more information on viewing records via the activity stream,
please refer to the Activity Streams documentation.

Accounts (20 of 21+) Create [P Preview ¢ > x
IR All Activity Stream c B ﬂ
Type a note or drag and drop an attachment. Type @ to mention a user. Type # to m

Opportunity Name ~Extended Support 5k

reference a record.

Account Name T-Squared Techs

E LinkedIExtended Support 5klo T-Squared Techs. ® Expected Glose D...  2016-11-30
Administrator 2 hours ago
Likely $5,000.00
Created test2 Account. ®
Administrator on 2016-11-23 01:01pm Best $5,000.00
Created test1 Account. ® U Enen
Administrator on 2016-11-23 01:01pm Show more...

Linked Extended Support 5k to
T-Squared Techs.
Administrator 2 hours ago

E Created Extended Support 5k

Opportunity.
Administrator 2 hours ago

Support 5k.
Administrator 2 hours ago

Linked support to Extended
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Note: If you cannot access activity streams, the feature may have been disabled
via Admin > System Settings. For more information, refer to the System
documentation in the Administration guide.

Viewing via Preview

Record previews are accessible anywhere you see the Preview button (eye icon),
usually to the right of a record's row. Click on the preview icon to expand or
refresh the intelligence pane and view details about the record without leaving the
current page. Record previews are available from list views, subpanels, duplicate
search, Search and Select drawers, and activity stream posts.

In the preview, Sugar displays the topmost fields from the module's record view
and the record's most recent activity stream entries in the intelligence pane. To
view all of the fields that are on the record view, click "Show more...". From
module list views, left and right arrow buttons at the top of the intelligence pane
allow you to preview the next or previous record of the current list. To close a
preview, simply click the "X" in the corner of the intelligence pane.

Contacts (20 of 21+) Preview E
Filter o o A Name
Aliza Bloomfield
Name 4 Title % AccountName & Email Address & ( 01 Tit
itle
Director Operations
Y¢  Aliza Bloomfield  Director Opera...  Tri-State Medic... beans.info.pho... ( v
Mobile
Y%  JillDemo Supervisor Acme Holdings jill.demouser@... @ v (994) 871-5262
Y%  Jennie Hannum IT Developer JAB Funds Ltd. the46@exampl... ( @ Department
Ops
Y¢  Ramonita Edbe... VP Operations Nimble Techno... phone52@exa... (| @ v
Do Not Call
w Darell Erlandson VP Sales Underwater Mi... sales.hr.qa@ex.. ( @& ~
. | Account Name
Pid Daron Langone Senior Product... beans38@exa... ( @ ~ Tri-State Medical Corp
Y¢  Truman Marcus Director Opera... section.kid@ex... ( @ Email Address
beans.info.phone@example.com
Y¢  Ricky Gailey Director Opera... support.sectio.. (I @ v beans.ga.sugar@example.tw
Y%  Trudie Kelton Director Sales First National S... dev64@examp... ( @& Tags
Y¢  Johanne Bram... VP Operations Insight Marketi...  vegan64@exa... ( @ «
Y¢  Dulcie Donalson  Director Opera...  Dirt Mining Ltd info52@examp... (| @&
v¢  Stefan Constable Director Opera... First National S... beans.dev@ex.. ( @& ~ Linked Aliza Bloomfield to Monthly
. ) ) | a News.
Y¢  Miles Rux Director Opera... DD Furniture Inc  info.sugar@ex... ( @& Will Westin on 2018-01-03 11:08am
Y¢ | Tierra Palin President Tracker Com LP infol0@examp... ( @ w

Viewing via Reports

The Reports module allows you to build, run, and manage reports to gather key
record information. In addition to only displaying the fields and relationships you
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desire, reports can utilize complex filters to display specific subsets of your
records. Once a report is run, you can click any record's name link in the results to
open its record view. Please note that you can only directly access record views
with Rows and Columns-type and Summation with Details-type reports as
Summation-type and Matrix-type reports do not include hyperlinks in their display
columns. For more information on using reports, please refer to the Reports
documentation.

Type: Rows and Colu

Mame: Accounts Report Report

Modules: Accounts, Accounts = Email
Address

Display Columns: Mame, Emall Address Assigned to: Adminis
Schedule: None

Filters: None

Teams: Global

(1 - 53 of 53)

Name Email Address
ABC Company abc@example.com
Evermore Company evermore@example.com

In addition to navigating to the Reports module and finding or building relevant
reports, you can use the View {Module} Reports option to see only the reports
based on the desired module.

AccountsE Contacts =

4 Create Account

= View Accounts

Ll View Account Reports

EE |

® Import Accounts

Please note that your ability to access reports may be restricted by a role. For
more information on roles, please refer to the Role Management documentation.
Check with your system administrator if you cannot access the Reports module.

Searching for Records

Each module's list view includes a list view search to help you easily locate records
in a module-specific manner. Matching records will be displayed in the list view
below. Global search allows users to search for information across their entire
Sugar database rather than restricting searches to a specific module. In both
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searches, Sugar automatically appends the wildcard character (%) to the end of
your search phrase. This allows the system to retrieve all records that start with
the keyword entered in the search. If you would like to broaden the search, you
can use the wildcard at the beginning of your text as well (e.g. %services). This will
pull up any record that has the word "services" in the name, regardless of how it
starts or ends.

Global Search

For a brief introduction to global search, please refer to the Global Search section
of this page. For in-depth information on both search methods as well as how
wildcards are used in the different methods, please refer to the Search
documentation.

List View Search

List view search enables users to easily search by the record's name within an
individual module and pull up matching records in the list view. The search also
provides a Filter option allowing you to narrow your search further using the
available options as follows:

e Create : Create a new custom filter which you can use to filter your search
o Note: You can also click "Create" to the right of the Filter option.

e All "Module Name" : Returns all records in the module (e.g. Accounts) to
which you have access

e My "Module Name" : Returns only records assigned to you

e My Favorites : Returns only records you have marked as favorites

e Recently Created : Returns only records you created in the module within
the last 7 days

e Recently Viewed : Returns only records you have viewed in the module
within the last 7 days
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+ Create
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v All Accounts
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My Accounts
h Inc Salt Lake City Us @ ~
My Favorites
| C Salt Lake City Uus @ ~
Recently Created
AG Denver Uus @ ~
Recently Viewed

When you choose a filter, Sugar will return records that match both the selected
filter and any name provided in the open Search box in the filtered list view
results. For example, if you select "My Accounts" in the Filter options and enter a
query in the Search box, Sugar will only return account records that are assigned
to you and have names that match the search term. Once the search is complete,
the relevant results will populate in the list view below the search bar.

Accounts (3)

T [y accounts © BT x =z o
Name $ City ¢ BilingCountry ¢ Ph Lo

¥ Introductory Holdings Pittsburgh USA 4 @& -

¥¢ | Kings Royalty Trust Toronto Canada (1: & ~

¥ | Tracker Com LP Denver USA 01 @ ~

Note: The yellow highlighting in this image has been added for effect and will not
appear in the application.

When you perform a search using a filter from the filter list, the filter will continue
to apply if you navigate away from and then return to the module's list view. Any
text query entered in the open Search box, however, will not be preserved.

To see all account records to which you have access, simply select the All Accounts
option in the filter and remove any text from the search bar:
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A Arrmiinte

To clear an applied filter, click the "x" on the selected filter option (e.g. My
Accounts) in the Search box; to clear a text query from the search, click the "x" on
the right end of the search box:

ISR v 2ccounts © RS e Bo

To update the filtered list view with the most recent results, click on the Refresh
icon to the right of the search box:

Accounts (20 of 21+)
Filter - o | &)
Type v is any of v [ m ] - 4

Please note that you will only be able to see records as allowed by your team
membership, user access type, and assigned roles. For more information on teams
and roles, please refer to the Team Management and Role Management
documentation. Administrators can configure what fields appear on the List View
Search via Admin > Studio for certain modules. For more information on editing
layouts, please refer to the Studio documentation.

Creating a Filter

Users can also create new filters via the Create option in the Filter list of the
search bar. This allows users to add custom, complex filter options when searching
in the module's list view. You have the option to add multiple fields to your new
filter by clicking the Plus button to the right of the filter selection dropdown lists
and set select operators along with their value(s). A filter's criteria need to be true
for a record in order for it to appear in the list view search result. Additionally,
filters with no specified values may be saved as a custom filter to act as a filter
template when a user often searches using the same fields but with varying values.
Please note that only fields you have view access for will appear in the Filter list
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when creating a search filter.

When you run a search using a created filter, the search will be preserved when
you navigate away from the module. Returning to the list view will automatically
display the results of your last filter.

The following steps cover creating a new Assigned to filter in the Accounts module
as an example:

1. Click the Filter option on the Accounts search bar then select "Create".

Accounts (20 of 21+)

R e
Q & C(City & Billing Country
+ Create
oldings Pittsburgh USA
Nearby Prospects
rust Toronto Canada
v All Accounts
ing Inc Persistance USA

o You can also click "Create" to the right of the Filter option.
2. Select the field you wish to add to your filter as well as the condition and
matching criteria.
o Note: Only fields you have view access for will be available to add
in the Filter list.
3. To add additional fields to the new filter, click the Plus button to the right
of the filter.
o To remove fields from the new filter, click the Minus button to the
right of the filter.
o To clear any filter values (e.g. Will Westin), simply click the "x" to
the right of the value or select "Reset" to the left of the Save button.

Filterv 4 o

Assigned to [z] isanyof

Search and Select...

Name $ City 4 BilingCountry 4 Prore v—ocr v £

The list view will automatically display results matching your filters as you create
and modify the criteria. To view the most recent matching records for an existing
filter, click on the Refresh button to the right of the search box.

Note: When filtering a relate field using "is any of" or "is not any of", you can
select up to 20 values.

82/1.061



Saving a Filter

Saving a filter will preserve the chosen fields as well as the condition(s) of the
matching value(s). Additionally, it will allow users to easily select previously
created and saved filters from the Filter options.

The following steps cover saving a new search by Name filter for the Accounts
module as an example:

1. Create a new filter to perform a search on your desired fields.
2. Enter a name for the new filter (e.g. "Accounts assigned to Sarah and
Will").

posines o - sanyor [ oo s Y v wesen SRR

I Accounts assigned to Sarah and Will | Reset  Cancel

3. Click "Save" to add this filter to the module's Filter options.

You can also create and save a filter without entering any filter values (e.g. Sarah
Smith) if you wish to enter new values each time you utilize the filter. When re-
using the filter simply enter the appropriate filter value(s) and the list view will
display the matching results. Once you are done with the filter, click "Reset" to the
far right of the filter's name to clear the filter value(s).

The custom filter can always be edited as necessary by selecting the filter and
updating the fields, conditions, values, etc. via the filter details panel. Once the
necessary updates have been made, click "Save" to preserve the changes.

Please note that you can easily delete custom filters by selecting the filter (e.g.
Accounts assigned to Sarah and Will) from the Filter list, clicking the filter's name
on the Search bar, then clicking "Delete" on the filter details panel.

List View

A module's list view displays all records meeting the current search criteria and to
which users have access. You can view the basic details of each record within the
field columns of the list view or click the record's name to open the record view. To
access a module's list view, simply click the module tab (e.g. Accounts) in the
navigation bar at the top of Sugar.

Please note that you will only be able to see records as allowed by your team
membership, user access type, and assigned roles. For more information on teams
and roles, please refer to the Team Management and Role Management
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documentation.

-

' - Accounts |+  Contacts w  Opportunities v Leads =  Calendar v  Reports
Accounts (20 of 21+)
Filter m = ®

Name + City < Billing Country &  Phone % User e
¥%  Introductory Holdings Pittsburgh USA (412)123-9876  WillWestin @&
%  Kings Royalty Trust Toronto Canada (123)456-1234  Will Westin @&

Users with administrator or developer access have the ability to change what fields
are visible in the list view via Admin > Studio. For more information on editing
layouts, please refer to the Studio documentation.

Total Record Count

The list view displays the total count of records (e.g. "20 of 21+") on the upper left
of the page next to the module name (e.g. Accounts). The count will capture the
total number of records displayed on the current set of list view results. If there
are additional records in the list view results set, a hyperlinked number (e.g.
"21+") will display to the right of the initial count. Simply click the hyperlinked
number in the parentheses to view the total count of all records in the list view
result set.

‘i v Accounts »  Contacts »  Opportunities

Accounts|(20 of 21+)

Please note that, by default, Sugar displays 20 records per list view results set, but
administrators can change the number of records displayed via Admin > System
Settings. For more information, please refer to the System documentation.

Create Button
The Create button on the upper right of the module's list view allows users to

easily create new record's in the module. Once you click the button, the module's
record view layout opens where you can enter all of the relevant information to
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create the new record. Please note that administrators can configure the Record
View layout via Admin > Studio. For more information on configuring layouts,
please refer to the Studio documentation.

Accounts (20 of 21+)
Fer - () c@o

List View Search

To search for a specific record within a module or for a list of module records
filtered by name, use the search bar located above any module's list view. Start
typing a word into list view search and Sugar will retrieve all records that start
with the given characters.

Accounts (20 of 21+)
e - )| @ e

List view searches also support the system wildcard character (%) to retrieve
results that contain certain characters in their name or title. For more information
about performing module-specific searches via list view, please refer to the Search
documentation.

Refreshing Search Results

The list view's Refresh button provides a quick way to reload the results of any
filtered or unfiltered list view without reloading the browser or losing any filter or
search criteria you may have set. Simply click on the Refresh button to the right of
the search box to load the most current list of matching records.

Accounts (20 of 21+)
efrresn lis

Fiter - (YD) z | o
Type v isanyof B csiomer o) | -+

Checkbox Selection

Users can perform various types of actions on module records by first selecting the
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desired records from the module's (e.g. Contacts) list view. To select individual
records from the list view, mark the checkbox on the left of each record row.

iter - (D  @e

v Name ¢ City 4 BilingCountry ¢ Ph &
¢ | Introductory Holdings Pittsburgh USA 4 @ -
Kings Royalty Trust Toronto Canada 1z ® ~
v | Insight Marketing Inc Persistance USA 9 @ ~

To select all records displayed on the current set of list view results, click the
checkbox to the left of the Actions menu. Please note that a dialog will appear
below the list view's column headers indicating that you have selected all records
on the list view's current result set (e.g. 20). To select all records in the search
results, click "Select all records" in the dialog.

- Name % City %4 Billing Country # Ph &
You have selected all 20 records in this viewn the result set.

Y  Introductory Holdings Pittsburgh USA 4 @ -

W Kings Royalty Trust Toronto Canada (1z @& +

If you wish to clear the selection for all records on the list view result set, simply
click "Clear selections" in the dialog. You can also clear the selections for all
records by clicking the checkbox option again to remove the check marks.

hd Name % City % Biling Country # Ph e
You have selected all 31 records in the result setl Clear selections.

v | Introductory Holdings Pittsburgh USA 41 @ -

% | Kings Royalty Trust Toronto Canada iz @ -~

Mass Actions Menu

The Mass Actions menu to the right of the checkbox option allows you to perform
various actions on the currently selected records. Please note that the actions
available to perform will vary between each of the modules. To access the Mass
Actions menu simply click the triangle next to the checkbox option.
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Export
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For more information on the actions available within a specific module, please
refer to the list view section in the application guide pertaining to that module. The
most common actions available in the Mass Actions menu are as follows:

Menu Item Description

Email For modules which include an Email
field, send an email to one or more
records' email addresses

Mass Update Mass update one or more records at a
time

Merge Merge two or more duplicate records

Recalculate Values For modules with a calculated field,

updates calculated values to reflect
recent changes to calculated fields
made via Admin > Studio

Delete Delete one or more records at a time
Export Export one or more records to a CSV file

The following sections will cover the most common type of actions available in the
Mass Actions menu.

Favorite Designation

Users have the option to mark records as favorites via a module's list view. This
allows users to designate records that are important or will be viewed often so that
they can easily be accessed via the search filter's My Favorites option or from the
module tab's Favorites option. In the module's list view, the star on the left of each
record's row is orange once marked to indicate a favorite record. For more
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information on how to mark records as favorites, please refer to the Favoriting
Records section of this documentation.

The following steps cover marking records as favorites via the Accounts list view
as an example:

1. Navigate to the Accounts list view by clicking the Accounts module tab.

2. Use the List View Search to find the Account records you wish to mark as
favorites.

. Mark the star icon on the left of each desired account's row.

To remove the account as a favorite, click the star again to revert it to

white.

> W

Y% | Introductory Holdings Pittsburgh

E Kings Royalty Trust Toronto

mmsight Marketing Inc Persistance

Column Reordering

List view provides the ability to reorder columns by dragging and dropping the
title of the column to the desired location. The new column order will remain for a
user upon subsequent visits to the module until the user's browser cache is
cleared. You can reset the column order back to the default view by clicking the
Gear icon to the far right of the list-view column headers and selecting "Reset
default view". Please note that this option only appears if the current column order
differs from the default order.

e - G c @e

Name Phone P4 = + Billing Country % Lo

%  Kings Royalty Trust Toronto Canada (123)456-1234 @&

Column Resizing

Users can easily adjust the size of columns in list views per their viewing
preference. Simply place your cursor on the column divider, and when the left-and-
right arrow appears, click and drag the column to the desired size.

The set column width will be preserved when you navigate away from the page.
Sugar will render the preferred column size across sessions until the user removes
or resets the relevant browser cookies. You can reset the column width back to the
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default size by clicking the Gear icon to the far right of the list-view column
headers and selecting "Reset default widths". Please note that this option only
appears if at least one of the column widths in the current list view is different
from the default column width.

Changes to the column width made by administrators in Studio are only respected
if the user has not resized the specific column in the list view. The column width
set by the user will supersede the default column width configured in Studio until
the user resets the list view back to the default widths. For more information how
admins can set column widths, please refer to the Studio documentation.

Note: Sugar enforces a minimum width for currency fields (e.g. Best, Likely, etc.)
in list view columns to prevent the columns from being collapsed beyond this limit.

=

Name v none & City + Billing Country 5 &
%  Kings Royalty Trust (123)456-1234  Toronto Canada @ -
¢ | JAB Funds Ltd. (366) 842-4996 St. Petersbu... USA @ -

Column Sorting

Sugar's list view provides users the ability to sort all of the current search results
by a field column in either ascending or descending order. To sort by a field or
switch the sort direction, click the column header noting that the fields which
allow sorting will have a pair of arrows. You can click the column header again to
reverse the sort order.

Note: List views may only be sorted by one column at a time and cannot be sorted
by custom relate fields or the Tags field.

Name % Phone & City E Billing Country $ o]

%  Kings Royalty Trust (123)456-1234  Toronto Canada @ -

Column Selection

Sugar gives users the ability to personalize the list view by specifying which fields
they want to be displayed in the list view. You can click the Column Selection icon
to the far right of the list-view column headers to see the list of available fields.
Click a field name to toggle whether or not it is included as a column in your list
view. Please note that administrators have the ability to configure what fields are
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available to display in the list view via Admin > Studio. For more information on
configuring fields to display in the list view, please refer to the Studio
documentation.

Name % Phone &  City = BilIingCountry%_

#  Kings Royalty Trust (123) 456-1234  Toronto v Name "

¥7  JABFunds Ltd. (366) 842-4996  St. Petersb, ¥ Phone "

¢  Cloud Cover Trust (598) 722-5280  St. Petersb, ¥ CIY |
v Billing Count

#r  Nimble Technologies Inc ~ (182)329-3369  Santa Fe (ing tountry |
v User

¥y  Spindle Broadcast Corp. (510) 946-3705 Santa Fe v
v Email Address

Y7 | Aim Capital Inc (506) 505-8650  Santa Fe "
v Date Modified

¥¢ | 24/7 Couriers (382)239-7069  San Mateo "
v Date Created

vy | Tri-State Medical Corp (171) 906-5479 San Jose 4

Preview

Users can preview a record's details directly from the module's list view by
clicking the Preview icon to the far right of each record's row. Please refer to the
Viewing via Preview section of this page for more information.

Contacts (20 of 21+) Preview > x
ISR Create | o o Y Name
Aliza Bloomfield
Name & Title % AccountName % EmailAddress & ( ] "
e
Director Operations
Yy  Aliza Bloomfield  Director Opera... Tri-State Medic...  beans.info.pho... ('
Mobile
v JillDemo Supervisor jil.demouser@... @ v (994) 871-5262
Yy  Jennie Hannum IT Developer JAB Funds Ltd. thed6@exampl... ( @ ~ Department
Ops

Record Actions Menu

The Record Actions menu to the right of each record's Preview button allows users
to edit, follow, delete, etc. specific records directly from the list view. For example,
users have the ability to inline edit the display column fields directly from the list
view by clicking the triangle next to the Preview icon then selecting "Edit".
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Daryl Leaman
Sherrill Pfeil
Veta Puryear

Marge Heeter
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Soon Basler

New

Recycled
Assigned
Assigned

New

Overhead & U...

Underwater Mi...

White Cross Co
RR. Talker Co

Dirt Mining Ltd

(661) 675-8591 s @|

Edit

Follow

Delete

Convert

The options in the Record Actions menu allow you to perform the following

operations:

Menu Item Description

Edit Edit this record

Follow Follow this record

Delete Delete this record

Convert For the Leads module, convert this lead

More Records

The list view loads an initial number of records meeting the current search criteria
with the option to show additional results at the user's request. By default, Sugar
displays 20 records per list view results set, but administrators can change the
number of records displayed via Admin > System Settings. For more information
on changing the number of displayed records, please refer to the System
documentation. To load the next set of list view results, simply click the More
"Module Name" (e.g. More accounts) link at the bottom of the list view.

Y% | Smith & Sons

I XY&Z Funding Inc

Y& | Chandler Logistics Inc

More accounts...

¥ SUGAR

Activity Stream

(550) 176-4995  Los Angeles USA Maxle @& =
(974) 319-4045 Kansas City USA Christ @ =
(575) 569-7545  Kansas City USA JimBri @

0 Mobile EzShortcuts ¢ Feedback @ Help

The module's activity stream displays user posts made directly via the module as
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well as record posts relevant to the module record. To view the module's activity
stream, simply click the Activity Stream button to the right of the list view's search
bar. For more information on how to add posts to the activity stream, please refer
to the Activity Streams documentation.

Note: If you cannot access activity streams, the feature may have been disabled
via Admin > System Settings. For more information, refer to the System
documentation in the Administration guide.

You can add comments to posts using the comment button to the far right of each
post. You can also preview the record referenced in record posts by clicking the
Preview button to the right of each post. The activity stream can be filtered to only
display certain messages (e.g. Messages for Create, Messages for Update, etc.) by
clicking "Filter" above the post input box and selecting the desired message type.
You can also refresh the activity stream to view its latest entries by clicking the
Refresh button to the right of the filter area.

1 - Accounts v i Q g v o
Accounts Create
Al Activity Stream o | @
v All Activity Stream
p an attachment. Type @ to mention a user. Type # to reference a [:
Messages for Create
Messages for Link . .
Smith & Sons to Introductory Holdings. @
Messages for Post Sago
Messages for Unlink b Introductory Holdings. ®» @
Messages for Update
ea—createe-taereaseiory Holdings Account. ®» @

Will Westin 15 hours ago

Dashboards

To the right of list views, the intelligence pane displays dashboards when not
displaying a record preview. Dashboards are sets of dashlets configured for the
specific list view to display useful Sugar data. An out-of-the-box default dashboard
will likely be initially displayed on your list view intelligence pane. Sugar admins
are able to create and push custom default dashboards to your views. You may also
create personal dashboards using the dashlets and configurations that best suit
your business needs. All dashboards can also be shared with teams of users who
can the pull the dashboards to their views as desired. Ensure the intelligence pane
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is expanded using the Arrow icon at the top right of the list view. For more
information, please refer to the Dashboards and Dashlets documentation.

Quotes v  Documents v Q @ > +
Accounts List Dashboard ~ w Create ~
~ . My Accounts PN

¢ D o Name % Billing Country & City
20 @ - . .

Introductory Holdings USA Pittsburgh

. A @~ Kings Royalty Trust Canada Toronto

m A &~ Insight Marketing Inc USA Persistance

t A e~ B.C. Investing Internati... ~ USA Persistance

o. A|® |~ Hammer Group Inc USA Alabama

@.. 20 @ =

More accounts...

n A @ -

Record View

The module's record view displays thorough information regarding the record such
as name, email address, phone number, etc. Beneath the fields, you can toggle
between viewing a record's subpanels of related records (e.g. Opportunities,
Leads) and the record's activity stream. The record view can be reached by
clicking a record's link from anywhere in the application including from the
module's list view.

Please note that you will only be able to view a record according to your team
membership, user type, and role restrictions. For more information on teams and
roles, please refer to the Team Management and Role Management
documentation. Users with administrator or developer access have the ability to
change the record view by configuring the layout via Admin > Studio. For more
information on editing layouts, please refer to the Studio documentation.
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O sanesmin « <> 238

Title Mobile

Sales Manager (415) 878-BBEBE
Department Do Mot Call

Sales

Account Mame Email Address

Smith & Sons jane@example.com

Favorite Designation

Users have the option to mark records as favorites via the module's record view.
This allows users to designate records that are important or will be viewed often so
that they can easily be accessed via the search filter or from the module tab. In the
module's record view, the star to the right of the record's name is gray once
favorited.

© seresmin [+] Bz <> 28
Title @ Mobile

Sales Manager (415) 878-8888

Following Designation

Users can also choose to follow specific records to which they have access to in
Sugar by clicking the Follow button to the right of the record's name. The ability to
follow records allows each user to personalize their activity stream by specifying
which records' posts should appear on the activity streams displayed on their
Home page and in module list views. Please note that you will automatically follow
records that you create as well as records that are assigned to you. You will not,
however, automatically follow records you import. Should a user lose access to a
record in Sugar, they will automatically stop following that record. Instructions for
toggling the Following button on a record view, please refer to the Following via
Record View section of this documentation.

ABC Incorporated ¢ > m

Website ndustry

http://www.abcinc.com Communications
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Next or Previous Record

On the upper right of the record view, there are two buttons that allow you to page
through each record in the module's list view's current search results. Clicking the
Left arrow button displays the previous record of the current search results while
clicking the Right arrow button displays the next record of the current search
results.

@ jane Smith % eai - |
Title MMaobile m

Sales Manager {415) B78-B8E8

Actions Menu

The Actions menu on the top right of each module's record view allows you to
perform various actions (e.g. edit, copy, delete) on the current record.

o ABC Company t¥ > m

Website ndustry Snare
http://www.abcco.com Commul pownload FDE
Member of Type Email PDF
Custom
Find Duplicates
Assigned to Office Ph
Will Westin (415) 78§ COPY
Tags Historical Summary
View Audit Log
Billing Address Shipping 8 view Personal Info
123 First 5t
San Francisco, CA 94015 Delete
USA

Please note that certain action items (e.g. Convert Lead) in the Actions menu can
vary between the various modules. The following sections will cover the most
common action items across the modules. For more information on a specific
action not listed below, please refer to the record view actions menu section for
the specific module's documentation in the application guide.

Menu Item Description

Edit Edit this record
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Share

Share a link to this record via email

Download PDF

Download record information as a PDF
file

Email PDF

Email record information as a PDF
attachment

Find Duplicates

Locate potential duplicates of this
record

Copy

Duplicate this record

Historical Summary

View a historical summary of activities
(e.g. calls, meetings related to this
record

View Audit Log

View a sequence of changes made to
this record

View Personal Info

Display this record's fields which an
admin has designated as personal
information

Delete

Delete this record

Show More

The record view typically displays a few key fields (e.g. website, mobile phone,
office phone) on the business card panel with the option to view more fields by
clicking the "Show more..." link on the bottom left. Please note that administrators
can configure the fields that appear on the business card panel via Admin > Studio
> Layouts > Record View. For more information on editing layouts, please refer to
the Studio documentation.

ABC Incorporated i

Website

http://www.abcinc.com

Member of

Assigned to

Mary Thompson

Tags

Show more...

Follow

Industry

Communications

Type
Customer

Office Fhone
(510) 788-B788

> I

96/1.061



http://support.sugarcrm.com/Documentation/Sugar_Versions/8.1/Ent/Application_Guide/User_Interface/#Sharing_Records
http://support.sugarcrm.com/Documentation/Sugar_Versions/8.1/Ent/Application_Guide/User_Interface/#Downloading_Record_PDFs
http://support.sugarcrm.com/Documentation/Sugar_Versions/8.1/Ent/Application_Guide/User_Interface/#Emailing_Record_PDFs
http://support.sugarcrm.com/Documentation/Sugar_Versions/8.1/Ent/Application_Guide/User_Interface/#Finding_Duplicate_Records
http://support.sugarcrm.com/Documentation/Sugar_Versions/8.1/Ent/Application_Guide/User_Interface/#Creating_via_Duplication
http://support.sugarcrm.com/Documentation/Sugar_Versions/8.1/Ent/Application_Guide/User_Interface/#Viewing_Record_Historical_Summaries
http://support.sugarcrm.com/Documentation/Sugar_Versions/8.1/Ent/Application_Guide/User_Interface/#Viewing_Record_Audit_Logs
http://support.sugarcrm.com/Documentation/Sugar_Versions/8.1/Ent/Application_Guide/User_Interface/#Viewing_Personal_Information
http://support.sugarcrm.com/Documentation/Sugar_Versions/8.1/Ent/Application_Guide/User_Interface/#Deleting_via_Record_View
http://http//support.sugarcrm.com/Documentation/Sugar_Versions/8.1/Ent/Administration_Guide/Developer_Tools/Studio#Editing_Layouts

Subpanels

Beneath the module (e.g. Accounts) record's fields are subpanels containing
related records from various modules (e.g. Contacts, Leads, Opportunities). You
can create a related record as well as link an existing record directly from the
subpanel. Once the records appear within the subpanel, users can preview the
record's detail and edit the record's data directly from the record view. Please note
that the subpanels are viewable when you access the Data View section of the
module's record view.

Show more...

Related = m Filter % O]

CALLS (5 of 6+) + -

(D contacts (2) + -
Name & City & State $ Email s

7 |ohanne Bramwell New York MY johanne. b@example.net @& -

7 Lindsay Smith San Francisco CA lindsay@example.com @& -

Note: Administrators may choose to disable a module's subpanels for the entire
instance via Admin > Display Modules and Subpanels. For more information,
please refer to the Developer Tools documentation.

Related Record Subpanels

Subpanels under a module's record view contain its related records. Each
relationship between two modules has a type, and that type determines if the
relationship produces a field or a subpanel for each side. When a record of the
primary module can be related to only one record of a second module (i.e. 1-1 or
M-1 relationships), the relationship is displayed as a field on the primary module.
When the record can be related to multiple records of a second module (i.e. 1-M or
M-M relationships), the relationship is displayed as a subpanel instead since
subpanels can hold many records.

For example, an account may be related to multiple contacts, so the related
contacts are displayed in a subpanel on the account record. Administrators or
users with developer-level role access may choose to change a subpanel's title and
included fields by configuring the layout via Admin > Studio to provide visibility to
the most important fields. For more information on modifying subpanels, please
refer to the Studio documentation.
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Related-record subpanels provide the following information and capabilities:

Related « m Filter o E @
+

CALLS (5 of 6+) l open/close
| () conTACTs|(5 of 6+)

Link Existing Record

| Mame

L

City ¥ | State & Email

* Steven Ewert Ohio CA steven®@example.com E
g Lauren Burkes Los Angeles CA lauren@exs Edit
o Johanne Bramwell Mew York WY johanne.b@ Unlink

' o Lindsay Smith San Francisco  CA lindsay@example.com @ -
g |eanette McCormick St. Petersburg CA j-mccormick@example.com @&@ -

Mare contacts...
i

e Record Count : Subpanel headers display the total count of related
records (e.g. "5 of 6+") next to the module name. The count captures the
number of records currently displayed with an additional, hyperlinked
number (e.g. "6+") where there are more records than currently displayed.
Click the hyperlinked number to see the total count of related records.

e Collapse or Expand : Click anywhere in the subpanel's header to collapse
or expand it. Subpanels will remain collapsed or expanded on future visits
to the module.

o Note: Administrators can choose to disable the sticky feature and
collapse all subpanels by default via Admin > System Settings. For
more information, please refer to the System documentation.

e Column Widths : Place your cursor on the column divider and, when the
double arrow cursor appears, click and drag the column to the desired size.
Please note that the column width will not be preserved when you navigate
away from the page.

o Note: Sugar enforces a minimum width for currency fields in list
view columns to prevent the columns from being collapsed beyond
this limit.

e Column Sort : Click a column header to sort the subpanel's items by that
value. Clicking the same header again will reverse the sorting order (e.g.
from ascending to descending).

e Create a New Linked Record : Click the Plus button on the upper right of
a subpanel to relate a new record to the record you are currently viewing.
Please note that the Link Existing Record option is not available when the
relationship is required in the related module (e.g. in an account's
Opportunities subpanel).
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o Note: Because creating a new related record opens a drawer on top
of the current record view, you should use the Cancel button to
return to record view. Using the browser's back button will return
you to the previous page.

e Link Existing Record : Click the triangle to the right of the Plus button
then select "Link Existing Record" to relate existing records to the record
you are currently viewing.

o Note: Because linking an existing record opens a drawer on top of
the current record view, you should use the Cancel button to return
to record view. Using the browser's back button will return you to
the previous page.

e Favorites Designation : Click the star on the left of a record's row to
toggle it as a favorite. A dark gray star indicates that the record is a
favorite while a white star indicates it is not. For more information, please
refer to the Favoriting Records section of this page.

e Hyperlink Fields : Blue field values, such as record names, may be clicked
to open the record in record view. Record view provides a complete picture
of the record and is described in detail in the Record View section of this
page. Email addresses also appear in blue and can be clicked to compose
an email to that recipient.

e Record Actions Menu : Click the triangle on the right of a record's row to
access the Record Actions Menu which includes the following options:

o Preview : To preview a record by displaying its fields and activity
stream in the right-hand side drawer, click the Eye icon to the far
right of the record's row. For more information, please refer to the
Viewing via Preview section of this page.

o Edit : To inline edit the record directly within the subpanel, choose
"Edit" from the Actions menu on the right of the record's row and
click "Save" to preserve the changes.

o Unlink : To delete the relationship between the two records,
choose "Unlink" from the Actions menu on the far right of the
record's row. This removes the relationship but does not delete the
record itself. Please note that the Unlink option is not available
when the relationship is required in the related module (e.g. in an
account's Opportunities subpanel).

o Additional Options : Some modules may have additional options
available which are covered in the individual module's
documentation.

e More Records : By default, Sugar displays up to five records in each
subpanel though administrators can alter the number via Admin > System
Settings as described in the System documentation. If additional related
records exist, click "More <Module Name>..." (e.g. "More Accounts...") at
the bottom of the subpanel to load the next set.

Filtering Subpanels
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While in Data View, all of the related records will be displayed beneath the
record's fields. Users have the ability to search for records which appear in the
subpanels as well as filter the view to only display a specific module (e.g. Leads,
Contacts). To locate a record by name, enter the keyword into the Search bar, and
the subpanel(s) with the matching record(s) will appear below.

[(Related - (Coneen)] Fier - (2000 « 2z Blo
+

@ CONTACTS (1)

Name = City *  State & Email

A

o Lindsay Smith San Francisco  CA lindsay@example.com @& -

To filter, simply click the Related option to the far left of the Search bar and select
the module whose subpanel you wish to view. Filter and search may be combined
to only display matching records within a selected module. To see all subpanels to
which you have access, simply select "All" in the Related options and remove any
text from the search bar. When you run a search using a saved or created filter,
the search will be preserved when you navigate away from the page. Returning to
the page will automatically display the results of your last filter. Please note that
search strings entered in the open Search box are not preserved when navigating
away.

When a Sidecar module (e.g. Contacts, Leads, Tasks) is selected from the Related
options, you have the option to filter the related subpanels further using one of the
available options (e.g. My Favorites, Recently Created). Please note that you can
also create custom filters for related Sidecar modules. Once the related module
(e.g. Contacts) is selected, either click the Filter option and select "Create" or click
"Create" to the right of the Filter option. For more information on creating a
related records filter, please refer to the Creating a Related Records Filter section
of the Search documentation.

[EEER  contacts | IR | Cronte cBo
+ Create
@ CONTACTS (5 + -
« All Contacts
Mame + State &+ Email
My Contacts
* Steven Ew] CA steven@example.col &
My Favorites
g Lauren Bu = CA lauren@example.nel & -
Recently Created
o Johanne B ) _ NY johanne.b@example & w
Recently Viewed
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Reordering Subpanels

Users can easily move subpanels to a new location on the record view by dragging
and dropping the subpanel's header. The new subpanel order will remain for a
user upon subsequent visits to the module until the user's browser cache is
cleared.

Refreshing Subpanels

To refresh the results of a filtered or unfiltered subpanel view, simply click on the
Refresh button to the right of the search box. This will reset the current view of
expanded subpanels with the most current results that match your search and
filter criteria. Please note that subpanel results in a collapsed state are not
affected by the Refresh button.

Show mare... m
Related = [ Fitter 71l = &

Activity Stream

The record view's activity stream displays user posts and record posts specific to
the individual module record. To view the record's activity stream, simply click the
Activity Stream button below the record's fields. Users can view all posts in the
record view's activity stream even if they do not follow the record in Sugar. Please
note that you must follow the record if you wish to view the record view posts via
the Home page or List View activity stream. For more information on how to add
posts to the activity stream, please refer to the Activity Streams documentation.
You can add comments to posts by clicking the Comment button to the far right of
each post, entering in your comment, then clicking "Reply". You can also preview
the record referenced in the record post by clicking the Preview button. The
activity stream can also be filtered to only display certain messages (e.g. Messages
for Create, Messages for Update) by clicking "Filter" above the post input box then
selecting the desired message type.

o mers:  Activy ream |

Module Allcﬁvitym = B9
Type a note or drag and drop an attachment. Type @ to mention a user. | |
Type # to reference a record.
Linked Regan Harker to ABC Incorporated. ’I|®
Max Jensen an hour ago
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Note: If you cannot access activity streams, the feature may have been disabled
via Admin > System Settings. For more information, refer to the System
documentation in the Administration guide.

Dashboards

To the right of record views, the intelligence pane displays dashboards when not
displaying a related record preview. Dashboards are sets of dashlets configured for
the specific record view to display useful Sugar data. An out-of-the-box default
dashboard will likely be initially displayed on your record view intelligence pane.
Sugar admins are able to create and push custom default dashboards to your
views. You may also create personal dashboards using the dashlets and
configurations that best suit your business needs. All dashboards can also be
shared with teams of users who can the pull the dashboards to their views as
desired. Ensure the intelligence pane is expanded using the Arrow icon at the top
right of the record view. For more information, please refer to the Dashboards and
Dashlets documentation.

ABC Incorporated > m Accounts Record Dashboard[*] & - |
Website Industry .
Opportunity Metrics -~

http:/fwww.abcinc.com Communications

Member of Type

Customer

Assigned to Office Phone
Mary Thompson (510) 788-8788

Tags

Billing Address Shipping Address

123 Forest Ave
San Francisco, CA 94018
USA

Alternate Phone Email Address n E

support@abc.com $0 $1,744,410

Won Lost Active

Intelligence Pane
Intelligence panes display on list views, record views, and to the right of the Home

page activity stream. They provide users with valuable record information via
dashboards as well as allowing Sugar records to be previewed.

Dashboards

Most intelligence panes have out-of-the-box default dashboards with a set of
commonly used dashlets. Admin users may also have created default dashboards
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which are pushed to teams of users. In addition, individual users can create their
own personal dashboards with whichever dashlets they wish to use. Any dashboard
can also be shared to additional teams who can then pull the dashboard into their
intelligence panes for use.

Please refer to the Dashboards and Dashlets documentation for in-depth
documentation about using dashboards as well as information about commonly
used dashlets.

Previews

Users can preview a record's details by clicking the Preview icon to the far right of
a record's row or activity stream post. The preview appears in the intelligence
pane to the right of the Home page's activity stream and on list views and record
views. The preview displays the topmost fields from the module's record view and
the record's most recent activity stream entries. Please note that administrators
can configure the fields that appear on the record view layout via Admin > Studio
> Layouts > Record View. For more information on activity streams, please refer
to the Activity Streams documentation.

Viewing Previews

There are various options available for viewing previews in Sugar including via the
list view, record view, and activity stream. Previewing allows users to easily view
key information regarding a record directly from the intelligence pane without
navigating away from the current page. Users can mark a record to follow or
unfollow via the preview by clicking the Follow or Unfollow button within the
record's details. Clicking the hyperlinks (e.g. account name, website, email
address) within the preview allow you to access the record view, external company
website, compose email, etc.

Previewing From List Views

Users can view a record's topmost fields directly from the module's list view by
clicking the Preview icon to the far right of each account's row. The intelligence
pane will display the record's details with key information regarding the record as
well as any related activity stream information.
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Accounts (20 of 21+)

Mame + City *
W ABC Incorporated 5an Francisco
| W XY&Z Funding Inc Kansas City
| ¢  Smith & Sons Los Angeles
% John 5mith and Company San Francisco
~| +¢ | ABC Company San Francisco
¥ KM Corp (HA) Kansas City
SR Jungle Systems Inc 5an Jose
| ¥ AtoZ CoLtd San Francisco
1 ¥y | AirSafetyinc St. Petersburg
IR+ ]l Resources Inc Cupertino
| f | 24/7 Couriers San Mateo
1 ¥r | Powder Suppliers Alabama

Previewing From Record View

Billing Country 4

UsA

UsA

UsA

UsA

UsA

UsA

UsA

UsA

UsA

UsA

UsA

UsA

Phone

(415) 226-B888

(550) 176-40995

(415) 812-7892

(415) 226-B888

(375) 275-B268

(374) 315-6162

(415) 728-8000

(077)541-3937

(825) 133-2353

(382) 239-7069

(220) 464-3066

~
¥

re
-

Preview

E o o Name

>

@ & & & @

@

ABC Incorporated

i Website
http:/fwww.abcinc.com

(510) 788-8788 E -

Industry
A Communications

- Member of
Type
Customer

Assigned to
Mary Thompson

e Office Phone
(510) 788-8788

Tags
Show more...

Linked Regan Harker to ABC
v e Incorporated.

Max Jensen an hour ago

Users can also view a record's details from the module's record view by clicking

the Preview icon to the far right of each record row in the subpanel. The

intelligence pane will display the record's details with key information regarding
the record as well as any related activity stream information.
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o ABC Incorporated # > m Preview < > x

Website Industry Narne
Johanne Bramwell

http://www.abcinc.com Communications
Member of Type Title .

Operations Manager

Customer
obile

Assigned o Office Phone (346) 352-5008
Mary Thompson (510) 788-8788

Department
Tags Operations

Do Not Call
Show more...

Account Name

ABC Incorporated
Related » () Filter c B o .

Email Address
johanne.b@example.net
the20@example.biz

0 CALLS (5 of 6+)

@ CONTACTS (5 of 6+)

Tags
CHEEDED
< Jeanette McCormick 5t Petersburg CA Show more...
°r Johanne Bramwell Mew York NY @
<7 Lauren Burkes Los Angeles CA @® - Linked johanne Bramuwell
to ABC Incorporated.
o Lindsay Smith San Francisco CA @® - Menc Jensen an hour aga

Previewing From Activity Streams

In addition, you can also preview the record referenced in activity stream posts
from the Home page, list view, and record view activity stream by clicking the
Preview button to the right of each post. Please note that preview is only available
for Create, Update, Relate, and Un-relate-type posts in the activity stream. For
more information about previewing activity stream posts, please refer to the
Previewing Posts section of the Activity Streams documentation.

Note: If you cannot access activity streams, the feature may have been disabled
via Admin > System Settings. For more information, refer to the System
documentation in the Administration guide.

The intelligence pane displays the topmost fields from the module's record view
and the record's most recent activity stream entries.

105/1.061


http://http//support.sugarcrm.com/Documentation/Sugar_Versions/8.1/Ent/Application_Guide/User_Interface/Activity_Streams#Previewing_Posts
http://http//support.sugarcrm.com/Documentation/Sugar_Versions/8.1/Ent/Administration_Guide/System#Activity_Streams

Accounts (20 of 21+)

Preview

B Name
ABC Incorporated

Type a note or drag and drop an attachment. Type @& to mention a user. m ebsite
Type # to reference a record.

00060600006

Updated Office Phone on ABC Incorporated.

Max Jensen a few seconds ago

Linked Cornelius Cartier to 24/7 Couriers.

Max Jensen a minute ago

Updated Office Phone on Air Safety Inc.

Max Jensen 2 minutes ago

Linked Karly Shealey to |] Resources Inc.
Max Jensen 2 minutes ago

Created DBA Inc. Account.

Max Jensen 6 minutes ago

Linked Muriel Ormond to XY&Z Funding Inc.

Max Jensen 7 minutes ago

Updated Office Phone on ABC Incorporated.

Max Jensen 7 minutes ago

Updated Assigned User on Smith & Sons.
Mary Thompson on 01/04/2018 12:20pm

Previewing From Global Search

http://mww.abcinc.com

Industry

> H Communications
Member of
. =
Type
Customer
. @
Assigned to
Mary Thompson
. =
Office Phane
(510) 78B8-8788
» @ Tags
» @ Show more...
e Updated Office Phane on
e ABC Incorporated.
Max Jensen
. =

a few seconds ago

Users can view a record's details directly from the View All Results page for Global
Search by clicking the Preview icon to the far right of each record's row. The
intelligence pane displays the topmost fields from the module's record view and

the record's most recent activity stream entries. For more information on

previewing via the View All Results page, please refer to the Search
documentation.
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Search Results for: "smith" (14)

Tony Smith
Primary Email: t.smith@example.com

Sarah Smith
Frimary Email: sarah.smith@example.com

Jane Smith
Primary Email: jane@example.com

Lindsay Smith
Primary Email: lindsay@example.com

Smith & Sons
Email Address: ga.sugar@example.co.uk , Office Phone: (550) 176-4...

John Smith and Company
Office Phone: (415) 812-7892

Send signed contract to John Smith
Status: In Progress, Due Date: 01/05/2018 10:00am

@ John Smithson

John Moaore
Alternate Address Street: 123 Smith St, Primary Address Street 123 ...

Show More

Preview
Name
@ Jane Smith
itle
a Sales Manager
Mabile
(415) 878-8888
Department
Sales
@ Do Not Call
& Acccfunt Mame
Smith & Sons
Email Address
& jane@example.com
Tags
@
Show more...
@&
Linked Jane Smith to Smith
o & Sons.
@& Mary Thompson

on 01/04/2018 11:59am

In the preview, Sugar displays the topmost fields from the module's record view.
To view all of the fields that are on the record view, click "Show more...". Please
note that administrators can configure what fields appear on the business card
panel via Admin > Studio > Layouts > Record View. For more information on
editing layouts, please refer to the Studio documentation.
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Preview < > =

Name
Jane Smith

itle
Sales Manager

Mobile
(415) B78-8B888

Department
Sales

Do Mot Call

Account Mame
Smith & Sons

Email Address
jane@example.com

ags

Show more...

Previewing a Record's Activity Stream

When previewing a record via the intelligence pane, you can also view any related
activity stream posts which will appear below the record's detail. Please note that
you cannot create new posts or comment on posts via the activity stream when
previewing a record. For more information on creating posts and commenting on
posts, please refer to the Activity Streams documentation.
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Preview > %

Name
ABC Incorporated

Website
http://www.abcinc.com

Industry
Communications

Member of
Type
Customer

Assigned to
Mary Thompson

Office Phone
(510) 78B-8788

ags

Show more...

l-'i Please provide update

-

s onrenewal meeting with JELTLELTES
on ABC Incorporated.
Mary Thompson a few seconds ago

Updated Office Phone on ABC
o Incorporated.

Max Jensen 12 minutes ago

Note: If you cannot access activity streams, the feature may have been disabled
via Admin > System Settings. For more information, refer to the System
documentation in the Administration guide.

Previewing Next and Previous Records

Above a previewed record in the intelligence pane, there is a Left and Right arrow
button that allows you to scroll through the next and previous records. Clicking the
Left arrow button displays the previous record's preview while clicking the Right
arrow button displays the next record's preview. When previewing from the
module's list view, you can scroll through the list view's current search results.
When previewing a related module record from a module's record view, you can
scroll through the list of related records in the specific subpanel.
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Preview x

Name
ABC Incorporated

Website
http://www.abcinc.com

Closing a Preview

If you no longer wish to preview the records, you can simply close the preview by
clicking the "X" on the upper right of the intelligence pane. Please note that the
dashboard view will display again on the intelligence pane once you close the
preview.

Preview > Izl

Name
ABC Incorporated

Website
http://www.abcinc.com

Editing Records

Records may be edited at any time to modify or add information. Edits can be
made via record view or list view as detailed below. For instructions on how to edit
the various field types, please refer to the Editing Fields section below.

Please note that your ability to edit records in Sugar may be restricted by a role.
For more information, please refer to the Role Management documentation. Check
with your system administrator if you do not see the edit options.

Editing Inline via Record View

Users can edit individual fields in a record view without entering the full edit mode
by clicking the field name. Fields which are available for inline editing will display
a pencil icon when hovering on the field name or value. After entering your desired
values, click "Save" to preserve your changes to one or several fields.
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|
, o ABC Incorporated m

|
#Website ndustr
y

| http:/fwww.abcinc.com Communications

Editing via Record View

You can edit many fields at once via the record view by clicking the Edit button on
the upper right of the page. Once the record view layout is editable, update the
necessary fields, then click "Save" to preserve your changes.

o ABC Incorporated # m

Website ndustry

http://www.abcinc.com Communications

Editing Inline via Subpanels

Beneath the record's fields are subpanels containing related records from various
modules. You can edit individual fields (e.g. Email, Office Phone) for records
directly within the subpanel without entering the full edit mode. Simply click the
Actions menu to the far right of the record's row and select "Edit".

(D coNTACTS (5 of 6+) P
Mame ¥ City ¥ State & Email ]
* Lindsay Smith San Francisco CA lindsay@example.com @ |-
r |eanette McCormick St Petersburg CA jomecory Edit
w* |ohanne Bramwell New York NY johanne Unlink

The fields on the record's row will become editable and allow users to type or
select a new value. You can click the double arrow icon on the upper right of the
page to expand the subpanel list view's width to make editing easier. Click "Save"
to preserve your changes.

Editing Inline via List View

You can also edit individual fields on a module's list view without entering the full
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edit mode. Click the Record Actions menu to the far right of the record's row and
select "Edit".

Name 4+ City 4 Biling Country 4 Phone &
W  Nelson Inc Alabama UsSA (980)5 @
v¥ | T-Cat Media Group Inc Los Angeles USA Edit
Y7  NW Bridge Construction Los Angeles USA Unfollow
¥r  Q.R.&E.Corp Sunnyvale USA Delete

The fields on the record's row will become editable and allow users to type or
select a new value. You can click the double arrow icon on the upper right of the
page to expand the list view's width to make editing easier. Click "Save" to
preserve your changes. After saving, please refresh the page to have any list view
filters be applied to the new record's values.

Note: Text area fields are not inline editable from list views.

Editing via List View Preview

Users have the option to edit fields directly in a record's preview when previewing
from the module's list view. An administrator must first enable the feature via
Admin > System Settings as described in the System documentation.

Navigate to a module's list view and click the eye icon to the far right of a record's
row in order to open the preview. Hover over the Preview header and then click
the pencil icon.

Accounts (20 of 21+) Preview Cancel m
Filter = m o E o @ Mame

| 360 Vacations ‘

Mame + City %  Billing Country 4 .3
Website

Yy 360 Vacations Salt Lake City ~ USA - http:/fwww.360vacay.com
¥r  Waverly Trading House  Los Angeles USA & - Industry

Hospitality X -
17 | Kaos Trading Ltd Ohio USA & -

Member of

7 Insight Marketing Inc Persistance USA @& - -
%5  Southern Realty Salt Lake City UsA @& v Type
t¥  AirSafetyInc St. Petershurg  USA & v Customer jalld
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The fields on the record's preview will become editable and allow you to type or
select a new value. Click "Save" to preserve your changes.

Mass Editing via List View

Mass Updating allows you to apply the same changes to multiple records at once.
Administrator users or users with developer-type role access can control which
fields are available during mass update via Admin > Studio. Fields with the data
type of date, datetime, dropdown, multiselect, radio, relate, flex relate, or tags can
be made available for mass updating. For more information on configuring the
mass update fields, please refer to the Studio documentation. After using list view
search to locate the desired records, you can choose individual records or use the
Select All option to modify all of the current results. Using the Select All option will
allow you to update up to 1000 records at a time. If you wish to update more than
1000 records or update a specific group of records from the list view, use filters to
perform the updates in smaller batches.

Please note that your ability to mass update may be restricted by a role. For more
information on roles, please refer to the Role Management documentation. Check
with your system administrator if you do not see the Mass Update option.

The following steps cover mass updating account records as an example:

1. Navigate to the Accounts list view by clicking the Accounts module tab.
2. Use the list view's list view search to identify accounts you wish to modify.
3. Select the desired accounts then choose "Mass Update" from the Actions

menu.
B Mame ¥ City # | Billing Country %
Emai Salt Lake City  USA
Mass Update House  Los Angeles USA

Recalculate Values

Chio UsA

Add To Target List
= g Inc Persistance UsA

Merge )

Salt Lake City USA
Delete

St Petersburg  USA
Export

—- S— Kansas City Usa

i‘.? Anytime Air Support Inc Kansas City 54

+r  ABC Company San Francisco  USA

4. The Mass Update panel will appear below the search bar. Set values for the
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field(s) you wish to alter. The following options may be available in the
Mass Update panel:

o Add Row/Remove Row : To mass update several fields at once,
click the plus icon to the right of the row.

o Append {Field}(s) : When mass updating a field that may contain
multiple values (e.g. Tags, Teams), Sugar will display a checkbox
labeled "Append {field}(s)", where {field} is the name of the field
you have selected. This option is enabled by default to prevent loss
of data by adding the new values to any existing data in the updated
field. Disable the checkbox if you prefer to overwrite any existing
data in the updated field.

Mass Update Cancel

Tags - Bhopena oges
o These additional options appear when mass updating the Teams
field:

= Set as Primary Team : Use the star icons to specify which
team, if any, should be set as the primary team on the
updated records. A primary designation is required when
the Append Team(s) option is disabled.

= Add Team/Remove Team : Specify multiple teams by using
the plus and minus icons adjacent to the Team selection

field.

Mass Update
* ppend Team(s)

+[[="+]

5. Click "Update" to save the changes to all of the selected account records.

Set as Primary Team

Teams - Global -

Note: If your administrator has enabled team-based permissions, you may also see
a Lock button or a "Selected" box on the Teams field. Please refer to the Using
Team-Based Permissions section for more information.

Editing Fields

Sugar records include a variety of field types which enable you to capture all of the
different kinds of data which are important to your organization. While many fields
are available for use on each module out-of-the-box, administrators and users with
developer-level role access have the ability to add fields of these various types to
modules via Admin > Studio as described in the Studio documentation. Studio may
also be used to configure fields by, for example, making fields required, allowing
them to be mass updated, making their values calculated, and specifying when
they should be visible.
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Descriptions and instructions for editing different field types are available below:

e Text : Text fields allow users to enter a word or brief phrase by clicking
into the field and typing. Text fields will accept any combination of
characters (i.e. letters, numbers, spaces, and symbols) but have a
100-character limit by default. Administrators can edit the maximum
character length restriction via Admin > Studio.

Department

Sales

e Text Area : Text area fields allow users to enter large amounts of text by
clicking on the field and typing. Administrators can modify the default
display size of a text area field via Admin > Studio, but this will not limit
the number of characters that can be entered by a user. Most browsers
supported by Sugar will allow the user to resize an active text area field
temporarily by dragging the bottom corner of the field to the desired width
and height.

Description

Collaboratively administrate empowered markets via plug-and-play networks. Dynamically
procrastinate B2C users after installed base benefits. Dramatically visualize customer
directed convergence without revolutionary ROI.

Efficiently unleash cross-media information without cross-media value. Quickly maximize
timely deliverables for real-time schemas. Dramatically maintain clicks-and-mortar
solutions without functional solutions. \

2

e Integer : Integer fields allow users to enter whole number values (e.g. 850)
by clicking on the field and typing. Administrators can specify a minimum
and maximum value for the field via Admin > Studio.

Number of Employees
1,800

e Dropdown : Dropdown fields provide a list of values where only one value
can be selected at a time. The list will be collapsed to only display the
selected value except during editing, making it appropriate for longer lists
of values. Click the selected value to see the full list. Clicking the desired
value will replace it as the selected value.
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Industry

Apparel

Banking
Biotechnology
Chemicals
Communications

Construction

Consulting

e Multiselect : Multiselect fields provide a list of values where one or more
values can be selected at a time. The list will be collapsed to only display
selected values except during editing, making it appropriate for longer lists
of values. Click the blank space to the right of selected values to see
additional options. Click the x on a selected value to de-select it.

Contact Preference

[orfcephone oY mai o |

Mobile Phone

Alternate Phone

e Radio : Radio fields provide a list of values where only one value can be
selected at a time. The entire list of all values will be displayed at all times,
making it appropriate for shorter lists of values. Click the circle of the
desired value, and any previously selected value will be deselected
automatically.

Number of Employees
1-100
101-200

© 201-300

e Checkbox : Checkbox fields provide a boolean type typically used to
answer a yes or no question. Click the box to toggle whether it is checked
or not.

Do Not Call
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e Date : Date fields allow users to specify a particular date by either typing a
date in the provided format or clicking the Calendar icon and selecting it
via the date picker. Click the month and year (e.g. "January 2018") to select
the desired month or use the arrows to navigate to the desired month. To
set the year, click the month and year at the top of the picker, then click
the year at the top of the picker, and then select the desired year. Once the
month and year are set, click the desired date below to set the date and
close the picker.

Cancellation Date

| |
E January 2018 D

Su Mo Tu We Th Fr Sa

31 1 2 3 4 5 6

7 8 9011 12 13

14 15 16 17 18 19 20

21 22 23 24 25 260 27
28 29 30 31 1 2 3 P

4 5 6 7 8 9 10

e Datetime : Datetime fields allow users to specify both a particular date
and a time. The date portion is set just like a date field as described above.
The time portion can be set by typing a time in the provided format or
clicking the Clock icon and selecting it via the dropdown.

Start Date

01/10/2018 £ | 03:30pn{0] '

Location

Description

¢ Relate : Relate fields allow users to select a record from a single module.
Both relate fields (which are visible via Admin > Studio > {Module Name}
> Fields) and one-sided relationships (i.e. one-to-many and one-to-one) are
represented by the same relate field user interface. Type the first few
characters of the desired record and either select from the type-ahead
results or click "Search and Select..." at the bottom for a more robust
search.

Account Name

I Search and Select... I

* Flex Relate : Flex relate fields require users to select first the module and
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then a record from that module to relate to the current record. The module
selector works like a dropdown field while the record selector works like a
relate field, both of which are described above. You can click the "x" to the
right of the selected record's name (e.g. ABC Company) to clear out the
value. Please note that a module may only have one flex relate field.

Related To

Account ~ | | ABC Company Ev

Q Q

ACco Search and Select... |

Contact
Opportunity
Task

Product Catalog

Quote

Quoted Line It...

Email Address : Email address fields contain one or more email addresses
for a single record; email addresses are entered by clicking in the field and
typing or pasting the address. The following options are available when
editing an Email Address field:
o Add/Remove : Add additional email address fields by clicking the
plus button. Click the minus button to remove the adjacent address.

Email Address

johanne.b@example.com n@ o |-

o Primary : A white star with a black background represents the
primary email address on a record. This will be the default address
that Sugar will find when the record is included in email campaigns
and other send-message events performed within the application.
On a given record, only one email address can be the primary one.
If a record contains only one email address, it will be set to primary
by default.

Email Address m
Hoo -

johanne.b@example.com

o Opted Out : The button with a slashed circle indicates whether or
not an email address has been opted out from email marketing
campaigns. Sugar automatically opts-out an email address when a
recipient clicks the opt-out link in an email-type campaign message.
When enabled, the button will have a black background.
Administrators can configure whether new email addresses added
to Sugar records default to opted-in or opted-out by using the "Opt-
out new email addresses by default" option via Admin > System
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Email Settings.

Email Address Opted Out

johanne.b@example.com * a o -

When an opted-out email address is saved, the opt-out status is
indicated by a blue circle with a line through it. Opted-out email
addresses also display a Link button in record view. Clicking this
button will copy a link to your computer's clipboard which you can
send to the email address owner in order to request that they
confirm their desire to receive marketing emails from your
organization. When the copied link is visited in a web browser,
Sugar will automatically set the email address to opted-in.

Email Address

johnnydoe@gmail.com

@ john.doe@example.com %

Please note that opted out email addresses are only blacklisted from
campaigns, so users can continue to send them transactional emails
via the Emails module. For more information about email opted-out

email addresses, refer to the Emails documentation.

o Invalid : Invalid or undeliverable email addresses are represented
by a black button with a white exclamation point. Sugar
automatically marks email addresses as invalid if they are returned
via the recipient's mail server during the distribution of an email
campaign. Users can also manually toggle the invalid designation
on and off by clicking the Invalid button next to the email address.
Sugar will not permit users to send messages to invalid email
addresses from anywhere within the application.

Email Address m
« o -

johanne.b@example.com

e Tags : The Tags field allows users to enter keywords or phrases in order to
connect Sugar records by common attributes that may not be defined via
basic database fields. Once a new tag has been created, it can be re-used
by any user in any module that contains a Tags field. To use the Tags field,
click inside the field and type a word or phrase. Sugar will recommend
existing tags as you type, but you can choose to ignore the
recommendations and create an entirely new tag. For more information
about tagging records in Sugar, please refer to the Tags documentation.
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Tags

2075

2018 (New Tag)

2018 Eastern Conference

Ped

018 European Conference

(=)

018 Latin America Conference

2018 North America Conference

e Teams : The Teams field specifies which teams of users have access to
view the record. An individual team selection works like a dropdown field
which is described above. Click the Plus button to add additional teams to
the record or the Minus button to remove a team. Click the Star button to
set the primary team. For more information on teams, please refer to the
Team Management documentation.

Teams

| East v] -

West - || +

Note: If your administrator has enabled team-based permissions, you may also see
a Lock button or a "Selected" box on the Teams field. Please refer to the Using
Team-Based Permissions section of this page for more information.

Using Team-Based Permissions

In Sugar, teams are typically used to control which groups of users can access a
record. Using team-based permissions, however, an administrator may choose to
extend the purpose of teams to control who can perform certain operations on the
record (e.g. edit, delete). When enabled, regular users can use a record's Teams
field to grant access such as viewing, editing, exporting, importing, and deleting
permission to specific users or user groups.

An administrator must first enable team-based permissions and configure roles and
users for this feature. For more information, please refer to the Role Management
documentation. Once the roles are applied to users, any user who can edit the
Teams field in the enabled module can grant extra access to teams of users.

If you are not an administrator and you are not sure if team-based permissions are
enabled for a module, simply navigate to a record view, click "Edit", and look for a
lock button next to the Teams field:

Teams

[ Global - B s
- %

a|l- +
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If you do not see a lock button, reach out to your system's administrator to discuss
whether team-based permissions are appropriate for your organization's business
needs.

Note: Legacy interface modules also support team-based permissions but use a
checkbox labeled "Selected" next to the Teams field to indicate whether or not the
team's members have extra access to the record.

Team-based permissions have no effect on users who have not been assigned to
roles that are configured with "Owner & Selected Teams" access. For more
information, please refer to the Record Operation Definitions section of this page.
For information on using team-based permissions on a record, please refer to the
Role Management documentation.

To grant extra access to a record for all members of a team who have role
permission, click the lock button next to the team's name. This will enable
additional permissions according to the guidelines in the table below. To control an
individual user's access to a record, add that user's private team to the record's
Teams field and then enable or disable additional permissions according to the
guidelines in the table below. Please note that extra access will only be granted to
users who have a role restricting their access to "Owner & Selected Teams" as
described in the Role Management documentation.

Team Setting Appearance Button Description
Additional A black button with n Members of this
Permissions an open lock team have extra

Enabled access to this
record or fields
within the record
as controlled by
their roles

Additional A white button with | g Members of this
Permissions a closed lock team have no
Disabled additional team-

based permissions
as controlled by
their roles

In the following example, members of team East have standard team access to the
record (at a minimum, view permission), while Jim and members of team West
have view permission plus extra access to do things such as working with
restricted fields, and editing, deleting, and exporting the record. Note that a user
can be an explicit or implicit member of a selected team, and if they are part of
both a selected team and a non-selected team for a record, they will be granted the
extra access.
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Teams
West B -
- %

East

Jim Brennan - % -

Note: Changes made to the selected state of teams on an existing record are
audited in the record's audit log.

Locked Fields

Occasionally, you may see a lock icon (not to be confused with the Lock Button
used for team-based permissions) near one or more fields on a record in Sugar.
The lock icon indicates that the adjacent field is temporarily locked from editing
for all users. Locked fields occur as a result of Advanced Workflow settings that
have been configured by your system's administrator. When a record becomes
involved in a process that has locked fields, that record will respect those field
locks until the record is no longer participating in the process.

" v Accounts -  Contacts v i Q Q v <
Warning This record is participating in a
[Elsne: A - -
EISne: process and may contain some locked fields. U Save
ENebsite Endustry
http://sneekerdeepo.com Apparel
Member of mype

v  Competitor

Locked fields are enforced in Sugar for imports, mass updates, and record
merging. Please note that records containing one or more locked fields cannot be
edited via list view regardless of whether the locked fields appear in the list view's
columns. To edit the record's unlocked fields, you must navigate to the record
view, which you can do by clicking on the record's link in the alert box or as you
typically would in Sugar.
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‘- v Accounts »  Contacts_w __ Opportunities v _ leads ~ Q a . +

Accounts (20 of 21+) A Warning Sneaker Depot is participating in a

process and may contain some locked fields.
To edit the record, click here Sneaker Depot.

Filter ~ m [+ ®
Name ¢ City % BilingCountry & Phone & User s | £
¥ | Sneaker Depot Olympia USA Administrator @ E
Y¥  Introductory Holdings Pittsburgh USA (412) 123-9876 Edit
¥ | Kings Royalty Trust Toronto Canada (123) 456-1234 Unfollow
Y% | Insight Marketing Inc Persistance USA (950) 567-6591 Delete

Deleting Records

If a record is invalid or should no longer appear in your organization's instance, it
may be deleted from either the record view or list view. Deleting via the record
view allows you to delete the current record while the list view allows for deleting
one or more records at a time. Deleting a record will not delete its related records
and will only remove the relationship, so you may wish to also delete any related
records to avoid orphaned records.

Please note that your ability to delete accounts in Sugar may be restricted by a
role. For more information on roles, please refer to the Role Management
documentation. Check with your system administrator if you do not see the Delete
options.

Deleting via Record View
The following steps cover deleting an account via record view as an example:

1. Navigate to an account's record view.
2. Select "Delete" from the Actions menu.
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o ABC Company 7 > m

Website Industry SR
http:/fwww.abcco.com Communi gunioad PDE
Member of Type Ernail PDF
Customer
Find Duplicates
Assigned to Office Phar
Will Westin (415) 788 “OPY
Tags Historical Summary
View Audit Log
Billing Address Shipping AC view Personal Info
123 First 5t
San Francisco, CA 54015 Delete

[ L.

3. A pop-up message will display asking for confirmation. Click "Confirm" to
proceed.

Deleting via List View

The following steps cover deleting an account via list view as an example:
1. Navigate to the Accounts list view by clicking the Accounts module tab.
2. Use the List View Search to find the Account record you wish to delete.

3. Click the Record Actions Menu to the far right of the record's row and
select "Delete".

Mame + City %+  Billing Country £
ABC Incorporated San Francisco U5A & |-
Cloud Cower Trust St. Petersburg Edit

Air Safety Inc 5t. Petershurg Unfollow

DBA Inc. San Francisco Delete

4. A pop-up message will display asking for confirmation. Click "Confirm" to
proceed.

Mass Deleting via List View

The following steps cover deleting one or more account records via the list view as
an example:
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1. Navigate to the Accounts list view by clicking the Accounts module tab.
2. Use the List View Search to find the Account records you wish to delete.
3. Select the desired account records then choose "Delete" from the Actions

menu.
E Mame ¥ City ¥ Billing Country
Ernai d San Francisco (ILYN
Mass Update 5t St. Petershurg USA

Adcl To Target List St Petersburg LISA

Merge San Francisco LISA
Delete
C Kansas City USA
Export
. Los Angeles LISA
[ ] R John Smith and Co...  5an Francisco LISA
@ | ¥y ABCCompany San Francisco USA

4. A pop-up message will display asking for confirmation. Click "Confirm" to
proceed.

You can also use the Select All feature in the list view, which will allow you to
easily select the first 1000 records in the result set. If you wish to delete more than
1000 records or delete a specific group of records on the list view, please use the
filter option in list view search to perform the deletions in smaller batches.

Emailing Records

Sugar allows users to compose and send outbound emails to records which include
an Email Address field such as accounts, contacts, leads, and targets as well as any
custom person- or company-type modules which include an email address field.
The sections below cover the various ways to send emails to records. Accounts,
contacts, leads, and targets may also be emailed via campaigns, and more
information about emailing these records via campaigns is located on their
individual documentation pages.

Note: Before users can send email from Sugar, please complete the required
configurations described in the Emails documentation. The logged-in user must
have at least one outgoing email account successfully configured in the Emails
module.

Once an email is successfully sent by a method other than workflows or
campaigns, the email record will appear in the History dashlet and Emails
subpanel on the record's record view. For more information on sending emails
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from your own account, please refer to the Emails documentation.
MEETINGS (1) + -
History + &

+
@) emais (2) u i
0

Last 30 Days

Subject % Status % Date Created *
: 0 2
Meetings Emails Calls
g Meeting Confirmation Archived 01/11/2018 11:50am
) o _ ™ Meeting Confirmation
g Discuss pricing Archived 12/21/2017 07:39am @ e = ) .
£/ Mary Thompson, 11 minutes ago

Emailing via List View

For modules that include an Email field, the Email option in the list view's mass
actions menu enables users to send an email message to one or more records at a
time from the module's list view. Simply select the desired record(s) from the list
view then choose "Email" from the list view Actions menu. The Compose Email
window will open allowing you to enter in all relevant information (e.g. subject,
body). Please note that the email will be sent to the selected record's primary
email address on file.

The following steps cover composing and sending an email from the Accounts list
view as an example:

1. Navigate to the Accounts list view by clicking the Accounts module tab.

2. Find and select the accounts in the list view that you would like to send an
email to.

3. Choose "Email" from the Mass Actions menu.
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B Name & City %  Billing Country %
Email Salt Lake City  USA
Mass Update House  Los Angeles USA
Recalculate Values Chio USA
Add To Target List

& E Inc Persistance USA

Merge
Salt Lake City UsA

Delete
St Petersburg  USA

Export

c Kansas City UsA

-_— - ———————

Y& Anytime Air Suppeort Inc  Kansas City USA

i ABC Company San Francisco  USA

4. In the Compose Email window, enter the subject and body of the email
message, edit the recipient fields (optional), then click "Send".

After sending the message, the email record will appear in the Emails subpanel
and History dashlet of each related record.

MEETINGS (4) + -
History + &
+ -
Sl Last7 Days « E o
@) EmAILS (5 of 6+) + 0 2 2
Meetings Emails Calls
From +  Subject +  Status & | Date
™ Welcome Email
o Mary Thompsen  Welcome Email ~ Archived  01/11/2018 01:38pm @ £/ Mary Thompson, & minutes ago

Emailing via Quick Create

Quick Create provides an easy way to send an email from Sugar to the recipient
associated with the record you are viewing. Quick Create for email messages can
be accessed from the Quick Create menu on the navigation bar, from any Emails
subpanel, or by clicking on a linked email address in Sugar list views or record
views.

* Quick creating via Quick Create menu : Use "Compose Email"” in the
Quick Create menu to relate a message to the record you are currently
viewing and automatically populate the message's "To" field with the
record's name and primary email address. If you use the Compose Email
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quick-create option from any other page, simply insert the desired
recipient(s) manually as explained in the Working With Recipient Fields
section of the Emails documentation.

Q 2 |+

A

Create Account
Create Contact
Create Opportunity
Create Lead

Create Document

+ |+ + + + +

Compose Email

e Quick creating via email address : The Quick Create view will also open
if you click on a hyperlinked email address inside the Sugar application.
For example, email addresses displayed in list views, dashlets, intelligence
panes, and record views can be clicked to expose the Quick Create email
compose view pre-filled with the clicked email address.

o Quick create from an email address in list view:

Leads (20 of 21+)

Filter = m = E Q
Mame ¥ Account Name ¥  Email ¥ £
17  Eric Stolz DBA Incorporated [ ericstolz@example.com ] @&@ -

o Quick create from an email address on the record view:

O ccso - . 9

Title Muobile

Sales Manager (415) 7BB-BBE8

Website Do Mot Ca

Account Name Email Address

DBA Incorporated ericstoltz@example.com

¢ Quick creating via Emails subpanel : Click the Create (+) icon on the
Emails subpanel to compose an email to the record's primary email address
and automatically relate the message to the record you are viewing.
Note: Legacy modules contain an Activities subpanel instead of an Emails
subpanel.
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DOCUMENTS (1) + -

@ emais (2) [+]
From % Subject & Status & Date m

7 Administrator White Cross Co % Draft 2018-01-0211:. @& w

hig Administrator White CrossCo &  Draft 2018-01-0211 @&

To edit or override a default email recipient on Quick Create, click on the name
above the Subject field and the area will transform into the standard
From/To/Cc/Bcc form.

Compose Email Cancel  Save Draft ==l

— Click on the recipient’s name
Sherrl Prel | e [to make the To field editable.]

o B I U § = i

'
1]
il
Ml
b~}
4
|»
4

Font Sizes ~  Paragraph v Font Family ~

&
<
J

For more information on editing recipients, please refer to the Working With
Recipient Fields section of the Emails documentation.

Emailing via the Emails Module

Users can compose and send messages directly from the Emails module by clicking
the Compose Email button on the Emails list view or by selecting "Compose Email"
on the Emails module tab menu. This opens up the compose layout, which allows
you to enter all of the relevant information for the email.

Use the following steps to compose an email via the Emails module:

1. Click "Compose Email" on the Emails module list view or the Emails
module tab menu:

1 - Accounts w EmailsE H Q o r-:' - +
Emails (20 of 21+4) 4+ Compose Email

4+ Create Archived Email

Filter = m o E (0]

View Emails
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2. Enter appropriate values for the fields in the layout. All required fields are
marked as such and must be completed prior to saving.

3. Once the necessary information is entered, click "Send" to deliver the
message to the recipients specified in the To, CC, and BCC fields.
Alternatively, click "Save Draft" to navigate away from a message without
sending it. Email records in a draft state are only visible to the email's
assigned user and the administrator.

For more detailed information about sending emails, please refer to the Emails
documentation.

Emailing via Workflows

Sugar's Workflows module is available to administrators and users with developer-
type role access. With each workflow, a set of conditions triggers a combination of
actions and email alerts, including the ability to send emails to Sugar records that
include an email address. Workflows can send simple emails or can utilize alert
email templates built to include relevant data pulled from the record as well as
your organization's design and branding. For more information, please refer to the
Workflow documentation.

Emailing via Advanced Workflow

Sugar's Advanced Workflow is available to administrators and users with
developer-type role access. Process definitions created in Advanced Workflow may
contain Send Message events that include the ability to send emails to Sugar
records that have an email address. Send Message events utilize templates created
in the Process Email Templates module. Templates may include relevant data
pulled from the record as well as your organization's design and branding. For
more information, please refer to the Process Email Templates documentation.

Note: Advanced Workflow is exclusive to Enterprise and Ultimate editions of
Sugar.

Exporting Records

Exporting downloads all fields for the selected records to your computer as a .CSV
(comma-separated values) file. This may be useful when needing to use Sugar data
with other software such as Microsoft Excel or to update existing records by
exporting, making changes, then importing the altered records back into Sugar.
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For more information on updating existing records via import, please refer to the
Import documentation. Due to PHP memory limitations on the server, there may be
occasions when the application times out while exporting a large number of
records. If you encounter an error when performing this action, we recommend
selecting the records in smaller batches.

Records may be exported from the module's list view by first locating and selecting
the checkboxes of the desired record. Then, select "Export" from the Mass Actions
menu. You can also export Rows and Columns-type reports if you wish to employ
more complex filter criteria and have greater control over which fields will be
included. For more information on exporting records, please refer to the Export
documentation.

B Mame ¥ City

Emai d San Francisco USA

Billing Country

4

Mass Update st St Petersburg UsA

Add To Target List St. Petersburg USA

Merge

San Francisco UsA

Delete
c Kansas City UsA

Export
= Los Angeles UsA
@| ¥  JohnSmithand Co...  San Francisco UsA
@ | ¥¢ ABCCompany San Francisco UsA

Please note that your ability to export accounts from Sugar may be restricted by a
role. For more information, please refer to the Role Management documentation.
Check with your system administrator if you do not see the Export option.

Recalculating Calculated Values

Administrators or users or developer-level role access to a module may see an
additional option in the list view's Actions menu: "Recalculate Values". This option
appears only for modules that contain one or more calculated fields. For more
information on calculated fields, please refer to the Studio documentation.

This utility allows administrators to recalculate affected field values following the
addition or alteration of a calculated field in Studio. The mass actions menu option
allows you to recalculate field values for up to 1000 records at a time. To update
more than 1000 records, perform the recalculations in multiple batches as needed.
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Note: This action will not appear unless the user is an administrator or has
developer-level access to the module and there is at least one calculated value in
that module. Please note that your ability to recalculate values may be restricted
by a role. For more information on roles, please refer to the Role Management
documentation. Check with your system administrator if you do not see the
Recalculate Values option.

The following steps cover recalculating values for records from the Accounts list
view as an example:

1. Navigate to the Accounts list view by clicking the Accounts module tab.

2. Use the list view's List View Search to identify accounts you wish to update.

3. Select the desired accounts then choose "Recalculate Values" from the
Actions menu.

Accounts (20 of 21+)
Filter = m o E @
E Mame £ City % Billing Country &
Emai San Francisco USA &* -
Mass Update d San Frangisco USA &® -

Recalculate Values

5t 5t Petersburg USA @ -
Add To Target List
= St Petersburg UsA @& -
Merge i
c Kansas City UsA & -
Delete
Los Angeles UsA @* v
Export
— e miimis e =D 58N Francisco USA @ -
@ | ¥ ABCCompany 5an Francisco USA @ -
G ..M. Corp (HA) Kansas City UsaA an -

Finding Duplicate Records

Between multiple users working in Sugar, importing new records, and converting
leads, it is possible for duplicate records to be accidentally put into the system.
Before creating a new record, the best practice is to first check that the record
does not already exist in Sugar. You can identify duplicate records for cleanup
using list view search from the module's list view.

Searching for records with similar names or other information can turn search into
a powerful, duplicates-finding tool. A wizard is also available for finding potential
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duplicates and may be used as shown below. If duplicate records are detected, you
can perform a merge per the Merging Records section of this documentation.

Please note that your ability to use the Find Duplicates action may be restricted by
any role which prevents editing records. For more information on roles, please
refer to the Role Management documentation. Check with your system
administrator if you do not see the Find Duplicates option.

The following steps cover locating duplicate accounts using the Find Duplicates
option from the Accounts record view as an example:

1. Navigate to an account's record view.
2. Choose "Find Duplicates" from the Actions menu.

Cloud View Systems Inc. 17 m

Share

Website Industry

http:/fwww.cloudviewsys.com Technelog pownload POF

Member of Type Email PDF
Customer

Find Duplicates

3. Potential duplicate account records will be listed on the Find Duplicates
page. Select the duplicate record(s) you wish to merge then click "Merge
Duplicates".

o You can preview the duplicate record's details by clicking the
Preview button to the far right of the record's row.

o You can search for specific records from the Accounts list view if
you wish to check for more potential duplicates. For more
information on performing a search, please refer to the List View
Search section of this documentation.

o You can also click the Gear icon above the Preview button to change
the list of fields that display on the list view column headers.

Find Duplicates Cancel | Merge Duplicates | Preview x
Filter = m Name

Cloud View Systems Inc.
Mame City Billing Countr, @

ebsite
http://fwww.cloudviewsys.com
‘You have selected 1 records in the result set. Clear selections.

Industry
Cloud View Systems |... Technology

Once you click "Merge Duplicates", the merging process with the current record
will begin. For instructions on performing the merge that follows, please refer to
Steps 3-9 of the Merging via List View section of this documentation.
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Merging Records

When duplicate records are identified in Sugar, you have the option to merge two
or more into a single record. Once the merge is complete, the duplicate record(s)
will be deleted, and the primary record will remain. Please note that all
relationships belonging to the duplicate records will be merged to the primary
record meaning that any calls, meetings, cases, etc. related to the duplicate
record(s) will automatically be related to the resulting, merged record.

Note: Date Created, Date Modified, and Password field types are not supported
when merging duplicate records in Sugar.

Merging via List View
List View Search may be used to identify duplicate records by, for example,

searching for records with similar names. Once your search has identified
duplicates, you can merge them directly from the module's list view.

The following steps cover merging accounts via the list view as an example:

1. Use the list view's List View Search to identify duplicate accounts.
2. Possible duplicates will be displayed in the list view. Select the duplicate
record(s) that you wish to merge.
o Please note that up to five records may be merged at once in Sugar.
An error message ("Invalid number of records passed. The valid
range is from 2 to 5 records.") will appear if more than five records
are selected when attempting to perform a merge.

Accounts (3) @

Filter ~ m abc company x = E o
(/] B MName = City % Biling Country % Phone = ]
e selected 3 records in the result set. Clear selections.
Mass Update

San Francisco USA {415) BOD-BBEE &€ -
Recalculate Values

San Francisco USA (415) BOD-BBEE @ -

Add To Target List

3. Select "Merge" from the Actions menu to display the Merging Records
page. The primary record's field values are displayed on the left while other
record's values are in columns to the right. For convenience, fields with
differing values will appear on the top of the list. Saving the merged
records will preserve only the field values marked with the radio button
into a single record.

San Francisco USA (415) 226-BEEE @ -
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Merging 3 Records Cancel Preview x

Mame
ABC Company E* ABC Company
, Website
e @ http://www.abcco.com
Website
o http:/fwww.abi http:/fwww.abcc... http://www.abcc... ndustry
T Biotechnology
ype Custo... % = Customer © customer
- Member of
Office Phone o (415) BOD-8888 (415) B0O0-8888 (415) 226-8888
Billing Street
& 123 First 5t 123 First Street @ 123 First 5t Type
s Customer
Billing Postal Code O o1 95111 AT
Shipping Street Assigned to
PRing © 123Firstst 123 First Street 123 First 5t Mary Thompson
Shipping Ci )
pRIn City ©  san Francisco 5an Jose San Francisco Office Phone
o (415) 800-8888
Shipping Postal C.. Of o111 95111 94080
) Tags
Emall Address - ] support@abccob..
MName i -
© | ABC company ABC Company ABC Company Billing Address
123 First 5t

If 3 or more records are selected to be merged, an X icon will appear at the
top right of each record. Clicking the "X" will remove the record from the
merge process but will not delete the record.

4. To change which record is considered the primary, drag and drop the
Primary label on the top of a different column.

5. Review the field values in each column and click the radio button to the left
of the value that should appear on the final record. You can also manually
type or select a new value for any field as necessary.

o Note: Fields you do not have Edit access for cannot be edited on
the merging records page.

6. Preview what the final, merged record will contain as you work by clicking
the eye icon to display the preview in the Intelligence Pane.

7. Click "Save" once all fields you wish to appear on the single, merged record
have their radio buttons selected.

8. A pop-up message will display confirming that the duplicate record(s)
should be deleted. Click "Confirm" to proceed.

Viewing Record Historical Summaries

For modules that are related to activity records (e.g. calls, meetings, emails, notes,
and tasks), you can view quick details of the related activities via a record's
Historical Summary option. From the record view, simply select "Historical
Summary" in the Actions menu.
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ABC Incorporated < > m

Website Industry b

http://www.abcinc.com Communi' pounioad POE
Member of Type Email PDF
Customer
Find Duplicates
Assigned to Office Phon
Mary Thompson (510) 788- COPY

Historical Summary

Tags

The Historical Summary shows a digest of the following activity records that are
considered closed by virtue of their statuses:

Record Type Included Statuses
Calls Held, Canceled

Emails Sent, Received, Archived
Meetings Held, Canceled

Notes All notes

Tasks Completed, Deferred

Note: Calls and meetings with a Canceled status will display a status of "Not Held"
in the Historical Summary.

The Historical Summary page will display as a list view with each activity's type,
subject, status, description, etc. and allow you to click the activity's name to view
its full details. You can add additional fields by clicking the Column Selection icon
to the far right of the list view column headers. You can also preview the activity
record in the intelligence pane by clicking the Preview icon to the far right of each
record's row, providing key information as well as any activity stream information.
For more information on activity streams, please refer to the Activity Streams
documentation.

The Historical Summary list view provides the ability to reorder columns by
dragging and dropping the title of the column to the desired location. The new
column order will remain for a user upon subsequent visits to the module until the
user's browser cache is cleared. You can reset the column order to the default view
by clicking the Gear icon to the far right of the list view column headers and
selecting "Reset default view". Please note that this option only appears if the
current list view column order is different from the system's default column order.

Users can also easily adjust the size of columns in the Historical Summary list view
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per their viewing preference. Simply place your cursor on the column divider, and
when the Left-and-Right arrow appears, click and drag the column to the desired
size. The set column width will be preserved when you navigate away from the
page. Sugar will render the preferred column size across sessions until the user
removes or resets the relevant browser cookies. You can reset the column width to
the default size by clicking the Gear icon to the far right of the list view column
headers and selecting "Reset default widths". Please note that this option only
appears if at least one of the column widths in the Historical Summary list view is
different from the default column width.

o Historical Summary for ABC Incorporated m Preview x

Subject
Present finalized proposal t...

Type %+ Subject % Status Description

Discuss Review Process Held @& /

tatus

Present finalized proposal to John Held Meeting to di... E m
@

Start & End Date

@ Vieeting Confirmation Sent Hello John,lw 01/11/2018 09:00am - 10:00am (1...

Follow up meeting Mot Held  Meeting to di... @ Repeat Type

Viewing Record Audit Logs

Changes made to each record are tracked over time, and users are able to view the
history of changes via each record's audit log. To access the audit log, simply
navigate to the record view and select "View Audit Log" from the Actions menu.
Please note that the audit log only tracks changes to fields that are marked as
"Audit" via Admin > Studio. For more information on designating fields for audit,
refer to the Studio documentation. The list of fields currently marked for audit for
the module will appear at the bottom of each record's audit log page.

e Thomas Wellington ¥ > m

Title Mobile share
Marketing Manager (415) 226-7842 - oert
Website Do Not Ca

Manage Subscriptions

Download vCard

Account Name Email Address
BCA Corporation @ t.wellington@e ' nd Duplicates
Tags Copy

Historical Summary
Primary Address Alternate Address | view Audit Log
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Once the audit log opens, the header will display the name of the current record to
better identify which record's audit log the user is viewing. Please note that the
header will just display "Audit Log" and not include the record's name if the user
does not have access to the record's name or the record's name is blank. Below the
header, the user can perform a search to retrieve log entries for specific fields
(e.g. Office Phone), old values, or new values.

IAudit Log for Thomas Wellingtonl

Field * Oldvalue Mew Value Changed By ¥  5ource Change Date -
Office Phaone (415) 788-7800 (415) 788-7820 max Max Jensen 04/02/2018 11:43am

|
Maobile (415) 226-7842 max Max Jensen 04/02/2018 11:42am |
Title Marketing Manager max Max Jensen 04/02/2018 11:42am
Email Address twellington@exa... max Web to Lead 04/02/2018 11:39am
Team Id Global max Web to Lead 04/02/2018 11:39am
Assigned User max max ‘Web to Lead 04/02/2018 11:3%am
Consent Last Updated 04/02/2018 max Web to Lead 04/02/2018 11:3%am
Status New max Web to Lead 04/02/2018 11:39am
Office Fhone (415) 788-7800 max ‘Web to Lead 04/02/2018 11:3%am
Last Name Wellington max ‘Web to Lead 04/02/2018 11:3%am
First Name Thomas max Web to Lead 04/02/2018 11:39am

Fields audited in this module: Salutation, First Name, Last Name, Title, Facebook Account, Twitter Account, Google Plus ID, Do Not Call, Home Phane, Mabile,

Office Phone, Other Phone, Fax, Primary Address Street, Primary Address Street 2, Primary Address Street 3, Primary Address City, Primary Address State,

The audit log contains the following fields:

Field Description

Field The name of the audited field that has a
change in value
Note: Only fields marked as "Audit" in
Admin > Studio will be displayed in the
audit log.

Old Value The old field value prior to the data
change

New Value The new field value after the data
change

Changed By The Sugar user who made the data
change
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Source The source (e.g. Sugar user, Web to
Lead form) from which each field
change originated

Note: The field may be blank if the
source is unknown.

Change Date The date the field change occurred

The rows of the audit log represents each time that an audited field is set or
changed, starting with values specified during the record's creation. In addition,
when any email address changes are captured in the audit log, the email audit icon
appears to the right of the email address which provides users access to the email
address audit log. For more information, refer to the Viewing Email Address Audit
Logs section below.

In addition to the old and new values of each field change, the time and source of
the change are recorded. When a user is directly responsible for the change,
whether by editing in Sugar or via an authenticated service such as Sugar's Plug-in
for Microsoft Outlook, the user will be specifically named. However, many non-
user entities are also responsible for record changes. Potential source values are
as follows:

Advanced Workflow
BWC Ul

Rest API

SOAP or v4 1 and older REST API
CLI

Cron Job

Logic Hook

Sugar Workflow
User

Web to Lead
Installer

Viewing Email Address Audit Logs

Email address audit log entries are generated for an email address whenever the
"Opted Out" or "Invalid" flags are modified or when an opt-in link is generated.
These changes are captured in the email address audit log which can be accessed
by clicking the email audit icon to the right of the email address on the record
audit log.
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Audit Log for Thomas Wellington

Fiela ¥+ Didvalue Mew Value Changed By =
Email Address thomas.wellington.. admin
Ciffice Phone (415) 788-7800 (415) 7BB-7B20 max

The email address audit log contains the same fields (e.g. Fields, New Value,
Source) as the record audit log but will only display entries when there are
changes to the Opted Out and/or Invalid options for the email address. Please note
that the email address audit log will not display any data if an email address is not
marked as "Opted Out" or "Invalid" when it is initially added to the record.

Audit Log for thomas.wellington@example.com m

Field + Did Value New Value Changed By + Source Change Date

Opted Out admin Administrator 04/03/2018 09:45am

Viewing Personal Information

For organizations that prioritize data privacy, fields which contain personally
identifying information for an individual are of particular importance. Admins can
designate these fields as "Personal Information" via Admin > Studio. If your
organization's data privacy procedures include providing individuals with a record
of the data you have recorded about them, the View Personal Info option provides
a valuable tool for condensing all of a record's personal information in one screen.
For more information on using this option and servicing data privacy records of
types "Send Personal Information Being Process" or "Export Information", refer to
the Data Privacy Guide.

Record PDFs

If you require a record's information outside of Sugar, you can download or email
the information in PDF form. Administrators have the ability to build multiple PDF
templates via Admin > PDF Manager for each module to ensure that the relevant
record information is being included for your specific purpose. For more
information on creating and managing PDF templates, please refer to the PDF
Manager documentation. Please note that the Download PDF and Email PDF
options will only appear in the Actions menu if there is an existing PDF template
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available for the module.

Note: If a user's email address is empty in their profile or if they have set their
email client to "External Email Client", then the "Email PDF" option will be hidden
for that user.

Downloading Record PDFs

Download record information as a PDF file via the desired record's record view by
selecting "Download PDF" from the Actions menu. All PDF templates which your
administrator has created and made available for the module will appear beneath
the Download PDF option. Simply select one of the templates to generate the PDF
file to view or save onto your local machine.

o ABC Incorporated < > m

Website Industry Share

http://www.abcinc.com Comm| pownload POF

Memberof Type Account - Renewal Letter
Custon

Mew Account - Welcome

Al n ol

Emailing Record PDFs

Users also have the option to email record information as a PDF file using Sugar's
email client. From the originating record's record view, click the Actions menu and
select "Email PDF". All of the PDF templates that your administrator has created
and made available for the module will appear beneath the Email PDF option in the
Actions menu.

e ABC Incorporated # < > m

Share

Website Industry
http://www.abcinc.com CommM  pownload PDE
Member of Type Ernail PDF
Custor
Account - Renewal Letter
Assigned to Office P
Mary Thompson (510)7] MNew Account - Welcome

Select one of the templates to create a draft in the Emails module. Sugar will
deliver you to the record view for the email.
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@ ABC Incorporated m

From Date

Mary Thompson 01/10/2018 11:05am

To
support@abc.com

Here is the file you requested (You can change this text)

Attachments

Email Attachment : A... (408K)

Cc Bee

Assigned To Related To
Mary Thompson ABC Incorporated

Teams
Mary Thompson (Primary)

The draft will have the following information pre-populated:

e From : The logged-in user's outgoing default email account

e Date : The date the message is being sent

e To : The primary email address of the originating record (if available)

e Subject : The name of the originating record

e Body : "Here is the file you requested (You can change this text)"

e Attachment : The PDF file created from the originating record

o The file's name will appear as "Email Attachment :

{originating record name} {template name}.pdf"; for example,
"Email Attachment : Acme 25 units Customer invoice.pdf".

e Teams : The logged-in user's default team(s)

e Assigned To : The Sugar user assigned to the email record

e Related To : The originating record and its module

Click "Edit" on the draft email record to reveal the Send button or to update the

fields as necessary and then click "Send". For more information on sending emails
via the Emails module, please refer to the Emails documentation.

Favoriting Records

Each Sugar user has the option to designate their own favorite records which are
important or will be viewed often so that they can easily be accessed via list view
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search or from the module tab. Once records are marked as favorites, select "My
Favorites" from the Filter option next to the Search bar or select from your most
recent favorites directly from the module tab.

Favoriting via List View

The following steps cover marking records as favorites via the Accounts list view
as an example:

1. Navigate to the Accounts list view by clicking the Accounts module tab.

2. Use the List View Search to find the account records you wish to mark as
favorites.

3. Darken the star icon on the left of each desired account's row by clicking
on the star one time.

Accounts (20 of 21+)

Filter = m = E @
Mame % City % Billing Country % | Phone L] &
E Hammer Group Inc ~ Alabama LSA (470) 909-5308 -

mac Bank Salt Lake City UsSA (356) 539-8340 ® v

4. To remove the account as a favorite, click the star again to revert it to
white.

Favoriting via Record View

The following steps cover marking records as favorites via the Accounts record
view as an example:

1. Navigate to an account's record view.

2. Click the star icon to the right of the account's name in the upper left of the
record view to designate it as a favorite.

3. To remove the account as a favorite, click the star again to revert it to
white.

Cloud Cover Trust | % < > m
Website mcmstr}f

http://www.supportthe.tw Communications
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Favoriting via Subpanel

The following steps cover marking account records as favorites via the subpanel in
related modules as an example:

1. Navigate to a related module's record view.
2. Click the star icon to the left of the desired record's row in the Contacts

subpanel.
(D conTAcTs (5 of 6+) + -
Mame ¥ City ¥ | State & Email ]
E Lindsay Smith San Francisco CA lindsay@example.com - v

3. To remove the contact as a favorite, click the star again to revert it to
white.

Following Records

Users can also choose to follow individual records. This allows each user to
personalize their activity stream by specifying which records' posts should appear
on the activity streams displayed on their Home page and in module list views.
Please note that you will automatically follow records that you create as well as
records that are assigned to you. You will not, however, automatically follow
records you import. Should a user lose access to a record in Sugar, they will
automatically stop following that record. For more information about activity
streams, please refer to the Activity Streams documentation.

Following via List View

The following steps cover marking an account to follow via the Accounts list view
as an example:

1. Navigate to the Accounts list view by clicking the Accounts module tab.

2. Use the List View Search to find the Account records you wish to follow.

3. Click the Record Actions menu to the far right of the records row and
select "Follow".
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Filter = m = E @

MName = City = Biling Country & Phone &
7 360 Vacations Salt Lake City UsA (594) B53-5816 @& | -
17 Waverly Trading House  Los Angeles UsA Edit

Y7  Kaos Trading Ltd Chio Usa

4. To stop following the account, click the Record Actions menu and select
"Unfollow".

Following via Record View

The following steps cover marking an account to follow via the account's record
view as an example:

1. Navigate to an account's record view.
2. Click on the Follow button to the right of the account's name to change its

label to "Following".

360 Vacations tr

Website
http://www . 360vacay.com

3. To unfollow the account, click on the Following button to revert its label to
"Follow".

360 Vacations ¥ Following

Website
http://www.360vacay.com

Sharing Records

Individual records can be shared with other users in your organization by sending
an email including the record's direct link. In the desired record's record view,
select "Share" from the Actions menu. A Compose Email window will open, and the
email's text will include the URL of the record. Enter the recipient(s) email address
in the To field then click "Send".
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360 Vacations ¥ > m

Share

Website Industry

http://www.360vacay.com Hospitalit pownload POF

The recipient can simply click the link in the email to access the account record in
Sugar. Please note that the user must be logged into Sugar in order to access the
record. Users will only be able to view the shared record as allowed by their team
membership, user access type, and assigned roles. For more information on teams
and roles, please refer to the Team Management and Role Management
documentation.

Using the TinyMCE Text Editor

TinyMCE is a third-party WYSIWYG editing tool used by Sugar so that users can
create content such as knowledge base articles and email messages with rich-text
formatting elements.

TinyMCE's rich-text editor framework presents the following familiar formatting
options:

Element Button(s) Function

Source Code . Bypass the rich-text editor
options and insert your
own HTML code or view
the HTML code of an
existing template to make
advanced changes.

Bold, Italic, Underline, B 7/ U S Use these basic font

Strikethrough formatting options to
easily add common styles
to text in the message
body.

Bullet List, Numbered List | := .= Transform paragraphs in

T the message body into a

formatted list.

Align Left, Align Center, = = = o= Set paragraph alignment.

Align Right, Justify

Text Color, Background Choose a custom font

Color color or highlight text with

a background font color.
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AC B[ ©
ENEEEEEN
ENEEEEEN
O ENEn
O O
x
Clear Formatting T. Clear any formatting.
Insert/Edit Image, E P Insert or edit an image or
Insert/Edit Link a link.
Font Sizes Font Sizes  [=] Choose a font size for the
text.
8pt
10pt
12pt
14pt
18pt
Paragraph Paragraph  ~ Choose a format for
headers.
Paragraph
Heading 1
Heading 2
Heading 3
Heading 4

Last Modified: 2018-11-29 22:23:53

User Interface (Legacy Modules)

Overview

The user interface in Sugar is essentially everything you see and can interact with
in Sugar. Knowing what buttons allow you to do what actions and how to quickly
add and edit information is critical to managing your customer information. This
documentation is divided into related sections in order to cover in detail, interface
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options to perform specific tasks.

Legacy Modules

This documentation will cover the Legacy user interface which is carried over from
Sugar 6. Below is a list of modules which use the Legacy user interface. Other
modules use the updated Sidecar user interface which is described in detail in the
User Interface documentation.

e Calendar
e Campaigns
e Documents

Note: Custom modules that are created in Module Builder will utilize the Sidecar
user interface. Custom modules installed to an instance prior to Sugar 7 that were
not created in Module Builder will use the Legacy user interface upon upgrade to
7.X.

List View

Each module in Sugar contains a list view to search and display records in a table
format. To access a module's list view, simply click the module tab (e.g.
Documents) in the navigation bar at the top of Sugar.

1 - Accounts w Contacts - Documents w i Q a - +

Search Documents

Document Name My Favorites Search  Clear Advanced Search
Document Name File Name Source Category Sub Category Revision Date Expiration Date
Sales Team: Internal Sugar 2017-12-21
Internal Process Process.docx 9 00:13

The list view displays all records meeting the current search criteria and to which
your user has access. By default, Sugar sorts records in descending order of their
creation date. You can view the basic details of each record within the field
columns or select the record name to view it in the detail view.

Please note that you will only be able to see records as allowed by your team
membership, user access type, and assigned roles. For more information on teams
and roles, please refer to the Team Management and Role Management
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documentation.

You have the option to change what fields are displayed in each module's list view
by configuring your layout options in the Advanced Search. For more information
on configuring your list view, please refer to the Layout Options section of the
Search documentation. Users with administrator or developer access also have the
ability to change what fields are visible in the list view via Admin > Studio. For
more information on editing layouts, please refer to the Studio documentation.

Basic Search

The basic search is at the top of the list view for each module and offers a few,
commonly used fields for a simplified search experience.

Search Campaigns

Name My ltems My Favorites Search  Clear | Advanced Search

From the Basic Search panel, you can also click "Advanced Search" to access
additional search functionality as needed.

The following buttons and checkboxes are common across many Legacy modules'
Basic Search panel and have the following functions:

e Search : Click the Search button or press your Return/Enter key to
perform the search.

e Clear : Click the Clear button to clear all criteria from the searchable
fields.

e My Items : Select this box to return only records assigned to you.

e My Favorites : Select this box to return only records you have marked as
favorites.

When you run a search, Sugar will return records matching all (as opposed to any)
of the fields and checkboxes for which you have given a value. For example, if you
select "My Items" and enter a name or subject, Sugar will only return records with
a matching name or subject that are assigned to you. Once the search is complete,
the relevant results will populate in the list view below the search panel. To see all
records to which you have access within the module, simply click “"Clear" and then
"Search" to perform a blank search with no filters. Please note that you will only be
able to see records as allowed by your team membership, user access type, and
assigned roles. For more information on teams and roles, please refer to the Team
Management and Role Management documentation.

Administrators can configure the fields that appear on the Basic Search for each
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module via Admin > Studio. For more information on editing layouts, please refer
to the Studio documentation.

Advanced Search

Advanced Search offers a more in-depth search experience than Basic Search
including additional fields, layout options, and saved search capability. From the

Advanced Search panel, you can also click "Basic Search" for simplified searching.
Search Campaigns

Name Start Date Equals - End Date Equals

(vyyy-mm-dd) (yyyy-mm-dd)

Status Type Assigned to Administrator

Planning Telesales Chris Olliver

Active Mail Max Jensen

Inactive Email Max Jensen

Complete Print Sally Bronsen

In Queue Web Sarah Smith
My Favorites E
¥ Layout Options Save search as: — Modify current search: | 4ate  Delete

BasicSearch | Saved Searches -none-

The following buttons, checkboxes, and dropdowns are common across many
Legacy modules' Advanced Search and have the following functions:

e Search : Click the Search button or press your Return/Enter key to
perform the search.

e Clear : Click the Clear button to clear all criteria from the searchable
fields.

e My Favorites : Enable this checkbox to return only records you have
marked as favorites.

e Layout Options : Use the expandable Layout Options section to configure
your list view. For more information, please refer to the Layout Options
section of the Search documentation.

e Saved Searches : Save, recall, update, and delete searches which you use
often. For more information, please refer to the Saved Search section of the
Search documentation.

When you run a search, Sugar will return records matching all (as opposed to any)
of the fields for which you have given a value. For example, if you select "My
Favorites" and enter in a field to search, Sugar will only return records matching
that field that you have marked as favorites. When searching by a multi-select or
dropdown field (i.e. "Assigned to"), however, Sugar will return records matching
any of these selections. Once the search completes, the relevant results will
populate in the list view below the search panel. To see all records to which you

150/1.061


http://http//support.sugarcrm.com/Documentation/Sugar_Versions/8.1/Ent/Administration_Guide/Developer_Tools/Studio#Layouts
http://http//support.sugarcrm.com/Documentation/Sugar_Versions/8.1/Ent/Application_Guide/Search#Layout_Options
http://http//support.sugarcrm.com/Documentation/Sugar_Versions/8.1/Ent/Application_Guide/Search#Saved_Search

have access within the module, simply click "Clear" and then "Search" to perform a
blank search with no filters. Please note that you will only be able to see records as
allowed by your team membership, user access type, and assigned roles. For more
information on teams and roles, please refer to the Team Management and Role
Management documentation.

Administrators can configure the fields that appear on the Advanced Search for
each module via Admin > Studio. For more information on editing layouts, please
refer to the Studio documentation.

Selecting Records

The list view in Sugar allows you to select a single record to view by clicking on
the name or subject of the record to open it in the detail view. You can also select
multiple records at once and perform certain actions on those records.

To select or deselect records in the Legacy modules list view, use the following
methods:

e Individual Selection : Mark the checkbox on the left of each record's row
on the list view you wish to select.

Document Name My Favorites Search  Clear /
* || Delete |
Document Name File Mame Source Category
Sale Toam-Intonalptenel | Sugr
g?cl‘is;—sgenewal E?cljziss docx B
ABC Contract US Terms Sugar

Agreement.docx

¢ Checkbox Selection : To select or deselect multiple records from the list
view, use the options in this checkbox dropdown menu.

o Select This Page : Selects all records shown on the current page
of list view results. You can also click the open checkbox to the left
of the Checkbox Selection menu to select all records on the current
page.

o Select All : Selects all records in the current search results across
all pages of list view results.

= Note: When using "Select All" you can not deselect single
records, but will have to use the Deselect All option.

o Deselect All : Deselects all records that are currently selected.
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Document Name My Favorites Search

A Delete | =

Select This Page (3) ent Name File Name Source
Select All (3) ‘eam- Internal nterna Sugar
Deselect All ] Process.docx g
SaesT Renewal Sales
G - Process Process.docx S

When selecting records, you can page through all of the records and Sugar will
remember which records are selected. Depending on your Sugar settings you may
see the count of records being selected or you may see a plus sign (+) to refer to
more records. Simply select the Deselect All option to remove all selected records
regardless of how they were initially selected.

Mass Actions Menu

The Actions menu to the right of the checkbox dropdown allows you to perform
various actions on the currently selected records. It allows you to perform actions
such as Delete, Mass Update, and Export for one or more records. Please note that
not all Legacy modules have these actions available. The sections below will cover
the most common actions across the modules. For more information on actions
available within a specific module, please refer to the list view section in the
application guide pertaining to the specific module.

=L

Mass Update [nt Name File Name Source
Export
a tract US Terms Sugar

Agreement. docx

Delete

The list view in Sugar allows you to easily mass delete records. Please note that
deleted records are not permanently removed from the database, but are marked
as deleted in the system so that it no longer appears in Sugar. These records can
be recovered by anyone with direct database access. Also, deleting records in
Sugar will not delete the related records and will only remove the relationship, so
you may wish to also delete any related records to avoid orphaned records.

The following steps cover deleting document records via the Documents list view
as an example:
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1. Navigate to the Documents list view by clicking on the Documents module
tab.

2. Use the Basic or Advanced Search to find the document records you wish to
delete.

3. Select the desired document record(s) individually or use the checkbox

dropdown's options.
4. Choose "Delete" from the Actions menu.

g Delate |-

Document Name File Name Source
Sales Team- Internal nterna

/] ‘ Sugar
Process Process.docx

[ Sales- Renewal Sales Sugar
Process Process.docx

5. A pop-up message will display asking for confirmation. Click "Ok" to
proceed.

Due to PHP memory limitations on the server, there may be occasions when the
application times out while deleting a large number of records. If you encounter an
error when performing this action, we recommend selecting the records in smaller
batches.

Mass Update

Mass Updating allows users to make the same change to multiple records at one
time from the list view. Users with administrator or developer level access can
control which fields are available during mass updates via Admin > Studio.
Currently, only fields with the data type of date, datetime, dropdown, multiselect,
and radio may be altered during a mass update. For more information on
configuring the mass update options, please refer to the Studio documentation.
Due to the PHP memory limitations on the server, there may be occasions when
the application times out while mass updating a large number of records. If you
encounter an error when performing this action, we recommend selecting the
records in smaller batches.

Please note that your ability to mass update may be restricted by a role. For more
information on roles, please refer to the Role Management documentation. Check
with your system administrator if you do not see the Mass Update option.

Use the following steps to mass update records from the list view:

1. Navigate to the list view by clicking the module tab in the navigation bar.

2. Use the list view's Basic or Advanced Search to identify records you wish to
modify.

3. Select the desired records individually or using the checkbox dropdown's
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options.

4. Choose "Mass Update" from the Actions menu.

Document Name My Favorites
¥ || Delete E
Mass Update fnt Name File Name Source
2Z:=§J:Ia;:;cess ;rt:égi;a_docx LT

5. Scroll to the Mass Update panel and set values for the fields you wish to

alter.

Note: For the Teams field, use "Replace" to remove existing team
assignments before adding those specified here. Use "Add" to add the

teams specified
Mass Update

Publish Date:

Category:
Status:

Document Type

Teams

Gancel

here to any existing team assignments.

Expiration Date: ) (yyyy-mm-o)

1 (vyyy-mm-da)
-none- . Sub Category: -none-

-none- - Is a Template -none- 4

-none- 4 Assigned to:

Primary

© Replace ) Add

6. Click "Update" to save the changes to all of the currently selected records.

Favorite Designation

Each Sugar user has the option to designate their own favorite records within
modules which are important or will be viewed often so that they can easily be
accessed via search or from the module tab. Once records are marked as favorites,
use the My Favorites checkbox in the Basic or Advanced Search to retrieve your
favorites or select from your most recent favorites directly from the module tab.

Use the following steps to mark records as favorites via the list view:

1. Navigate to the

list view by clicking the module tab in the navigation bar.

2. Use the Basic or Advanced Search to find the records you wish to mark as

favorites.

3. Mark the star icon on the left of each desired record's row.
4. To remove the record as a favorite, click the star again to revert it to white.
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Document Name My Favorites

Document Name File Name

ABC Contract US Terms
Agresment.docx

Sales Team: Renewal Internal

Process Process.docx

Edit Option

Records may be edited at any time to update or add information to the record. You
can make changes to existing records by clicking the Pencil icon to the left of each
record's name or subject in the list view. This will open up the records edit view
layout to update the necessary fields and you can click "Save" to preserve the
changes made.

Use the following steps to quick edit records via the list view:
1. Navigate to the list view by clicking the module tab in the navigation bar.

2. Use the Basic or Advanced Search to find the records you wish to edit.
3. Click the Pencil icon to the left of the record's name or subject in the list

view.
Document Name File Name Source
D ABC Contract UE Tarma Sugar
Agreement.docx
Sales Team: Renewal Internal Sugar
Process Process.docx

4. Update the necessary fields on the record's edit view layout, then click
"Save" to preserve the changes.
ABC Contract » Edit

Cancel Save and Continue (1of 3)

* Indicates required field

# Overview

Source: | Sugar ¥

File Name: * US Terms Agreement.docx Status: Active
Document Name: ABC Contract Revision: 1

Please note that your ability to edit records in Sugar may be restricted by a role.
For more information on roles, please refer to the Role Management
documentation. Check with your system administrator if you do not see the Edit
options.
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Administrators in Sugar may configure both the edit view and quick create via
Admin > Studio. For more information on configuring layouts, please refer to the
Studio documentation.

Column Sorting

List view provides the ability to sort all of the current search results by a field
column in either ascending or descending order. To sort by a field or switch the
sort direction, simply click the column header noting that the fields which allow
sorting will have a pair of arrows. You can click the column header again to
reverse the sort order. Please note that the list view may be sorted by only one
column at a time. You can also set a default order-by column using the layout
options in Advanced Search. For more information on setting a default column
sort, please refer to the Layout Options section of the Search documentation.

Document Name File Name Source Category Sub Category

US Terms

ABC Contract )
Agreement.docx

Sugar

Pagination

List view displays the current search results broken into pages that you can scroll
through rather than displaying potentially thousands of rows at once. To the right
just below the search panel, you can see which records of the total results set are
currently being displayed. The two single-arrow Next and Previous buttons can be
used to scroll through the records page-by-page. The two double-arrow First Page
and Last Page buttons allow you to skip to the beginning or the end of your current
results.

By default, Sugar displays 20 records per list view page, but administrators can
change the number of records displayed via Admin > System Settings. For more
information on changing the number of displayed records, please refer to the
System documentation.

Document Name My Favorites Search  Clear Advanced Search

- (1-3of 3)

More Information

Additional details for each record can be viewed by clicking the "i" icon to the far
right of each list view row. This provides users a quick view of additional
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information in addition to what appears in the display column fields. The resulting
pop-up window will show information such as Description, etc. by default. The list
of fields appearing here may only be configured through a code-level
customization.

Campaign Status Type End Date User Date Created +

December 2017 . : Max o 12212017 IZ'
Holiday Special Aclive S 01312018 Jensen L 04:33pm

Detail View

The module's detail view displays thorough information including all fields which
are grouped by default into the Overview and Other panels. You can also view a
record's related records (Activities, Documents, Contacts, etc.), which appear in
subpanels beneath the records fields.

Please note that you will only be able to view a record according to your team
membership, user type, and role restrictions. For more information on teams and
roles, please refer to the Team Management and Role Management
documentation. Users with administrator or developer access have the ability to
change the detail view by configuring the layout via Admin > Studio. For more
information on editing layouts, please refer to the Studio documentation.To access
a record's detail view, simply click on the name or subject link from anywhere in
the application including from the module's list view.
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December 2017 Holiday Special

Edit | = (16f 1) Launch Wizard View Status View ROI
# Overview
Name: December 2017 Holiday Special Status: Actlive
Start Date: 12/156/2017 Type: Email

End Date: 01/31/2018

Impressions: 0

Budget: (USD 5): 20,000.00 Expected Cost: (USD 5):
Actual Cost: (USD $): Expected Revenue: (USD $):
Objective:

Description: Holiday 2017 special for existing customers. 20% off all merchandise.

# Other
Assigned to:  Max Jensen Date Modified:  12/21/2017 04:40pm by Administrator
Teams: Global (Primary) Date Created: 12/21/2017 04:33pm by Administrator

Next or Previous Record

On the upper right of the detail view, there are two buttons that allow you to page
through each record in the module list view's current search results. Clicking the
Previous button displays the previous record of the current search results while
clicking the Next button displays the next record of the current search results. The
text in between shows which record result you are currently viewing within the
total number of current results.

Sales Team: Renewal Process

Edit | = (2 of 3)

# Overview

File MName: Internal Process.docx Status: Active

Actions Menu

The Actions menu on the top left of each detail view allows you to perform various
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actions (e.g. Edit, Share, Copy, Delete, etc.) on the current record. Please note that
the action items available in the Actions menu will vary between each Legacy
module.

Sales Team: Renewal Process

Edit I'I

Copy
Delete JEW

File Name: Internal Process.docx

Administrator users can also change the action items to be displayed as separate
buttons instead of a dropdown menu via Admin > System Settings. For more
information on configuring the actions menu, please refer to the System
documentation. The following sections will cover the most common action items
available across the Legacy modules. For more information on action items not
listed here, please refer to the Detail View > Actions Menu section of the specific
module's documentation.

Sales Team: Renewal Process

m Copy Delete

# Overview

File Mame: Internal Process.docx

Edit

You can edit records via the detail view by clicking the Edit button on the upper
left of the page. Once the edit view layout is open, update the necessary fields,
then click "Save" to preserve the changes made. For more information regarding
the edit view and how to edit records in Sugar, please refer to the Edit View
section of this documentation.

Sales Team: Renewal Process

Edit |~

# Overview

File Name: Internal Process.docx

Please note that your ability to edit records in Sugar may be restricted by a role.
For more information on roles, please refer to the Role Management
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documentation. Check with your system administrator if you do not see the Edit
options.

Administrators in Sugar may configure the module's edit view via Admin > Studio.
For more information on configuring layouts, please refer to the Studio
documentation.

Share

Individual records can be shared with other users in your organization by sending
an email with the record's link directly from the record view. In the module's detail
view, select "Share" from the Actions menu which will open a Compose Email
window including the URL of the record. Enter the recipient(s) email address in
the To field then click "Send".

December 2017 Holiday Special

o [7]

Copy

Delete : December 2017 Holiday Special

Users can simply click the link in the email to access the record in Sugar. Please
note that the user must be logged into Sugar in order to access the record. Users
will only be able to view the shared record as allowed by their team membership,
user access type, and assigned roles. For more information on teams and roles,
please refer to the Team Management and Role Management documentation.

Copy

You can create a new record by duplicating an existing record from the detail view.
The Copy option is useful if the record you are creating has similar information to
an existing record. Please note that any related record(s) to the original record will
not be copied to the newly created record.

Use the following steps to create a record by duplicating an existing record:

1. Navigate to a record's detail view.
2. Click the Actions menu and select "Copy".
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December 2017 Holiday Special

Edit E

Share

Delete 2. December 2017 Holiday Special

3. The displayed edit view is pre-populated with the original records values.
Update the necessary fields, then click "Save".

Cancel View Change Log

# Overview

Name: December 2017 Holiday Special

Start Date:
12/15/2017 | 1 (mmiddsnyy)

Delete

Users have the ability to delete records that are invalid or should no longer appear
in their organization's Sugar instance via the module's detail view. Deleting via the
detail view allows you to delete a single record in the module. Please note that
deleting records will not delete the related records and will only remove the
relationship, so you may wish to also delete any related records to avoid orphaned
records.

Please note that your ability to delete records in Sugar may be restricted by a role.
For more information on roles, please refer to the Role Management
documentation. Check with your system administrator if you do not see the Delete
options.

The following steps cover deleting a document record from the Documents detail
view as an example:

1. Navigate to a document's detail view.
2. Select "Delete" from the Actions menu.

Sales Team: Renewal Process

Edit B

Copy
Delete IF-'W

File Mame: Internal Process.docx

3. A pop-up message will display asking for confirmation. Click "Ok" to
proceed.
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View Audit Log

Changes made to each record are tracked over time, and for most modules, users
are able to view the history of changes via the audit log in each record's detail
view. To view the audit log, navigate to a record's detail view (e.g. campaigns) and
select "View Audit Log" from the Actions menu. Please note that only fields marked
as "Audit" in Admin > Studio will be displayed in the audit log. For more
information on designating a field for audit, please refer to the Studio
documentation.

April 2018 Specials

ek EI (1 of 1)

Copy

Delete ne: April 2018 Specials
Send Test

Send Emails

Mark As Sent _ .io. 04/30/2018

View Audit Log

ons: O

Field Panels

Field panels are what hold the fields for a record in the detail view. Most modules
come with two panels defined by default: Overview and Other. Please note that the
field panels can be collapsed to hide unnecessary data.

162 /1.061


http://http//support.sugarcrm.com/Documentation/Sugar_Versions/8.1/Ent/Administration_Guide/Developer_Tools/Studio#Fields

December 2017 Holiday Special

Edit | = Launch Wizard View Status View ROI
# Overview |
Name: December 2017 Holiday Special Status: Active
Start Date: 12/15/2017 Type: Email

End Date: 01/31/2018

Impressions: 0

Budget: (USD $): 20,000.00 Expected Cost: (USD 3):
Actual Cost: (USD $): Expected Revenue: (USD $):
Objective:

Description:  Holiday 2017 special for existing customers. 20% off all merchandise.

# Other |

Assigned to:  Max Jensen Date Modified:  12/21/2017 04:40pm by Administrator

Teams: Global (Primary) Date Created: 12/21/2017 04:33pm by Administrator

Users with administrator or developer access have the ability to change the fields
(e.g. Name, Assigned User, etc.) and labels inside the field panels as well as move,
create, and edit existing field panels via Admin > Studio to provide visibility to the
most important fields. Field panels can also be collapsed by default via Admin >
Studio. For more information on modifying field panels, please refer to the Studio
documentation.

Subpanels

Beneath the module record's fields are subpanels containing related records from
various modules (e.g. Accounts, Contacts). The subpanels that appear in a record's
detail view is based on the relationships defined for the current module as well as
the administrative settings on which subpanels are set to display in Sugar. You can
expand and collapse subpanels as well as rearrange them per your viewing
preference. For more information on changing the display of subpanels, please
refer to the Layout section of this documentation. You can create related records
as well as relate an existing record directly from the subpanel. Please note that the
actions available in the Actions menu can vary between certain subpanels.

Users with administrator or developer access have the ability to change the fields
(e.g. Status, Subject) and labels of each subpanel by configuring the layout via
Admin > Studio to provide visibility to the most important fields. For more
information on modifying subpanels, please refer to the Studio documentation.
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Activities and History

The Activities and History subpanels are special subpanels in Sugar that show data
from multiple modules based on certain criteria. For example, a meeting with a
status of "Planned" will appear in the Activities subpanel. Once the meeting is
changed to a status of "Held", it will move from the Activities subpanel to the
History subpanel. All related note and email records will appear in the History
subpanel as there are no filters on those modules, but notes and emails will never
display in the Activities subpanel. If you customize the status field for any of the
modules, the records that hold a custom status will appear in the Activities
subpanel. But code level customizations would be required to have a new status
show in the History subpanels.

Please refer to this chart for the criteria both subpanels use to query data:

Subpanel Module Status Field Filter
Activities Meetings Does not Equal "Held"
Does not Equal "Not Held"
Tasks Does not Equal
"Completed"
Does not Equal "Deferred"
Calls Does not Equal "Held"
Does not Equal "Not Held"
History Meetings Equals "Held"
Equals "Not Held"
Tasks Equals "Completed"
Equals "Deferred"
Calls Equals "Held"
Equals "Not Held"
Emails N/A
Notes N/A

Since the Activities and History subpanels contain records from many different
modules, there are some differences in the actions and record display than in
normal subpanels. Each record in both subpanels will have an icon to the far left
indicating which module the record originates from. For example, if the record is a
call, then the Telephone icon will display to the left of the subject.
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# Activities

Create Task |~

Subject Status Contact
Conference call with Lindsay Scheduled
Follow up on signed agreement Not Started
# History

Create Note or Attachment |~

Date

Subject Status Contact Modified <
) ) 122172017
Process Review Meeting Held 06:21pm

Normal subpanels typically have a Create and Select option to create or link
related records. The Activities and History subpanels have multiple actions due to
the fact that there are multiple modules involved.

You have the following actions available from the Activities subpanel:

e Create Task : Creates a new task record related to the record currently
being viewed.

e Schedule Meeting : Creates a new meeting record related to the record
currently being viewed.

e Log Call : Creates a new call record related to the record currently being

viewed.

e Compose Email : Launches the Compose Email popup window to send an
email.
Note: The email will automatically be related to the current record you are
viewing.

Note: When creating a Task, Meeting, or Call from the Activities subpanel, you
have the ability to set the Status field to "Held" or "Completed" which will place it
in the History subpanel.

# Activities

Create Task E

Schedule Meeting
Log Call
Compose Email

Status

ith Lindsay Scheduled

You have the following actions available from the History subpanel:
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e Create Note or Attachment : Creates a new note record related to the
record currently being viewed.

e Archive Email : Allows a received email to be entered manually on a
record for historical purposes only.
Note: This will not send an email to you or the email address on the record.

e View Summary : Opens a popup window with the Subject, Status, and
Detail of all associated records in the History subpanel. This is useful as it
allows you to view a history of all activities that have taken place for the
current record.

# History

Create Note or Attachment E

Archive Email
Status

View Summary

0B Process Review Meeting Held

Layout

Subpanels in Sugar can be personalized by each user to only display the most
relevant subpanels per their viewing preference.

e Collapse/Expand : Click the double arrow to the left of the subpanel's
name to either collapse or expand the subpanel.
¥ Document Revisions

wccounts
AContacts
Create |~
Mame Account Name
Johanne Bramwell Insight Marketing Inc

e Rearrange Subpanels : Drag and drop the subpanel's header bar to move
the subpanel to a new location on the detail view.
Note: Administrators can prevent users from moving subpanels to different
locations on the detail view. For more information on preventing
rearranging of subpanels, please refer to the System documentation. Check
with your system administrator if you are not able to rearrange your
subpanels.
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[ﬁ Contacts

Create (1-20f2)
Name Account Name Email Office Phone
Johanne Bramwell nsight Marketing Inc vegan64@example.net (327) 402-3565
Don Connors Super Star Holdings Inc kid.sales.sales@example.de (211) 592-3480
# Cases
Create ¥ (0-00of0)
B Subject Account Name Status Date Created Lo

Us

Actions

Related record subpanels (e.g. Contacts) also provide options to create or select
related records directly from the detail view.

e Create : Choose "Create" from the subpanel's Actions menu to relate a new
record. The newly created record will automatically be related to the
current record you are viewing.

# Contacts
| Create |~
Name Account Name
Johanne Bramwell Insight Marketing Inc

e Select : Choose "Select" from the subpanel's Actions menu to relate an
existing record. The Search popup window will display allowing you to
select records to relate to the current record you are viewing.

# Contacts
Create E
Account Name
Johanne Bramwell Insight Marketing Inc

Note: You may select multiple records in the search popup to be related to
the main record.
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Create Contact

Select

Contact List

- Mame Account Name
i Don Connors Super Star Holdings Inc
i Trudie Kelton First National S/B

e Edit : Choose "Edit" on the far right of the record's row to edit the related
record in the subpanel. Make the necessary changes to the record then
click "Save" to preserve the changes.

# Documents

Create |~ {1-10f1)
) Publish
Name File: Category Source Status Date
& Agreementdocx Agreement.docx Sugar Active 12M12/2013 '

e Unlink : Choose "Unlink" from the dropdown on the far right of the
record's row to remove the relationship between the related record and
current record.

o Note: This removes the relationship, but does not delete the record

itself.
# Contacts
Create | ¥ (1-20f2)
Name Account Name Email Office Phone
Johanne Bramwell Insight Marketing Inc veganB4@example.net (327) 402-3565 view D
Don Connors Super Star Holdings Inc kid.sales.sales@example.de (211) 582-3480

Users with administrator or developer access have the ability to change the fields
(e.g. Name, Assigned User, etc.) and labels of each subpanel by configuring the
layout via Admin > Studio to provide visibility to the most important fields. For
more information on modifying subpanels, please refer to the Studio
documentation.

Column Sorting

You can sort all of the related records in each subpanel by a field column in either
ascending or descending order. To sort by a field or switch the sort direction, click
the column header noting that the fields which allow sorting will have a pair of
arrows. Please note that each subpanel may be sorted by only one column at a
time.
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# Gases

Create |~
Num. Subject Account Name Status Date Created
249 System not responding ﬁ\:&z Funding Closed 12/21/2017 03:39pm
Pagination

The top right of the subpanel shows which records of the total results set are
currently being displayed. The two single-arrow Next and Previous buttons can be
used to scroll through the records page-by-page. The two double-arrow First Page
and Last Page buttons allow you to skip to the beginning or the end of the set.

By default, Sugar displays 5 records per subpanel results set, but administrators
can change the number of records displayed via Admin > System Settings. For
more information on changing the number of displayed records, please refer to the
System documentation.

# GContacts

Create | ¥ (1 -5 of 20)
Name Account Name Email Office Phone
L] L]
Edit View

The module's edit view allows records to be edited at any time to update or add
information as necessary. The Edit View layout is available for most Legacy
modules and can be accessed by clicking the Edit button on the upper left of the
detail view.

Sales Team: Renewal Process

Edit |~

A Overview

File Name: Internal Process.docx

Please note that your ability to edit records in Sugar may be restricted by a role.
For more information on roles, please refer to the Role Management
documentation. Check with your system administrator if you do not see the Edit
options.

Administrators in Sugar may configure the edit view via Admin > Studio. For more
information on configuring layouts, please refer to the Studio documentation.
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Pagination

On the upper right of the Edit View layout, there are two single-arrow Next and
Previous buttons which allow you to page through each record in the list view's
current search results. Clicking the Left arrow button displays the previous record
of the current search results while clicking the Right arrow button displays the
next record of the current search results allowing you to edit records as necessary.
The text in between the arrows, shows which record result you are currently
editing within the total number of current results. Once the necessary changes
have been made, you can click "Save and Continue" if you wish to save the details
in the current record and proceed with editing the next record.

Sales Team: Renewal Process » Edit

m Cancel Save and Continue {2 of 3)

* Indicates required fie

(=1

A Overview

Editing Records

Records may be edited at any time to update or add information to the record.
Once in the edit view, update the necessary fields available on the layout then click
"Save" to preserve the changes. You can click "Cancel" at any time to return to the
previous page without editing the record.

Sales Team: Renewal Process » Edit

|E:g HE i Cancel

A Overview
Source: ! Sugar ¥
File Name: * Sales Process.docx

Administrators in Sugar can configure the Edit View layout via Admin > Studio.
For more information on configuring layouts, please refer to the Studio
documentation.

Editing Related Fields

Sugar contains many different relationships between different modules and a
couple of different relate fields for users to create relationships with.
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Relate : Most one-to-many relationships in Sugar are represented by a
relate field. Relate fields on the edit view layout display an Arrow and "X"
button to the right of the field. You can either click the Arrow button to
select a related record from the record selection window or begin typing in

the open text box to pull up a list of records matching the keyword.
# Other

Assigned to:

Max Jensen

Flex Relate : Allows a dynamic module and a record from that module to
be related to the current record. Users can first select the module from the
dropdown list then choose or enter the record they wish to relate to the
current record they are viewing.

Email Addresses : Email address fields can be linked to many different
email addresses for a single record. Click the Plus button to add an email
address to a record.

Email Address: D Primary Reply-to

admin@example.com ©

Note: Only one email address can be selected as the Primary. Click the
minus sign to remove an email address from a record.
Teams : The Teams field specifies which team or teams of users have
visibility of each record.
o If there are multiple teams on a record, click "Show" to view all of
the teams.

Teams: *

Global °

o Click the Arrow icon to open the team selector window, or click the
Plus icon to add a new row to use the type-ahead feature.

o Click the Minus icon to remove a team from the record and select
only one team to be the primary team.

o For more information on teams, please refer to the Team
Management documentation.

Note: If your administrator has enabled team-based permissions, you may also see
a "Selected" box on the Teams field. Please refer to the Using Team-Based
Permissions section for more information.

Using the TinyMCE Text Editor

TinyMCE is a third-party WYSIWYG tool that allows users to provide HTML
formatting in specific sections in Sugar without requiring any HTML knowledge.
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TinyMCE is available when composing email or email templates from the Emails
module or creating workflow email templates.

HTan@lBIﬂﬁB@l%
s G331 I Ew Al |48 %
= | | |

|£- gv | Styles =  Paragraph ~ Font Family ~  Font Size -
= o | LB x x|
|=— Q2 |@Eo |8

-

The following are some descriptions of the more commonly used features in
TinyMCE:

e Text Formatting : Use the folllowing buttons to format text to be bold,
italics, underlined, or stricken through.
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H | |

e Alignment : Use the following buttons to change the alignment of the text
to be left, center, right, or justified.

HrmL (g |BIU,ABG ===
X 53 @ 0m Ge 7 |4 0 | iz iz |
M | | | |

e Fonts : Use the following dropdowns to select special section formatting,
fonts, and sizes.

|é- gv | Styles =1 Paragraph -  Font Family =  Font Size -
| SEE o | o |x x| H
|==— & A0 |8 T

e Layout Formatting : Use the following buttons to utilize bullet list,
ordered lists, and tables.

HTmL-@lBIEQ@l% |

X B2 @ @ .a;fa|aha¢_;1

| | | |

e Links and Images : Use the following buttons to create a link, remove a
current link, or add an image.

| é - g - | Styles = | Paragraph - | Font Family =  FontSize -
| =B | | L B | x. |02 iE
|=— 2 |@o |4
e Advanced HTML : Click the HTML button to view your content in full
HTML code. You may add and change the HTML to furthur refine your

content.
Not all HTML is allowed to be saved in Sugar. The following are some
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examples of HTML that will be removed when saved:

o Anything outside of the <body></body> tags.

o Any <style></style> tags.

o Any <script></script> tags.

o Any <form></form> tags.
Noters [Amye<GSutanthgsadded to some elements (e.g. <p>, <pre>, and
<span>), but due to different email clients rendering HTML email in
unexpected ways, inline CSS is not allowed on some elements (e.g. <div>,
<img>, and <table>).

w ) | B I U [ E =
& G @ On G a0k

A |
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Using Team-Based Permissions

In Sugar, teams are typically used to control which groups of users can access a
record. Using team-based permissions, however, an administrator may choose to
extend the purpose of teams to control who can perform certain operations on the
record (e.g. edit, delete, etc.). When enabled, regular users can use a record's
Teams field to grant access such as viewing, editing, exporting, importing, and
deleting permission to specific users or user groups.

An administrator must first enable team-based permissions and configure roles and
users for this feature. For more information, please refer to the Role Management
documentation. Once the roles are applied to users, any user who can edit the
Teams field in the enabled module can grant extra access to teams of users. If you
are not an administrator and you are not sure if team-based permissions are
enabled for a legacy module, simply navigate to a record view, click "Edit", and
look for a checkbox labeled "Selected" next to the Teams field:

Teams: *

Primary | Selected

Global o

West

Note: Sidecar modules also support team-based permissions but use a lock button
next to the Teams field to indicate whether or not the team's members have extra
access to the record.

To grant extra access to a record for all members of a team who have role
permission, check the Selected checkbox next to the team's name. This will enable
additional permissions according to the guidelines in the table below. To control an
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individual user's access to a record, add that user's private team to the record's
Teams field and then enable or disable additional permissions according to the
guidelines in the table below. Please note that extra access will only be granted to
users who have a role restricting their access to "Owner and Selected Teams" as
described in the Role Management documentation.

Team Setting Checkbox Description
Additional Permissions selected Members of this team
Enabled have extra access to this

record or fields within the
record as controlled by
their roles

Additional Permissions not selected Members of this team
Disabled have no additional team-
based permissions as
controlled by their roles

In the following example, members of team East have standard team access to the
record (at a minimum, view permission), while Jim and members of team West
have view permission plus extra access to do things such as working with
restricted fields, and editing, deleting, and exporting the record. Note that a user
can be an explicit or implicit member of a selected team, and if they are part of
both a selected team and a non-selected team for a record, they will be granted the
extra access.

Teams: Primary | Selected | A Hide
West o
East
Jim Brennan

Note: Changes made to the selected state of teams on an existing record are
audited in the record's audit log.

Last Modified: 2018-06-11 17:34:36

Activity Streams
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Overview

Sugar's activity stream allows users to view a list of activities performed on
records, create posts, preview posts, comment on posts, etc. Users can easily track
the most recent updates across their entire organization via the record and user
posts on the activity stream. The activity stream can be accessed via the home
page, module list view (e.g. Contacts list view), module's record view (e.g.
Contacts record view), as well as the intelligence pane.

Note: If you cannot access activity streams, the feature may have been disabled
via Admin > System Settings. For more information, refer to the System
documentation in the Administration guide.

The modules currently enabled to generate record posts for the activity stream are
Accounts, Bugs, Calls, Cases, Contacts, Leads, Meetings, Notes, Opportunity,
Quoted Line Items, Revenue Line Items, and Tasks. This documentation will go
over the basics of the activity stream as well as the various options available when
viewing posts, creating posts, commenting on posts, etc.

Viewing Activity Streams

There are various options available for viewing activity streams in Sugar including
via the home page, dashlet, list view, record view, and intelligence pane. Users will
be able to view record posts (e.g. create, update, link, unlink), user posts,
comments, and attachments via the activity stream. Keep in mind that if you are
not the assigned user or did not create the record, you must follow the record in
order to view all related posts via the Home page and List view activity stream.

Please note that you will only be able to view and access the activity stream for
audit-enabled modules (Accounts, Bugs, Calls, Cases, Contacts, Leads, Meetings,
Notes, Opportunity, Quoted Line Items, Revenue Line Items, and Tasks) in Sugar.
Un-audited modules (e.g. Target, Target List) will not display the list view activity
stream, record view activity stream, or provide the option to follow a record.

Note: Activity streams are not available for custom modules.

Viewing via Home Page

The Home page activity stream allows users to view all posts for records they are
following in Sugar as well as all user posts created on the Home page activity
stream. For more information on following records, please refer to the Following
Records section. You can access the Home page activity stream by clicking the
triangle next to the Sugar cube icon on the upper left of Sugar then selecting
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"Activity Stream". All posts created via the Home page activity stream will be
viewable by users in your organization. For more information on creating posts,
please refer to the Creating User Posts section. You can also comment on posts by

clicking the Comment button and preview posts by clicking the Preview button to
the right of each post.

TE Accounts W Cantacts « Opportunities - Leads w

Create Dashboard

+
@  Activity Stream

Manage Dashboards E

My Favorites Dashboard attachment. Type @ to mention a user. Type # to | |

§2 Home Dashboard

Viewing via Dashlet

The My Activity Stream dashlet displays the user's main Activity Stream within a
dashboard, eliminating the need to navigate to the Activity Streams view to
monitor the most recent stream activities. Like other Activity Stream views, the
dashlet supports inline commenting on specific stream activities, but it does not
allow record previews. The dashlet may be added to your home page or to the
intelligence page of any module's list view or record view. When added to an
Intelligence Pane, the My Activity Stream dashlet will display stream items in
context to the data within the main container of the page. For more information on
the My Activity Stream dashlet, please refer to the Dashboards and Dashlets
documentation.

My Activity Stream + A
Linked Follow-up on proposal to ABC P
Incorporated.

Mary Thompson an hour ago

(] EEIELR TG Please confirm the status of the finalized
B

proposal for [anea raeie by EOD 1/12/18.

Thanks-
Mary Thompson 2 minutes ago

Updated Office Phone on ABC "
Incorporated.
Mary Thompson 5 minutes ago

Linked Meeting Notes to ABC E
Incorporated.

More posts...
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Viewing via List View

The list view's activity stream displays all posts for records being followed in the
current module as well as all user posts created on the list view activity stream.
For more information on following records, please refer to the Following Records
section. To access the list view activity stream, click the specific module tab (e.g.
Contacts) at the top of the navigation bar then click the Activity Stream button to
the right of the list view's search bar. You can view both user and record posts
relevant to the module as well as create a post and comment on posts. For more
information on creating posts and commenting on posts, please refer to the
Creating User Posts and Commenting on Posts section. You can also preview the
post by clicking the Preview button to the right of each post.

1 - Accounts - Contacts = Opportunities -

Accounts m

TR All Activity Stream o ﬂﬂ

Type a note or drag and drop an attachment. Type @ to mention a user. ‘ ‘
Type # to reference a record.

Linked Ship Product Invoice to XY&Z Funding Inc. ®» @

Administrator 16 hours ago

(] (o, [Tl Please confirm once the invoice has been sent.
o . . .
Administrator 4 minutes ago

Updated Office Phone on XY&Z Funding Inc. » @

Administrator 12 minutes ago

Viewing via Record View

The record view's activity stream displays all posts specific to the current record
you are viewing. Users can view all posts in the record view's activity stream even
if they do not follow the record in Sugar. Please note that you must follow the
record if you wish to view the record view posts via the Home page or List View
activity stream. For more information on following records, please refer to the
Following Records section. To access the record view's activity stream, navigate to
a module's record view (e.g. Avery Software Co) then click the Activity Stream
button below the module's fields.

Please note that user posts created via the Home page or List View activity stream
that reference the specific record's name will also appear in the record view's
activity stream. For more information on referencing specific records, please refer
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to the Referencing Users and Records section.

° ABC Incorporated ¥ m

Website Industry
http://www.abcinc.com Communications
Member of Type
Customer
Assigned to Office Phone
Mary Thompson (415) B28-8788
Tags
Show mare...
wodue () ke o =

Type a note or drag and drop an attachment. Type @ to mention a C]
user, Type # to reference a record.

Linked Ship Product Invoice to ABC Incorporated to o g
ABC Incorporated.

Mary Thompson a minute ago

~ (o, [ (50 Plegse confirm once the invoice has been sent to John.
" Thanks!
Mary Thompson on 01/05/2018 12:14pm

Updated Office Phone on ABC Incorporated. P

Mary Thompson 2 minutes ago

Viewing via Intelligence Pane

The intelligence pane in Sugar allows users to view a record's detail along with the
related activity stream information directly from the Home page activity stream,
module's list view, as well as the record view. To preview a record's details, simply
click the Preview button to the right of a record post on the Home page or List
View activity stream. You can also preview a record via the module's list view or
related record subpanel by clicking the Preview button to the far right of each
record's row. Any associated user and record posts will appear below the record's
detail in the intelligence pane. Please note that unlike viewing via the Home page,
List View, or Record View activity stream, you cannot create posts or comment on

posts via the intelligence pane.
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o ABC Incorporated 1¥ m Preview > x

Website Industry e Subject
http://www.abcinc.com Communications Ship Product Invoice
Member of Type Start Date
Customer
Priority
Assigned to Office Phaone High
Mary Thompson (415) 828-B788
Due Date
Tags 01/12/2018 12:13pm
Status
Not Started
Show more...
Assigned to
- Chris Olliver
Related = m Filter o o
Related to
@ TASKS (3 of 4+) + ABC Incorporated
. Tags
Subject + Status % Contact -+
< Ship Product Invoice Mot Started John Moare L - Show more...
w Send contract Deferred Muriel Ormond & -
r Close out supportr..  Completed Miles Rux ® - Linked Ship Product Invoice to
ABC Incorporated to ABC
Incorporated.
More tasks... Mary Thompsen an hour ago
™ EulEeliEy Please confirm
o CALLS (2 of 34) + - “™  once the inveice has been sent
to John. Thanks!
MEETINGS (5 of 6+) + - Mary Thompson an hour ago
@ NOTES (2 + Created Ship Product Invoice to
-
(2) o ABC Incorporated Task.
Mary Thompson an hour ago
Subject % Last Modified % Date Created -

Activity Stream Views

The activity stream allows users to view a list of activities performed on records,
post messages, share external links, etc. The activity stream can be accessed via
the Home page, module's list view (e.g. Contacts list view), as well as the module's
record view (e.g. Contacts record view). For more information on viewing the
activity stream in Sugar, please refer to the Viewing Activity Streams section. The
following will cover the various options available to users when creating posts,
viewing posts, commenting on posts, etc. in the activity stream.

Post Options
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There are various post options (e.g. external links, images) available to users when
creating user posts in the activity stream. You can add external links, messages,
etc. to your user post by dragging and dropping the corresponding links into the
post input box. Files saved on your local machine can also be attached to your user
post to share with users in your organization. In addition, you can mention specific
users as well as reference specific records by typing in the @ or # sign followed by
the user or record name. For more information on the various post options
available, please refer to the User Post Options section.

Filter Options

The activity stream can also be filtered to only display certain messages (e.g.
Messages for Create, Messages for Update) by clicking "Filter" above the post
input box then selecting the desired message type. This enables users to filter the
activity stream to only display specific activity type's they wish to view. To view all
posts in the activity stream, simply select the All Activity Stream option in the
filter.

Accounts

|G [ AN Activity Stream o @E

+ All Activity Stream

p an attachment. Type @ to mention a user. | ‘
Messages for Create  Jd.

Messages for Link
essage to ABC Incorporated. @

Messages for Post utes ago

Messages for Unlink  Je, will call back to ABC Incorporated. » ®
utes ago
Messages for Update

mmmmmem b AN i mm e mam e Al

Refresh Button

The Refresh button is located to the right of the filter options and provides a quick
way to load the most recent activity stream posts without reloading the browser or
losing any filter criteria you may have set. Simply click the button to refresh the
current view.

ST All Activity Stream E [::1] E

Type a note or drag and drop an attachment. Type @ to mention a user, | ‘
Type # to reference a record.
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Preview Button

The Preview button to the right of each post allows users to preview the record
referenced in record posts. The intelligence pane will display the record's details
with key information regarding the record as well as any related activity stream
information. Please note that preview is available for Create, Update, Link, and
Unlink-type posts in the activity stream. User posts that originate from the record
view's activity stream can also be previewed on the Home page and List View
activity stream as it automatically references the record in the post. To close the
preview, simply click the "X" on the upper right of the intelligence pane. For more
information on previewing posts, please refer to the Previewing Posts section.

Accounts m Preview > E

Filter » LYY= T ] s @ Name
ABC Incorporated

Type a note or drag and drop an attachment. Type @ to mention a user. Type # | | Website
to reference a record. http://www.abcinc.com
Industry

Updated Office Phone on ABC Incorporated. » Communications

Mary Thompson a few seconds ago

Comment Button

Users can respond to posts via the activity stream by clicking the Comment button
to the right of each post. Once you click on the button, simply type your message
into the comment box then click "Reply". Please note that comments are visible to
all users in Sugar unless they do not follow the record in Sugar. For more
information on following and unfollowing records, please refer to the Following
Records and Unfollowing Records section. When a comment is added, the post will
move to the top of the activity stream once the activity stream page is refreshed.
For more information on commenting, please refer to the Commenting on Posts
section.

(] Please provide an update on meeting with n

Mary Thompsen a few seconds ago

Add your comment... Type @ to mention a user. Type # to reference a -

record.

Post Icon

To the left of each post is the Post icon which allows users to easily identify the
module that a record post is specific to, the user who created the post, etc. The
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Post icons for record posts are color-coded and display the first two letters of the
module to differentiate the various record posts for modules. For example, an
update post for the Accounts module will display a green circle with the letters
"Ac", while a post for the Opportunities module will display a purple circle with the
letters "Op". User posts, as well as comments added to posts, display the user's
profile image as the post icon, which helps to identify the user who created the
post or added the comment. For more information on uploading a profile picture to
your Sugar account, please refer to the User Profile section of the Getting Started
documentation.

™ Please provide an update on meeting with g

Mary Thompson 27 minutes ago

Q CELRLET LR Will send you an email with all the details, We can chat
as well should you have any questions. Thanks!

Sarah Smith 2 minutes ago

e Updated Office Phone on ABC Incorporated. » @

Mary Thompson 5 minutes ago

e Updated Type on Cloud Cover Trust - 137 Units. » @
Mary Thompson 5 minutes ago

Right Hand Side Drawer

On the upper right of the Home page activity stream, module's list view, and
record view, there is a double-arrow icon that allows users to expand the activity
stream to the full-screen width. The intelligence pane is hidden when the activity
stream is expanded. To reduce the activity stream's width and reveal the
intelligence pane, simply click the double-arrow icon again.

Activity Stream D

S All Activity Stream

Type a note or drag and drop an attachment. Type @& to mention a user. |:]
Type # to reference a record.

(] Please provide an update on meeting with g

Mary Thompson 3 hours ago

More Posts

The activity stream loads an initial number of posts with the option to show
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additional posts at the user's request. By default, Sugar displays 20 posts per
activity stream view, but administrators can change the number of posts displayed
via Admin > System Settings. For more information on changing the number of
displayed posts, please refer to the System documentation in the Administration
guide. To load the next set of posts, simply click the "More posts..." link on the
bottom left of the activity stream.

Linked ABC Inc - 800 units to ABC Incorporated. ®» @

Mary Thompson & hours ago

Mare posts...

Personalizing Activity Stream

Users can personalize their activity stream by specifying which records' posts
should appear on their Home page and List View activity streams. You can follow
specific records that you have access to view in Sugar by marking the Follow
button in the record view or the Follow option in the list view. Please note that you
automatically start following records that you mark as favorites in Sugar.

Following Records

Users can choose to follow specific records to which they have access to in Sugar.
You can mark a record to follow via the module's list view by selecting "Follow" in
the record actions menu as well as the record view by clicking the Follow button to
the right of the record's name. For more information on following records in
Sugar, please refer to the User Interface documentation. All posts appear on the
Home page and List View activity stream for records you follow in Sugar. Please
note that you will automatically follow records that you create as well as records
that are assigned to you. You will not, however, automatically follow records you
import. Should a user lose access to a record in Sugar, they will automatically stop
following that record.

Favoriting Records

Each Sugar user has the option to designate their own favorite records which are
important or will be viewed often so that they can easily be accessed via search or
from the module tab. You can mark a record as a favorite via the module's list
view, record view, and related record subpanels. For more information on
favoriting records in Sugar, please refer to the User Interface documentation.
Please note that you will automatically start following records you designate as
favorites in Sugar.
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Unfollowing Records

Users can also choose to unfollow records that they no longer wish to view posts
for in their activity stream. Please note that this will prevent all future posts as
well as the associated comments from appearing in your Home page and List View
activity stream. However, historical posts associated to the unfollowed record will
continue to appear in your activity stream. To unfollow a record via the list view,
click the Record Actions menu then select "Unfollow". To unfollow a record via the
record view, simply click the Following button again. Please note that you will
automatically stop following a record should you lose access to a record in Sugar.
Also, if you remove a record as a favorite, the Following status will not change and
you must unfollow the record accordingly.

From list view:

Mame £ City %  Billing Country & &
ABC Incorporated San Francisco UsA - -
XY&Z Funding Inc Kansas City USA @& -
Smith & Sons Los Angeles Usa  Edit

John Smith and Co...  San Francisco Usy Unfollow

From record view:

XY&Z FundingInc * (o] SN Edit -

Website Industry

http://www . xyz.com Banking

Creating User Posts

Users can access the activity stream to view a list of activities performed in Sugar,
track updates, as well as post messages to other users in their organization. To
create a post, simply enter your message into the post input box at the top of the
activity stream view then click "Submit". Please note that user posts display the
user's profile image to the left of the post as the Post icon. For information on Post
icons, please refer to the Post Icon section in this documentation. In addition to the
Post icon, the timestamp of when the post was created and the user's name who
created it will display as well. There are various options available when creating
posts such as adding links, images, attachments, external messages, etc. You can
also reference a specific Sugar record or user by typing @ followed by the user's
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name (e.g. @John Smith) or # followed by the records name (e.g. #ABC Company)
in your post. For more information on the different post options available, please
refer to the User Post Options section.

Creating via Home Page

The Home page activity stream can be accessed by clicking the triangle next to the
Sugar cube icon then selecting "Activity Stream". The post input box displays
beneath the Filter option and you can enter your message then click "Submit" for
the post to appear within the activity stream. Please note that user posts created
via the Home page are viewable by all users in your organization. Posts that
reference a specific record will also appear in that record view's activity stream as
it is linked. For more information on referencing records in your post, please refer
to the Referencing Users and Records section.

. .
TE Accounts w Q o =5 L o

Activity Stream

ST All Activity Stream

LR Meeting confirmed with for January 16th at 10 am.

Creating via List View

The List View activity stream can be accessed by navigating to a module's list view
(e.g. Accounts) then clicking the Activity Stream button to the right of the list
view's search bar. You can create a user post by entering your message into the
post input box then clicking "Submit". Please note that posts created via the list
view activity stream are visible in the record view's activity stream if the specific
record's name is referenced in the post. Also, if you reference a user (e.g. @Jim
Brennan) in your post, they will see the post on their Home page activity stream as
well. For more information on referencing records and users in your post, please
refer to the Referencing Users and Records section.

1 - Accounts w | Contacts -+  Opportunities = Leads -  Calendar =  Reporis =

Accounts (20 of 21+) Create
Y o |
Please call to confirm demo on January 19th then schedule the meeting.
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Creating via Record View

The Record View activity stream can be accessed by navigating to a module's
record view (e.g. ABC Incorporated) then clicking the Activity Stream button below
the module's fields. To create a user post, simply enter your message into the post
input box then click "Submit". Please note that posts added via the record view
activity stream are only viewable within that record's view unless a user is
following the record. All posts appear on the Home page and List View activity
stream for records you follow in Sugar. For more information on following records
in Sugar, please refer to the Following Records section.

ABC Incorporated # m
Website Industry
http://www.abcinc.com Communications
Member of Type

Customer

Assigned to Office Phone
Mary Thompson (415) 782-B788
Tags
Show more...
woduie () Fier - c =Y

m Follow up with m regarding the signed proposal

User Post Options

There are various options available when posting a message in the activity stream
such as adding an attachment, external link, referencing Sugar records, etc. Users
can easily drag and drop files, links, news feeds, etc. from their local machine,
external sites, as well as Sugar dashlets. You can also mention a specific user in
your post that you would like the message targeted to as well as reference records
that you wish to link the post to in Sugar. Please note that every user in Sugar will
be able to view the post if it's created via the Home page activity stream
regardless of whether a specific user is mentioned in the post.

Adding Rich Content and External Messages

Users have the option to add external links, images, and videos as well external
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messages (e.g. tweets, news articles) into their user post. This allows you to easily
share information across the organization by posting relevant links, videos, news
articles, etc. that will be important for other users to view. For more information
on previewing posts, please refer to the Previewing Posts section.

To add external links, messages, etc., simply drag and drop the corresponding title
that's linked to a URL into the post input box. For example, to add a video from
YouTube, click the title (e.g. "How to install SugarCRM") of the video then drag
and drop the link that appears into the post input box. The URL along with the
video will appear within the post once you submit it. For external twitter feeds, you
will need to click the post date (e.g. Jan 3) of the feed then drag and drop the link
that appears into the post input box. To attach an image to your post, copy and
paste the corresponding image URL into the post input box and the image will
appear within the post once submitted.

You can also reference a specific record in the post if you wish to link the post to
the record. For more information on referencing a record in your post, please refer
to the Referencing Users and Records section.

The following steps will cover adding an external link to the Home page activity
stream as an example:

1. Go to an external site (e.g. www.support.sugarcrm.com) then select a link
(e.g. Clearing Browser Cache article) you wish to add to your post.
Note: The actual link will popup when you click the link on the site and
drag it across the page.

& | Support
Latest News Popular Topics [cenmsreuerears
https://suppo...he/index.html
SugarCRM has released version 7.9.3.0 for all Sugar uses your internet browser's cache to
commercial editions. The 7.9.3.0 release is optimize page-load speeds and general
available for download to On-Site customers. Note: performance by saving and reloading visited pages
7.9.3.0... instead of...

2. Drag and drop the link into the post input box on your Home page activity
stream then click "Submit".
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Activity Stream

=TIl All Activity Stream

XN check out this article for more information on clearing browser
cache:

https://support.sugarcrm.com/Knowledge_Base/Troubleshooting/Clearing_Brow
ser_Cache/index.html

The external link will now display in the post on the Home page activity stream
and will be viewable by all users in your organization.

Activity Stream
Type a note or drag and drop an attachment. Type @ to mention a user. Type # to reference a m
record.

n Check out this article for more information on clearing browser
“» | cache:

https://support.sugarcrm.com/Knowledge_Base/Troubleshooting/Clearing_...
Mary Thempson a few seconds ago

Adding Attachments

Users can also drag and drop files such as PDFs, .doc files, .csv files, and image
files directly from their local machine (e.g. desktop) into the post input box to
share documents related to records with other users.

The following steps will cover adding a file from your desktop to the account
record view's activity stream as an example:

1. Locate the file on your desktop that you wish to attach to a post.
2. Drag and drop the file into the post input box.
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o ABC Incorporated # m

-

Website Industry
Agreement http:/fwww.abcinc.com Communications
Member of Type

Customer

Office Phone

(415) 782-8B788

Show more...

Module m Filter =

> =
et ype @ to mention a user, Type m
US Terms

Agreement

3. The attached file(s) will appear below the post input box. You may choose
to enter a message simultaneously, which will appear as a separate
comment-type post in the activity stream. To remove an attachment, click
the "X" on the file's placeholder. Click "Submit" to post the file to the
activity stream.

woauie [ Fiker - c =
Type a note or drag and drop an attachment. Type @ to mention a user. Type

# to reference a record.

US Terms D

Agreement.docx (85 KB)
No preview available

Type a note or drag and drop an attachm
# to reference a record.

You may drag and drop more than one file into the post input box, but please note
that each file will generate two posts in the activity stream: one post showing the
file item ("Fi" icon) and another linking to the note record ("Nt" icon) in Sugar
where the file is stored. You can preview the note record in the intelligence pane
by clicking the Preview button to the far right of the note activity stream post.
Click the file name in the preview's Attachment field to instantly download the file
to your local machine.
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o ABC Incorporated # m Preview > x

Website ndustry @ Subject
http:/fwww.abcinc.com Communications US Terms Agreement.docx
Member of Type s
Customer
Related To
Assigned to Office Phone ABC Incorporated
Mary Thompson (415) 782-8788
Description
Tags
Teams
Global (Primary)
Show more...
pment
Module ) Filter - o= a US Terms Agreement.docx |
Assigned to
Type a note or drag and drop an attachment. Type @ to mention a user. Type m Mary Thompson
# to reference a record.
Tags
Added file US Terms Agreement.docx on ABC P
Show more...
Incorporated.

Mary Thompsen a few seconds ago

Linked US Terms Agreement.docx to ABC Incorporated. * E @ Created US Terms

Mary Thompseon a few seconds ago Agreement.docx Note.

The newly created note record will appear in the Notes & Attachments dashlet in
the account record view's intelligence pane as well as the related Notes subpanel.
If the Notes & Attachments dashlet is not displayed in the intelligence pane, you
can add the dashlet by editing the dashboard. For more information on adding
dashlets, please refer to the Adding Dashlets section of the Dashboards and
Dashlets documentation.

When posting an attachment to the activity stream, if you choose to also include a
comment, any related records mentioned in the comment will not form a
relationship with the note record or uploaded file.

If a new note is created via the Notes subpanel or Notes & Attachments dashlet, an
activity stream post will be created indicating that a new note was linked to the
record. Please note that, when a note is created or linked via the Notes &
Attachments dashlet, you must refresh the activity stream or subpanel view in
order to view the corresponding record.
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